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Documentation Updates

The title page of this document contains the following identifying information:

o Software Version number, which indicates the software version.

o Document Release Date, which changes each time the document is updated.

« Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

e Search for knowledge documents of interest

e Submit and track support cases and enhancement requests
o Download software patches

o Manage support contracts

e Look up HP support contacts

« Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1

Introduction to Data Flow Management

This chapter includes:

Data Flow Management OVEerVIEW. . ... ... e 14
Data Flow Management Architecture. .. ... ... .. 17
Universal Discovery CONCEPLS. . . . . ... 18
Universal Discovery CommUNItY. . . ... 21

Note: (for HP Universal CMDB Configuration Manager users) The Data Flow Management
modules are available only when you are logged in to UCMDB in Actual state.

Data Flow Management Overview

This section gives an overview about the Discovery Control Panel and the Integration Studio.

This section includes:

"Integrations " below
"Discovery " on next page
"Data Flow Management Modules" on next page

"Reconciliation" on page 16

Integrations

You use the Integration Studio to set up integrations with external data repositories.

You can set up the following types of integrations:

Population. Integration that populates the CMDB with Cl and relationship information.

Federation. Integration that retrieves Cls and relationships from an external repository
whenever the data is requested in an ad-hoc fashion.

Data Push. Integration that pushes Cls and relationships from the CMDB to an external data
repository.

Each integration adapter supports certain types of integrations. For example, an integration adapter
that supports both population and federation types can retrieve data periodically for storage within
the CMDB or upon query time; both of these configurations can co-exist within a single integration.

To learn more, see "Integration Studio" on page 129.

Page 14 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 1: Introduction to Data Flow Management

Discovery

The Discovery process is the mechanism that enables you to collect information about your IT
infrastructure resources and their interdependencies. Discovery automatically discovers and maps
logical application assets in Layers 2 through 7 of the Open System Interconnection (OSI) Model.

Discovery discovers resources such as installed and running applications, network devices,
servers, and so on. Each discovered IT resource is delivered to, and stored in, the configuration
management database (CMDB) where the resource is represented as a managed Cl.

Discovery is an ongoing, automatic process that continuously detects changes that occurin the IT
infrastructure and updates the CMDB accordingly. You can discover nodes using agent-based or
agentless discovery.

After configuration, Universal Discovery automatically discovers the network on which the Data
Flow Probe is located, the Node on which the Probe resides, and the Node's IP address. A Cl is
created for each of these objects. These discovered Cls populate the CMDB. They act as triggers
that activate discovery jobs. Every time a job is activated, the job discovers more Cls, which in tum
are used as triggers for other jobs. This process continues until the entire IT infrastructure is
discovered and mapped.

For details on out-of-the-box discovery packages and supported integrations, see the HP Universal
CMDB Discovery and Integration Content Guide.

Data Flow Management Modules

Note: The Data Flow Management modules are only available when you are logged into
UCMDB in Actual state.

Data Flow Management (DFM) includes the following application modules:

Integration Studio

The Integration Studio enables you to set up UCMDB integrations to define and control data flows
from external data repositories to the CMDB, or from the CMDB to external data repositories.

For more information, see "Integration Studio" on page 129.

Discovery Control Panel

The Discovery Control Panel enables you to manage the Discovery process to discover the Cls
and relationships of your IT infrastructure. You control the process by activating discovery jobs.

You can manage discovery by partitioning your enterprise into zones and activating discovery
activities (groups of discovery jobs) to discover infrastructure (IPs, nodes), basic software (shallow
running software including application servers, databases, and web servers), deep database
configuration, and inventory ( for example, CPUs, installed software, logical volumes), among other
data.

You could also control the process by manually activating discovery jobs. You can choose to
activate all or some of the jobs in a module. You can also edit discovery jobs, and schedule a job to
run at a certain time.
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For more information, see "Universal Discovery" on page 184.

Data Flow Probe Setup

The Data Flow Probe Setup module enables you to add Data Flow Probes to the system and to
manage existing Data Flow Probes. You define the network range that each Data Flow Probe
covers.

You also manage communication credentials from the Data Flow Probe Setup module. These
credentials are used for both Discovery and Integrations purposes.

Universal Discovery integrates with HP Real Time Monitor (RUM) to provide passive, real-time
discovery and monitoring of traffic in a given environment. This is known as the Just-In-Time
discovery mechanism. You can manage IP ranges and port ranges for passive discovery probes
from the Data Flow Probe Setup module.

For more information, see "Data Flow Probe Setup" on page 23.

Reconciliation Priority

The Reconciliation Priority module enables you to specify the reconciliation priority for a particular
integration point, CIT, or attribute.

For more information, see "Reconciliation Priority" on page 268.

Adapter Management

The Adapter Management module enables you to edit adapters, scripts, configuration files
(including discovery rules), and scanner configurations. You can also replace or remove external
resources needed for Discovery or Integration from this module.

For more information, see "Adapter Configuration" on page 78.

Universal Discovery Community

The Universal Discovery Community Web site provides you with a convenient way to obtain the
latest Discovery and Integration Content Pack. The Content Pack provides all of the out-of-the-box
discovery packages and integration adapter required for performing discovery and integrating with
external sources.

For more information, see "Universal Discovery Community" on page 21.

Data Flow Probe Status

The Data Flow Probe Status module enables you to view the current status of a particular Data
Flow Probe: which discovery or integration job the Probe is currently running, execution statistics,
and soon.

Note: Data Flow Probes installed on Windows platforms only are displayed in this module.
For details, see "Data Flow Probe Status" on page 71.

Reconciliation

The Reconciliation process consists of two important steps:
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« Identification. The process by which Cls and relationships within the CMDB are identified
against existing Cls within the CMDB, other Cls within the same bulk, or Cls coming from
various federated data sources.

+ Reconciliation Priority. The process by which the CMDB reconciliation engine decides how to
deal with conflicting data. When conflicting values are given for the same CI attribute by
different integrations, the CMDB reconciliation engine resolves the conflict by looking at the
reconciliation priority assigned to each integration.

By default, unless you customize the reconciliation priorities within the Reconciliation Priority
Manager, the CMDB reconciliation engine uses the last reported value as the most accurate, that
is, all integrations have exactly the same priority.

For more information about reconciliation, see "Entity Reconciliation" on page 250.

For details about the Reconciliation Priority Manager, see "Reconciliation Priority Window" on page
274.

Data Flow Management Architecture

Data Flow Management architecture is deployed as follows:

HTTP/s

|
Webh Client UI[]["«*I[TIIB| Server DB Server

HTTP/s

Data Flow Probe

(" Customer's Network _|)
[ |

e

o The Data Flow Probe is responsible for integration of data to and from external data repositories
and for performing discovery.
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o The Data Flow Probe initiates communication with the UCMDB Server using http or https traffic,
enabling the product to bypass possible firewalls.

Universal Discovery Concepts

This section describes the main topics of Universal Discovery:

Data Flow Probe

The Data Flow Probe is the main component responsible for requesting tasks from the server,
scheduling discovery and integration tasks, executing them, and sending the results back to the
UCMDB Server. You define a range of network addresses for a specific, installed Data Flow Probe.
Each Data Flow Probe is identified by its name, chosen during the Data Flow Probe installation
process.

Passive Discovery Probe

A passive discovery probe is an HP Real Time Monitor (RUM) probe that is configured to integrate
with a Data Flow Probe to provide passive, real-time discovery and monitoring of traffic in a given
environment. This is known as Just-in-Time discovery.

Communication Protocols

Discovery of the IT infrastructure components uses protocols such as SNMP, WMI, JMX, Telnet,
and so on for communication. For details about each protocol, see the HP Universal CMDB
Discovery and Integration Content Guide.

Discovery and Integration Adapters

An adapter can be of one of the following types:

« Jython Adapter. An adapter based on a set of Jython scripts that are executed sequentially.
For details, see Create Jython Code in the HP Universal CMDB Developer Reference Guide.

o Java Adapter. An adapter based on Java code that implements the various DFM interfaces and
is wrapped in a JAR file. For details, see Developing Java Adapters in the HP Universal CMDB
Developer Reference Guide.

o Generic DB Adapter. An adapter that uses SQL queries and maps database tables to Cls and
relationships by using an ORM file. For details, see Developing Generic Database Adapters in
the HP Universal CMDB Developer Reference Guide.

o Generic Push Adapter. An adapter that uses a mapping file and Jython scripts to push data to
an external data repository. For details, see Developing Push Adapters in the HP Universal
CMDB Developer Reference Guide.

The adapters themselves do not contain information about the target to which they are to connect
and from which they are to retrieve information. For data flow to be configured correctly, adapters
require further context information, which can include an IP address, port information, credentials,
and so on.

For discovery adapters (adapters used for performing discovery), the additional information is
brought from the Trigger Cls associated with the discovery jobs; for integration adapters, the
information is manually fed when creating the integration or taken from the selected Trigger CI.
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For details on making adapter changes, see "Adapter Management Window" on page 101. For
details on creating adapters, see Adapter Development and Writing in the HP Universal CMDB
Developer Reference Guide

Input Queries
Note: Input queries refer only to discovery-based integrations.

Each discovery-based integration adapter is assigned an input query that is used as follows:

o The input query defines a minimal set of requirements for every Trigger Cl included in a job
or integration that triggers this adapter. (This is true even when no trigger query is associated
with the job.)

For example, an input query can query for IPs related to nodes with an SNMP agent installed
and discovered on them, that is, only IPs with installed SNMP agents can trigger this adapter.
This prevents the case where a user could manually create a Trigger Cl that adds all IPs as
triggers to an adapter.

o An input query defines how to retrieve data information from the CMDB. Destination data
information, even if it is not included in a Trigger CI, can be retrieved by the input query. The
input query defines how to retrieve the information.

For example, you can define a relationship between a Trigger Cl (a node with the node name of
SOURCE) and the target Cl and then can refer to the target Cl according to this node name.

For details on using input queries when writing adapters, see Step 1: Create an Adapter in the HP
Universal CMDB Developer Reference Guide.

Discovery Modules

The module is a grouping of discovery jobs that logically belong together, can be operated and
managed together, and so on. This helps to reduce clutter in the main view when many jobs need to
be written, and can also offer better manageability.

When creating a job, you should add it to a module or create a new module. If you are creating
several jobs, the best practice is to split them into logical groups and assign them to modules
accordingly.

Discovery Modules support a hierarchy of folders, to facilitate easy finding of the relevant discovery
capability.
Discovery and Integration Content Packs

The latest Discovery and Integration content for UCMDB is delivered as a Content Pack available
for download via the HP Live Network. For details on downloading and installing Content Packs,
see the "Universal Discovery Community" on page 21.

By downloading the latest Content Pack, you ensure that your system is up to date with the latest
content functionality. Content Packs are released in a separate release train and are installed on top
of the current UCMDB platform.

Integration Points

Integration points are entities used to set up UCMDB integrations. Each integration point is created
with a selected integration adapter and the additional configuration information required to set up the
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integration. For details on creating integration points, see "Integration Studio" on page 129.

Discovery Jobs

A job enables reuse of a discovery adapter for multiple discovery process flows. Jobs enable

scheduling the same adapter differently over different sets of triggered Cls and also supplying
different parameters to each set. You can launch a discovery by activating the relevant set of

discovery jobs that must be run. Relevant trigger Cls are automatically added to the activated
discovery jobs based on their trigger queries.

Discovery Activities

You use one of the discovery activities to discover infrastructure (IPs, nodes), basic software
(shallow running software including application servers, databases, and web servers), deep
database configuration, and inventory ( for example, CPUs, installed software, logical volumes),
among other information within Management Zone.

Management Zones

A Management Zone is a region in the network defined by a collection of IP ranges. A region of an
organization’s infrastructure should be defined as a Management-Zone when you want to discover
all the managed objects of the region using the same scheduling policy and parameters.

You can set up multiple Management Zones to run different instances of a Discovery activity in
different Data Centers in your enterprise.

For information, see "Universal Discovery Overview" on page 184.

Agent-Based Discovery

To collect inventory information, you can deploy Universal Discovery agents on client or server
machines. The UD agent provides a secured communication channel between the Data Flow Probe
and the Nodes being discovered. After setting up the secure communication channel, Universal
Discovery deploys and activates scanners onto the Nodes being discovered. The Scanners scan
the Nodes for inventory information and store the scanned results in scan files which are
downloaded to the Data Flow Probe through the secured communication channel established with
the UD agent.

When the UD agent is installed, collection of software utilization information is enabled. The

UD Agent also enables you to benefit from the Call Home feature. Call Home is useful in the case
where a Node was unavailable for scanning for a long period. It enables the UD agent to notify the
Data Flow Probe that the Node is currently available for scanning.

Agentless Discovery

Although agentless discovery does not require the installation of dedicated agents on the servers
that are to be discovered, it does depend on native OS or standard agents that are already installed
such as SNMP, WMI, TELNET, SSH, NETBIOS, and others. Other discovery capabilities are
based on application-specific protocols such as SQL, JMX, SAP, Siebel, and so on. For details on
supported protocols, see the HP Universal CMDB Discovery and Integration Content Guide.

Trigger Cls and Trigger Queries

A Trigger Cl is a Cl in the CMDB that activates a discovery job. Every time a job is activated, the
job may discover additional Cls, which in turn are used as triggers for other jobs. This process
continues until the entire IT infrastructure is discovered and mapped.
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A Trigger query associated with a job is a subset of the Input query, and defines which specific Cls
should automatically trigger a job. That is, if an Input query queries for IPs running SNMP, a Trigger
query queries for IPs running SNMP in the range 195.0.0.0-195.0.0.10.

Note: A Trigger query must refer to the same objects as the Input query. For example, if an
Input query of an adapter queries for IPs running SNMP, you cannot define a Trigger query for
an associated job to query for IPs connected to a node. This is because some of the IPs may
not be connected to an SNMP object, as required by the Input query.

Universal Discovery Community

The Universal Discovery Community (https://hpln.hp.com//group/universal-discovery/) on the HP
Live Network provides customers with a convenient way to obtain the latest HP UCMDB
Discovery and Integration Content Packs and related documentation.

Note: You need an HP Passport user name and password to log in to this site.
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Troubleshooting and Limitations. ... ... .. ... e 70

Job Execution Policies

You can define periods of time when a Probe must not run. You can choose to disable specific jobs
running on any Probe or all jobs running on a specific Probe. You can also exclude jobs from a job
execution policy so that they continue running as usual.

For details on defining a job execution policy, see "New/Edit Policy Dialog Box" on page 37.

Example of Policy Ordering
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Say there are two policies, Total TCP Blackout and Always (the out-of-the-box policy). Total
TCP Blackout does not allow any TCP discovery jobs to run. The policies appear in the list as

follows:
Job Execution Palicy
t ¥+ K&
Time Probes | Johs
Total TCP Blackout All [IP Traffic by Metwork Data, Col
Always All All

Ajob (Class C IPs by ICMP) starts running. It checks the policies in the policy list from top to
bottom. It starts by checking Total TCP Blackout. The job does not appear in this policy, so it
continues down the list and checks Always. The job does appear here (Allow All is selected
in the Edit Policy dialog box) so the job runs:

Edit Policy
Related probes | =<2l Probess== |7

Tirne &

Related jobs

® allow al
() Total Blackout

() Allowed jobs

) Dizallowed jobs

The next job (Software Element CF by Shell) starts running. It checks the policies in the
policy list from top to bottom. It starts by checking Total TCP Blackout. The job appears in
this policy (Disallowed Jobs is selected in the Edit Policy dialog box), so the job does not run:
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Pelated probes =<l Probess> &7

Time &
RFelated jobs
o oL
) Allow all & Software Element CF by Shell
~ x
I_) Total Blackout
) allowed jobs
(® Dizallowed jobs

Caution: If ajob is not connected to any policy, it does not run. To run these jobs, set the
last policy in the list to Allow All.

Running Jobs When a Job Execution Policy Is Running

If a policy begins to operate while a Probe is executing a job, the job pauses. When the policy
finishes, the job continues to run from where it ceased. For example, say a job contains 10,000
Trigger Cls. The job finishes working on 7,000 of them and then the policy starts to operate. When
the job continues (after the policy finishes), it works on the remaining 3,000 Trigger Cls—the job
does not start running from the beginning.

Data Validation on the Data Flow Probe

After discovery orintegration, results are processed, each one verifying a different aspect of the
outgoing discovery result - class model validation, redundant results validation, and so on. This is
called the result processing chain.

This section includes:
o "Class Model Data Validation" below

o "Content Data Validation" on next page

Class Model Data Validation

The CIT model resides on the Data Flow Probe (as well as in the CMDB). This enables data
validation to take place on the Probe when receiving data from services. Problems are generated for
a specific Trigger Cl and displayed to the user.

The following validation takes place on the Probe:
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e The CIT of the Cl is compared to that in the CIT model.

o The Clis checked to verify that all key attributes are present (on condition that the
CmdbObjectId attribute is not defined).

o The Cl's attributes are checked to verify that they are all defined in the CIT.

o The Cl's attributes of type STRING are checked to verify that they do not exceed the size limit.
If an attribute is longer than the limit, DFM checks whether an AUTO_TRUNCATE qualifier is
defined for the attribute. If there is a qualifier, the value is truncated and a warning message is
written to the Probe error. 1ogfile.

o The Cl attributes are checked for case inconsistencies. If there are inconsistencies, DFM
checks if a case-relevant qualifier LOWERCASE or UPPERCASE) is defined, and if so, it
applies the relevant case to all of the attributes.

o The Cl attributes are checked for white spaces. If there are white spaces, DFM checks whether
the DDM_AUTOTRIM qualifier value for the attribute. If it is set to true, the results are
trimmed— that is, leading and trailing spaces and tabs are trimmed, so that there are no white
spaces at the beginning or at the end of the resullt.

Allinvalid attributes raise an error, which reports on a specific Cl. When the Probe finds invalid data
that is related to the CITs, all data that the Probe has collected on that Cl is dropped by the Probe
and is not sent to the server.

For details on attributes, see "CI Type Attributes" in the HP Universal CMDB Modeling Guide.

Content Data Validation

Content that comes out-of-the-box with the Discovery and Integration Content Pack uses standard
libraries. However, user-defined packages might not be compatible with the standard APIs and can
send invalid data to the UCMDB server.

To provide strong validation for data reported to the UCMDB server, UCMDB allows for additional
content data validation before the data is sent to the UCMDB server, and indication of any invalid
data. To perform content data validation, you can create validation jython scripts and specify them
in the dedicated configuration file, dataValidationlibs.xml.

The Content Data Validation module loads and executes sets of jython scripts defined in the
dataValidationlibs.xml file. The content data validation jython scripts should contain the
ValidateData function, which is the entry point for data validation execution.

For details about how to configure the content data validation jython scripts, and for some
examples, see "Content Data Validation Jython Scripts" on page 65.

To enable or disable Content data validation in UCDMB, see "How to Enable Content Data
Validation" on page 34.

Filtering Results

You can filter results sent by the Probe to the HP Universal CMDB server. You would probably
need to filter irrelevant data regularly during production runs and specifically when you are testing a
limited environment.

There are two levels of filtering: adapter filtering and global filtering:
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o Adapter filtering. The Data Flow Probe filters the results for a specific adapter and sends to the
CMDB only those filtered Cls. You define an adapter filter in the Results Management pane in
the Adapter Configuration tab. For details, see "Adapter Configuration Tab" on page 96.

¢ Global filtering. DFM filters the results of all jobs running on a Probe. You define global filters in
the globalFiltering.xml file. For details, see "Configure a Filter" on page 87.

The order of filtering is as follows: during a run, the Data Flow Probe first searches for an adapter
filter and applies the filter to the results of the run. If there are no adapter filters, DFM searches for a
global filter and applies that filter to the results. If DFM finds no filters, all results are sent to the
server.

How to Start the Data Flow Probe

This section explains how to start the Data Flow Probe running on a Windows platform.

Note:

e The Data Flow Probe that runs on a Linux platform is intended only for integrations, and not
for discovery.

o The managed environment is defined by the IP ranges of the domains. However, with some
discovery adapters it is possible to override this behavior and discover Cls that are out of a
Probe's range.

This task includes the following steps:
o "Prerequisite" below
o "Start the Probe " below

Prerequisite

o Ensure that the Data Flow Probe is installed on a Windows machine. For details, see the
interactive HP Universal CMDB Deployment Guide.

o Ensure that UCMDB is installed and running.
Start the Probe
¢ From the Start Menu

On the machine on which the Probe is installed, select Start > Programs > HP UCMDB >
Start Data Flow Probe. The Probe is started as a service.

To verify that the Probe has been launched successfully, in HP Universal CMDB select Data
Flow Management > Data Flow Probe Setup. Select the Probe and, in the Details pane,
verify that the status is connected.

¢ In a Console

You can configure the Probe so that it opens in a console. In this case, the command prompt
window is displayed. Execute the following script:
C:\hp\UCMDB\DataFlowProbe\bin\gateway.bat console.
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Note: The user running the Probe service must be a member of the Administrators group.

How to Stop the Data Flow Probe

To stop the Probe when it is running as a service, select Start > Programs > HP UCMDB >
Stop Data Flow Probe.

To stop the Probe when it is running in a command prompt window (the console), press
CTRL+C, theny.

How to Add a Data Flow Probe

This task describes how to add a Probe to UCMDB.

This task includes the following steps:

3.

"Prerequisites" below

"Add a domain to UCMDB" below

"Add a Data Flow Probe to the new domain" below

"Add more Probes to the domain — optional" on next page

"Define credentials" on next page
Prerequisites
Verify that the Probe is installed and make a note of its IP address.
Add a domain to UCMDB

In this step, you create the domain for the new Probe. When you start the Probe, it connects to
UCMDB automatically. To verify, select Data Flow Management > Data Flow Probe
Setup. Select the Probe and, in the Details pane, verify that the status is connected.

To define Probe ranges before the Probe has connected for the first time, you must define them
manually. For details, see "New/Edit IP Range Dialog Box" on page 35.

a. Access the Probe configuration window: Data Flow Management > Data Flow Probe
Setup.

b. Select Domains and Probes and click the Add Domain or Probe button to open the
Add New Domain dialog box. For details, see "Add New Domain Dialog Box" on page 38.

Add a Data Flow Probe to the new domain
In this step, you define the Probe and its range.
a. Double-click the new domain and select the Probes folder.

b. Click the Add Domain or Probe button to open the Add New Probe dialog box. For
details, see "Add New Probe Dialog Box" on page 39.
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c. Select the new Probe and define its IP range. For details, see "New/Edit IP Range Dialog
Box" on page 35.

4. Add more Probes to the domain — optional

To add more Probes to this domain, repeat step "How to Add a Data Flow Probe" on previous
page.

5. Define credentials

You configure credentials depending on what must be discovered and which protocols are
supported on your site's network.

For details, see "Data Flow Probe Setup Window - Details Pane" on page 40. For a list of
protocols, see the HP Universal CMDB Discovery and Integration Content Guide.

How to Configure Periodic Data Flow Task
Updates

When a data flow job is activated, the input TQL of the adapter is calculated once and is sent to the
Data Flow Probe. If trigger Cl data changes (for example: a laptop acquires a different IP address)
the Data Flow Probe needs to be updated with the modified trigger Cl data. As long as the Data
Flow Probe is not updated with any changes, the query continues to run with out-of-date
information.

To ensure that the Data Flow Probe is always kept up-to-date with possible changes in trigger Cl
data, you can configure UCMDB to recalculate trigger Cl data and send any changes to the Data
Flow Probe.

This section includes:

o "Global Configuration" below

o "Adapter Configuration" on next page
e "Ad Hoc Updates" on next page

Global Configuration

Data flow tasks for all adapters are updated per the global setting configured in the Infrastructure
Settings.

Note: Where necessary, you can configure updates for a particular adapter to behave
differently. For details, see "Adapter Configuration" below.
To configure global data flow task updates:
1. Select Administration > Infrastructure Settings Manager.
2. Select the General Settings category.
a. Locate Enable periodic update of data flow tasks parameter and set the value to true.

b. Locate Periodic data flow task update interval and Periodic data flow task update
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start time and specify how often (in hours) to update the data flow tasks, and the time (01-
24) at which to start the update.

By default, this option is enabled, and the data flow tasks are updated once a day, at midnight.

Adapter Configuration

This task describes how to configure a particular adapter so that updates to its data flow tasks are
periodically sent to the Data Flow Probe.

Note:

e The setting in the adapter file overrides the global setting (Enable periodic update of data
flow tasks) described above.

For example, if the setting in the adapter file is set to true, but the global setting is set to
false, the adapter's tasks are still updated on the Data Flow Probe (and vice versa).

o This setting should be configured for an adapter only in the case where updates for the
adapter should behave differently to configuration in the global settings.
To configure data flow task updates for a particular adapter:
1. Open the adapter's xml file in an editor.
2. Locate the <dispatchMechanism> tag. If it does not exist, create it.

3. Add the following parameter:

<dispatchOnChanges isEnabled = "<true or false>" />
Example:
<pattern>
<dispatchMechanism type = "IpAddress">
<dispatchOnChanges isEnabled = "true" />

</dispatchMechanism>

</pattern>

Ad Hoc Updates

To run ad hoc updates of data flow tasks:
1. Logintothe JMX console.
2. Run the relevant JMX method:
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JMX Method Description

recalculateAndUpdateDFMTasks Updates data flow tasks for all the adapters
for which data flow task update is enabled.

Note: Data flow task updates are enabled
in the adapter's configuration file. For
details, see "Adapter Configuration" above.

recalculateAndUpdateDFMTasksForAdapter | Updates data flow tasks for selected
adapters without checking the adapter
configurations. That is, even if the data
flow task update is not enabled for a
selected adapter, the updates are run.

How to Update the Data Flow Probe's IP Address

This task describes how to configure a Data Flow Probe if its IP address has changed.

Note: If the IP address of a Data Flow Probe has changed, it is advisable to re-install the
Probe. For information about installing the Data Flow Probe, see the interactive HP Universal
CMDB Deployment Guide. If it is not possible to reinstall the Probe, perform the procedure
below.

To change the IP address of a Data Flow Probe:
1. Update the Probe properties
In C:\hp\UCMDB\Data Flow Probe\conf folder:
= Open the DataFlowProbe.properties file and update the following properties:
o appilog.collectors.local.ip
o appilog.collectors.probe.ip

For more details about these properties, see "DataFlowProbe.properties Parameters" on
page 55.

= Open the probeMgrList.xml, locate the line that starts with <probeMgr ip=and update
the Probe Manager machine name or IP address, for example:

<probeMgr ip="OLYMPICS08">

2. Stop the Probe

= To stop the Probe when it is running as a service, select Start > Programs > HP UCMDB
> Stop Data Flow Probe.

= To stop the Probe when it is running in a command prompt window (the console), press
CTRL+C, theny.

3. Run the clearProbeData script
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In C:\hp\UCMDB\DataFlowProbe\tools run clearProbeData.bat.
4. Restart the Probe
= Torestart the Probe from the Start window, see "Start the Probe " on page 27.

= Torestart the Probe in a console, see "In a Console" on page 27.

How to Update the Data Flow Probe Memory Size

The Data Flow Probe Memory Size is defined during installation.
This task describes how to change the maximum heap size..
1. Open the WrapperEnv.conf located in C:\hp\UCMDB\DataFlowProbe\bin\
2. Update the following parameters:
= set. GATEWAY_MAX_MEM
= set. MANAGER_MAX_MEM

Note: For Probes on Linux machine, update only set. GATEWAY_MAX_MEM

3. Restart the Data Flow Probe process.

How to Configure the Data Flow Probe to
Automatically Delete Cls

This task explains how to configure a job so that Cl instances of specific CITs are automatically
deleted. For details on how the Data Flow Probe deletes Cls, see "Automatically Deleted Cls and
Relationships and Candidates for Deletion Cls" on page 80.

1. Select the Clis to be Deleted
a. Access the Results Management pane in the Adapter Configuration tab.
b. Select the Enable Automatic Deletion check box.

c. Click the Add button to open the Choose Discovered Class dialog box. For details, see
"Choose Discovered Class Dialog Box" on page 104.

d. Select the deletion method for the CIT: Auto Delete or Candidate for Deletion.
e. Click the Save button at the bottom of the page.
2. Results

To view the deleted Cls, access the Deleted column in the Statistics Results pane. For
details, see "Statistics Results Pane" on page 220.
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How to Configure Number of Connections to Other
Machines

This task describes how to configure the number of connections per second that a Data Flow Probe
is allowed to create to other machines. You configure these settings in the globalsettings.xml file
which is located in the Adapter Management module under Resources pane > Packages >
AutoDiscoveryContent > Configuration Files.

To configure the number of connections per second created by the Probe to other
machines:

1. Inthe globalsettings.xmil file, configure the properties listed below as follows:

Property Description

maximumConnectionsPerSecond | Enables limiting the number of new connections per second
created by the Probe to other machines.

= 0. Unlimited number of connections allowed.

= > 0. The maximum number of connections. If this limit is
reached, any job trying to create a new connection will wait
for a period of time that is determined in the
timeToSleepWhenMaximumConnectionsLimitReached
property (see below)

Default: O (unlimited)

timeToSleepWhenMaximum Determines how long (in milliseconds) a job needs to wait until
ConnectionsLimitReached a new connection can be created, assuming the
"maximumConnectionsPerSecond" limit has been reached.

Default: 1000 milliseconds (1 second)

Note: If maximumConnectionsPerSecond = 0 this property
is ignored.

2. Save your changes.

How to Delete Unsent Probe Results

This task describes how to empty the Probe queue that contains results that have not yet been
transmitted to the UCMDB Server.

1. Access the Data Flow Probe JMX console: Launch a Web browser and enter the following
address: http://<Probe Gateway machine name or IP address>:1977. If you are running the
Data Flow Probe locally, enter http://localhost:1977.

You might have to log in with a user name and password.

Note: If you have not created a user, use the default user name sysadmin and the
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password sysadmin to log in.

2. Locate the Probe_<Probe Name> > type=MainProbe service and click the link to open the
JMX MBEAN View page.

3. Invoke the operation by clicking the dropUnsentResults button.

How to Enable Content Data Validation

This task describes how to enable or disable the execution of content data validation.

1. Inthe DataFlowProbe.properties file (located in c:\hp\UCMDB\DataFlowProbe\conf), set
the appilog.agent.local.process.result.dataValidation.content parameter as follows:

= true. Enables content data validation (default)
= false. Disables content data validation
2. Restart the Probe to update the changes.

3. If you are enabling validation, ensure that your content data validation configuration file,
dataValidationlibs.xml, is defined with the necessary Jython and library scripts. For details,
see "Content Data Validation Jython Scripts" on page 65.

For more information about Content Data Validation, see "Content Data Validation" on page 26.

Note: The value given to the appilog.agent.local.process.result.dataValidation.content
parameter in the DataFlowProbe.properties file can be overridden on an adapter level by adding
the \"enableContentDataValidation\" parameter to the adapter parameters. If this parameter
is absent among the adapter parameters (by default), the value defined in the
DataFlowProbe.properties file is used.

Data Flow Probe Setup User Interface

This section includes:

« "New/Edit IP Range Dialog Box" on next page

« "New/Edit Policy Dialog Box" on page 37

o "Add New Domain Dialog Box" on page 38

o "Add New Probe Dialog Box" on page 39

¢ "Choose Discovery Jobs Dialog Box" on page 39
o "Data Flow Probe Setup Window" on page 39

o "Data Flow Probe Setup Window - Details Pane" on page 40
e "Domains and Probes Pane" on page 47

« "Edit Related Probes Dialog Box" on page 48

« "Edit Timetable Dialog Box" on page 48
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o "Protocol Parameter Dialog Box" on page 54

¢ "Scope Definition Dialog Box" on page 54

o "Selecting Probes" on page 54

New/Edit IP Range Dialog Box

Enables you to set the network range for a Data Flow probe or for a passive discovery probe. The
results are retrieved from the addresses in the range you define. You can also define IP addresses
that must be excluded from a range.

To access

1.

Select Data Flow Management > Data Flow Probe Setup > Domains
and Probes > Domain:

For a Data Flow Probe: Under Data FI_ow Probes, select a @be, and in the
Ranges pane click the New IP range |_| or Edit IP range |£| button.

For a passive discovery probe: Under Passive Discovery Probes, select a
passive probe, and in the Passive Discovery Integrated Ranges pane click

the New IP range |2 or Edit IP range <% button.

Important

information

If you define a range that is out of the scope of the network on which the Probe is
installed, a warning message informs you that the Probe is not included in the
range.

Answer Yes to save the current range without including the Probe in the range.

Answer No to continue editing without saving the current range.

Relevant
tasks

"How to Add a Data Flow Probe" on page 28
"Module/Job-Based Discovery Workflow" on page 190

"How to Configure Just-In-Time Discovery" on page 193

User interface elements are described below:

LEjllement Description
IP Range | Enables you to define a range of IP addresses over which the Probe should perform
discovery.
+ Range.The IP address range. The rules for defining an IP address range are as
follows:
= The IP address range must have the following format:
start ip address - end ip address
Forexample: 10.0.64.0 - 10.0.64.57
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ul
Element Description
= The first decimal value (octet) of the start IP and end IP must be identical.
Forexample,10.1.2.3 - 10.2.3.4.
= The range can include an asterisk (*), representing any number in the range of
0-255.
= If you use an asterisk, you do not need to enter a second IP address. For
example, you can enter the range pattern 10. 0. 48 . * to cover the range from
10.0.48.01t010.0.48.255.
= Use an asterisk in the lower bound IP address of the IP range pattern only. (If
you use an asterisk in the lower bound IP address and also enter an upper
bound IP address, the upper bound IP address is ignored.)
= You can use more than one asterisk (*) in an IP address as long as they are
used consecutively. The asterisks cannot be situated between two numbers in
the IP address, nor can they be substituted for the first digit in the number. For
example, you can enter 10.0.*.* but not 10.*.64.*.
= Two Probes in the same domain cannot have the same IP address in their
range.
= Fora passive discovery probe, this range must fall within the range of the Data
Flow Probe it is reporting to.
o Type. (Data Flow Probe only) Defines the IP address lease time setting for the
range.
= Data Center: For permanent or long IP address lease times.
= Client: For short IP address lease times.
Note: Mac addresses are not captured during a ping sweep discovery job when
the setting is Data Center.
o Description. (Optional) A description about the selected range.
Note:
= Maximum number of characters allowed: 150
= No new lines or tabs may be inserted
Excluded | Enables you to define a range of IP addresses to exclude from the IP range specified
IP above.
Ranges —
|_| New Excluded IP Range. Enables you to define a range of IP addresses to
exclude, and enter a description about the excluded range if desired.
Eﬁj_ Delete Excluded IP Range. Deletes an excluded IP range.
|£| Edit Excluded IP Range. Enables you to edit a defined excluded IP range.
Note:
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Ul
Element

Description

o The rules for entering an excluded range are the same as for entering a range. For

details, see IP Range above.

o Use this feature to divide a network range into several sub-ranges.

For example, if the range is
10.0.64.0—10.0.64.255

and you define three excluded ranges:
10.0.64.45-10.0.64.50
10.0.64.65-10.0.64.70
10.0.64.89 - 10.0.64.95

the ranges to be discovered are:
10.0.64.0—-10.0.64.44
10.0.64.51 - 10.0.64.64
10.0.64.71-10.0.64.88
10.0.64.96 — 10.0.64.255

Ports

Enables you to define ports over which passive discovery should be performed
within the defined IP address range:

¢ All available ports. Enables passive discovery over all available ports.

« Selected ports Enables passive discovery over ports that you select from the

Global Ports List. Click [-=: to select ports to monitor.

Available: When defining an IP address range for a passive discovery probe only.

New/Edit Policy Dialog Box

Enables you to create a job execution policy, to disable jobs from running at specific times.

To
access

Data Flow Management > Data Flow Probe Setup > Domains and Probes >
Details pane > Job Execution Policy section. Select an existing policy and click the

Edit Policy |£| button, or click the New Policy |_| button.

See
also

o "Job Execution Policies" on page 23

o "Data Flow Probe Setup Window - Details Pane" on page 40
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User interface elements are described below:

]

Element

(A-2) Description

Related | o
jobs

For allowed and disallowed jobs, click the Add job or Remove job button to choose
specific jobs to be included in, or excluded from, the policy. If you click the Add job
button, the Choose Discovery Jobs dialog box opens.

Allow all. Run the job execution policy on all jobs.
Total blackout. The policy does not run on any jobs.
Allowed jobs. Choose jobs to run even during the configured blackout time.

Disallowed jobs. Choose jobs that do not run during the configured blackout time.

2]

Related | The Probes on which to run the policy. Click the button to open the Edit Related
Probes | Probes dialog box to define which Probes are included in the policy.

'Ene The date and time during which the policy is active. Click the button to open the Edit
L2 Timetable dialog box.

Add New Domain Dialog Box

Enables you to add a domain.

To access

Click the Add Domain or Probe |_| button in the Domains and Probes pane.

Important
information

In a version 8.01 or later environment that has been upgraded from version 6.x, to
enable data to be modeled similarly as in the previous version, you must define
the Probes as belonging to the External domain and not to the Customer domain.

User interface elements are described below:

Ul Element
(A-2) Description
Description | Enter a description to appear in the Details pane of the Data Flow Probe Setup
window.
Domain o Customer. A private domain used for your site. You can define several
Type domains and each domain can include multiple Probes. Each Probe can
include IP ranges but the customer domain itself has no range definition.

o External. Internet/public domain. A domain that is defined with arange. The
external domain can contain only one Probe whose name equals the domain
name. However, you can define several external domains in your system.

Name Enter a unique name for the domain.
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Add New Probe Dialog Box

Enables you to add a Probe.

To access | Click the Add Domain or Probe button in the Domains and Probes pane.

Important e Toadd aProbe to an existing domain, select Probes in the Domains and
information Probes pane and click the Add Domain or Probe button.

e Toadd a Probe to a new domain, create a domain, then add the Probe to the
domain.

¢ Two Probes in the same domain cannot have the same |IP address in their
range.

o When a Probe is activated, it is added automatically and its status changes to
connected. For details, see "Start the Probe " on page 27 or "In a Console" on
page 27.

Choose Discovery Jobs Dialog Box

Enables you to choose the jobs that are to be added to, or excluded from, the job execution policy.

To Select Allowed Jobs or Disallowed jobs in the Edit Policy dialog box and click the
access |i| button.

User interface elements are described below:

Ul Element

(A-2) Description

<Installed Locate the job to be included in, or excluded from, the policy. (Use the SHIFT or
packages> CTRL key to select several packages.)

Data Flow Probe Setup Window

Enables you to define a new domain or to define a new Probe for an existing domain. Also enables
you to define the connection data for each protocol.

To access Data Flow Management > Data Flow Probe Setup
Important o Fordetails on the Domains and Probes pane, see "Domains and Probes
information Pane" on page 47.

o Fordetails on the Details pane, see "Data Flow Probe Setup Window -
Details Pane" on next page.

See also Supported Protocols and Supported Agents in the HP Universal CMDB
Discovery and Integration Content Guide.
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Data Flow Probe Setup Window - Details Pane

Enables you to view the Probes running under all domains and to add an execution policy to jobs.

To In the Data Flow Probe Setup window, click an object in the Domains and Probes
access pane.

Depending on what you select in the Domains and Probes pane, different information is displayed in
the Details pane.

If you select...

@ DefauttDomain(Defaul)
EZ credentials
-] E:=§ Data Flow Probes

The information displayed is...

Domains and Probes. You can view details of all Probes
and you can define and edit job execution policies.

For details, see:
o "Data Flow Probes Pane" on next page

o "Job Execution Policy Pane" on page 43

EE Darmains and Probes
-5 [Defautt Domain(Defautt)|
EZ credertials
= Ec=§ Diata Flow Probes

A specific domain. You can add a description and view a
list of Data Flow Probes and passive discovery probes
defined and running in that domain.

For details, see:
¢ "Details Pane (Domain)" on page 42
o "Data Flow Probes Pane" on next page

e "Passive Discovery Probes Pane" on page 52

Du:umalns ahd Probes
DefaurtDDmaln(Defaurtj
E=' Credentlals

1 S4EIEI Protocal

— A S Protocal

[ Sy ' P TR

A specific protocol. You can add protocol parameters
and you can view details on the protocol, including user
credentials.

For details, see "[Protocol] Pane" on page 44

For a list of supported protocols, see the HP Universal
CMDB Discovery and Integration Content Guide.

EE Darnainz and Probes

E-mE° DefauttDomain (Default)
B2 credentials
~+E& Data Flow Probes

A specific Data Flow Probe. You can view details of the
Data Flow Probe, including range information. You can
also add ranges to, or exclude ranges from, the Data Flow
Probe, and you can remove a Data Flow Probe from

6 UCMDB.
For details, see:
e "Details Pane (Probe)" on page 42
¢ "Ranges Pane" on page 46
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If you select...

The information displayed is...

EE Darmainz and Probes
E-E Defautt DomainiDefautt)
E2 credertials
ET Data Flow Probes
—£7 Passive Dizcovery Probes
L MvDwMO714

Passive Discovery Probes. You can view and globally
configure notification types and verification policies for all
passive discovery probes that integrate with the Data Flow
Probes of the same domain.

For details, see "Passive Discovery Probes Pane" on

page 52.

A specific passive discovery probe.

Displays the details of a passive discovery probe,
including the Data Flow Probe to which it connects, and its
IP range information. You can also configure the IP ranges
to be monitored by the passive probe, and you can remove
a passive probe from the domain.

EE Darnainz and Probes
B DefauttDomain (Defaul)
E2 credentials
=EZ Data Flow Probes
L5 | aABM3MAMS
=55 Passive Dizcowvery Probes
L MvDvMO714

For details, see "Passive Discovery Probe Details Pane"
on page 49.

Data Flow Probes Pane

Enables you to view a list of all Probes connected to the server.

To access In the Domains and Probes pane, do one of the following:
¢ Select Domains and Probes

¢ Select Domains and Probes > <a domain>

User interface elements are described below:

Description
IP The main IP address with which the Probe communicates with the UCMDB server.
Last The last time that the Probe requested tasks from the server.
Access
Time
Name The name given the Probe when it was added to UCMDB.
Probe The version of the Probe.
Version

If the version of the Probe is not compatible with the version of the UCMDB server,
this is indicated. Moreover, if the incompatible Probe tries to connect to the UCMDB
server, the server sends a shutdown instruction to the Probe. To ensure compatibility,
you must upgrade the Probe manually. For details, see the section about manually
upgrading the Probe in the HP Universal CMDB Deployment Guide.
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Ul
Element

(A-2) Description

Status .

Connected. The Probe is connected to the server (the Probe connects every few
seconds).

Connected (suspended). The Probe is connected, but it is suspended such that
no jobs can run on the Probe.

Disconnected. The Probe is not connected to the server.

Details Pane (Domain)

This pane displays the details of the selected domain.

To access

In the Domains and Probes pane, select Domains and Probes > <a domain>

User interface elements are described below:

Ul Element

(A-2)

Description

Description | The description that was given to the domain when it was defined in UCMDB.
Domain e Customer. A private domain used for your site. You can define several
Type domains and each domain can include multiple Probes. Each Probe can

include IP ranges but the customer domain itself has no range definition.

o External. Internet/public domain. A domain that is defined with arange. The
external domain can contain only one Probe whose name equals the domain

name. However, you can define several external domains in your system.

Details Pane (Probe)

This pane displays the details of the selected Data Flow Probe.

To In the Domains and Probes pane, select Domains and Probes > <a domain> >
access | Probes > <a Data Flow Probe>

User interface elements are described below:

Ul Element
(A-Z)

Last time
probe
accessed
ucmMmbDB

Description

The last time that the Probe was accessed on the server machine.

Probe
Description

The description given to the Probe when it was added to UCMDB.
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Ul Element
(A-2Z)

Probe IPs

Description

The IPs of the Probe machine.

Note: If the Probe machine has more than one network card, all the IP addresses
are displayed.

Status

e Connected. The Probe is connected to the server (the Probe connects every
few seconds).

e Connected (suspended). The Probe is connected, but it is suspended such
that no jobs can run on the Probe.

¢ Disconnected. The Probe is not connected to the server.

Version

The version of the Probe.

Note: If the version of the Probe is not compatible with the version of the UCMDB
server, this is indicated. Moreover, if the incompatible Probe tries to connect to
the UCMDB server, the server sends a shutdown instruction to the Probe. To
ensure compatibility, you must upgrade the Probe manually. For details, see the
section about manually upgrading the Probe in the HP Universal CMDB
Deployment Guide.

Job Execution Policy Pane

Enables you to configure the periods of time when jobs should or should not run on selected Probes.

To access | Inthe Domains and Probes pane, select Domains and Probes.
Important e The default job execution policy is Always. This policy allows all jobs to run on
information any Probe at any time.
o Jobs that have a listening functionality—that is, they do not perform discovery,
for example, they listen to SNMP traps—are not included in a policy.
See also "Job Execution Policies" on page 23

User interface elements are described below:

ul

Element

(A-2) Description

Move priority up/down. Move the priority for the policy up or down. DFM executes
all the policies in the list with the first policy taking priority. If a job is included in two
policies, DFM executes the first policy only for that job.

New Policy. Opens the New Policy dialog box, enabling you to add a job execution
policy.

Remove Policy. Removes the selected job execution policy.
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Ul
Element
(A-Z)

Description

Note: If a job affected by the policy is active when the Remove command is
executed, UCMDB removes the policy but any of the job's triggers that are currently
running remain unaffected.

|§| Edit Policy. Opens the Edit Policy dialog box, enabling you to edit the selected job
o execution policy.

Jobs The jobs that are affected by the policy.

Probes | The Probes that are affected by the policy.

Time The schedule of the policy.

[Protocol] Pane

Enables you to manage protocol connection credentials.

Ul Element

(A-2) Description

|_| Create New Connection Details. Opens the Protocol Parameters dialog box,

o enabling you to define a connection credential for the selected protocol type. For
details, see "Protocol Parameter Dialog Box" on page 54.

s Remove Connection Details.Removes the selected connection credential.

|}| Edit Connection Details.Opens the Protocol Parameters dialog box, enabling

o you to edit the selected connection. For details, see "Protocol Parameter Dialog
Box" on page 54.

|E| :;3,| Copy/Move selected credential to another domain. Enables you to copy/move

- the selected protocol credential to another domain in the Domains and Probes tree.

|§| Export Certificate for Manual Agent Deployment. Enables you to export the

o Universal Discovery Agent certificate when installing the Universal Discovery
Agent manually. For details, see the section about manual Universal Discovery
Agent deployment in the HP Universal CMDB Discovery and Integration Content
Guide.
Available for: Universal Discovery Protocol only.

|Fr| 4 Move entry up/Move entry down. Enables you to move credential connections

o up or down to set the order in which credential sets are attempted. UCMDB tries to
connect using all the credential sets in the list with the first set taking priority.

<Protocol | Displays the defined connection credentials for the protocol type selected in the

connection | Domains and Probes pane. The details displayed in this section vary from protocol

details> type to protocol type. For details, see the relevant protocol information as
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Ul Element
(A-2Z)

Description

described in the Supported Protocols section in the HP Universal CMDB
Discovery and Integration Content Guide.

All protocol credentials include the following parameters:

¢ Index. Indicates the order in which credential instances are selected to make a
connection attempt. The lower the index, the higher the priority.

Default: Credentials are added with an auto-increasing index value. To update
the index, use the arrows buttons.

o Scope. To change the range that a protocol must discover or to select a Probe,
click Edit. For details, see "Scope Definition Dialog Box" on page 54.

Default: ALL.

o User Label. Enter a label to help you identify a specific protocol credential,
when you use it later. Enter a maximum of 50 characters.

<right-
click
menu>

Choose from the following options:

« Edit. Enables you to enter protocol parameters, such as user name and
password, that enable connection to an application on a remote machine.

« Edit using previous interface. Choose this option if:

= Ina previous version of UCMDB, you added parameters to this protocol that
do not exist in this version.

= Values in this version cannot be deleted. For example, in this version you
cannot configure SQL Protocol credentials with an empty port number.
Select this option to open the previous Edit Protocol Parameter dialog box
and delete the port number.

o Copy/Move to another domain. Enables you to copy/move the selected
protocol credential to another domain in the Domains and Probes tree..

o Check credentials. In the box that opens, enter the IP address of the remote
machine on which the protocol must run. The Probe attempts to connect to this
IP and returns an answer as to whether the connection succeeded or not.

« Export public certificates. Opens the Export dialog box, enabling you to
export the UD Agent certificate when deploying the UD Agent manually. For
details, see the section about manual agent deployment in the HP Universal
CMDB Discovery and Integration Content Guide.

<right-
click a
column
name>

Choose from the following options:
o Hide Column. Displayed when a column is shown.

o Show All Columns. Displayed when a column is hidden.
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Ul Element

(A-2)

Description

o Select Columns. Select to choose which columns to display or to change the
display order of the columns.

o Auto-resize Column. Select to change the column width to fit the contents.

Ranges Pane

Enables you to define network IP addresses on which a Probe must discover Cls.

To access In the Domains and Probes pane, select Domains and Probes > <a domain>
> Probes > <a Data Flow Probe>

Important For details on searching for a specific range, see the Find Probe Range by IP

Information | button in "Domains and Probes Pane" on next page.

User interface elements are described below:

Ul Element

(A-2)

Description

New IP Range. Opens the New IP Range dialog box, enabling you to define a
new IP range for the selected Probe. For details, see "New/Edit IP Range Dialog
Box" on page 35.

Delete IP Range. Select an IP range and click the button to delete a range from
the list.

Note: You can also delete an excluded IP range.

Edit IP Range. Opens the Edit IP Range dialog box, enabling you to edit the
selected IP range for the selected Probe. For details, see "New/Edit IP Range
Dialog Box" on page 35.

Note: You can also edit an excluded IP range.

Export Data To File. Enables you to export the defined IP ranges in Excel, PDF,
RTF, CSV, or XML format. For details, see "Cl Selector" in the HP Universal
CMDB Modeling Guide.

Import Ranges from CSV File. Opens the Import Ranges from File dialog box,
enabling you to select a CSV file from which to import a set of IP ranges.

Note: Before using this feature, verify that:
o theimported file is a valid CSV file

o theranges in the CSV file do not conflict with existing ranges, that is, there are
no duplicate or overriding ranges.

Expand All. Expands the entire hierarchical tree structure to display all of the
defined IP ranges, including the excluded IP ranges.
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Ul Element
(A-2) Description
|§| Collapse All. Collapses the hierarchical tree structure, leaving the top-level
o IP ranges showing, but hiding excluded IP ranges.
|E| Show/Hide Legend. Shows/Hides the legend for the Ranges pane.

o . Denotes the range of IP addresses included for the selected Probe.

) . Denotes a range of IP addresses to exclude from the defined IP range.
Range; The network IP addresses that the Probe uses to discover Cls. For details, see
Description | "New/Edit IP Range Dialog Box" on page 35.

Domains and Probes Pane

Enables you to view, define or edit a domain, connection credentials, Data Flow Probes, and
passive discovery probes.

Also enables you to automatically upgrade all the Data Flow Probes with the latest cumulative

patch (CUP).
To access Data Flow Management > Data Flow Probe Setup
See also e "Job Execution Policies" on page 23

o "Data Flow Probe Setup Window - Details Pane" on page 40

o "Passive Discovery Probes Pane" on page 52

User interface elements are described below:

ul

Element

(A-2) Description

|_| Add Domain or Probe. Adds a domain or a Data Flow Probe, depending on what is

T selected. For details, see "Add New Domain Dialog Box" on page 38 or "Add New
Probe Dialog Box" on page 39.

E Remove Domain or Probe. Deletes a domain, Data Flow Probe, or passive
discovery probe, depending on what is selected.

|E| Find Probe Range by IP. If a Probe has many defined ranges, you can locate a

— specific range: select the Probe and click Find Probe Range by IP. In the Find
Probe Range dialog box, enter the IP address and click the Find button. DFM
highlights the range in the Ranges pane.

|%| Reload Domain Information from Server. Updates all domain, Data Flow Probe,

T and passive discovery probe information from the server.
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Ul
Element

Description

o Suspend Probe. Suspends the selected Probe (Data Flow Probe or passive
discovery probe) from the UCMDB Server such that no jobs can run.

o Resume Probe. Resumes the Probe's ability to run discovery and integration
jobs.

Note: When a Probe is suspended, only the ability to run jobs is suspended. All other
processes continues to run as usual.

Deploy Probe Upgrade. Opens the Deploy Probe Upgrade dialog box, enabling you
to automatically upgrade the version of all the Data Flow Probes connecting to the
UCMDB Server with the latest cumulative patch (CUP).

In the Deploy Probe Upgrade dialog box, navigate to the Probe CUP .zip file.
Note:

o During the upgrade process, all compatible Data Flow Probes are automatically
restarted. If an integration is running on a Data Flow Probe while it is restarting, the
integration stops running, and starts over when the Data Flow Probe restarts. If an
integration is almost finished running, or a significant part has already run, to avoid
starting the integration over, we recommend letting it complete its run, and,
thereafter, upgrading the CUP.

o Data Flow Probes that are not compatible with the UCMDB Server are not updated
using this feature and must be updated manually. For details, see the HP Universal
CMDB Deployment Guide.

<Data
Flow
Probe
status
icons>

U2, Indicates that a Probe is connected.

U458, Indicates that a Probe is suspended.

o UT. Indicates that a Probe is disconnected.

Edit Related Probes Dialog Box

Enables you to select specific Probes.

To access

Click the Related Probes button |£| in the Edit Policy dialog box.

See also

"Job Execution Policies" on page 23

Edit Timetable Dialog Box

Enables you to set the times when a Probe must run a job execution policy.

To access Click the Edit €% button in the Edit Policy dialog box.
See also "New/Edit Policy Dialog Box" on page 37
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User interface elements are described below:

Ul Element

(A-2) Description

Description | Add a description of the specific policy. This field is mandatory.

Tip: The text you enter here appears in the Time box in the Job Execution Policy
pane, so it is recommended that the description be informative:

Job Execution Policy
ft ¥+ X 7
Time | Probes | Jobs
Labor Day weekend All Mone (total blackout)
Always All All
Time Click a cell for a day and time to be included in the policy. To add more than one

Definition time unit, drag the pointer over the cells.

Note: To clear a time unit, click the cell a second time.

Passive Discovery Probe Details Pane

This pane enables you to configure the passive discovery probes (HP RUM Engines) to monitor the
IP address ranges and ports that you specify.

To access Select Data Flow Management > Data Flow Probe Setup.

In the Domains and Probes pane, select a domain, and select a passive
probe under Passive Discovery Probes

Important The passive discovery probes can be configured to monitor the
information IP address ranges in the domain of the Data Flow Probe only .
Relevant task "How to Configure Just-In-Time Discovery" on page 193

See also e "Just-In-Time Discovery" on page 187

o "Passive Discovery Probes Pane" on page 52

Passive Discovery Probe Details Pane

User interface elements are described below :

Ul Element Description

Name The name given to the passive discovery probe (RUM Engine) when it was
defined in HP RUM.

Data Flow | The name of the Data Flow Probe to which the passive discovery probe reports.
Probe

IP The IP address of the passive discovery probe (RUM Engine) machine.
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Ul Element Description

Version The HP RUM version.

Status Indicates the status of the passive discovery probe:

e Connected. The passive discovery probe is connected and available to report
information to the Data Flow Probe.

o Suspended. The passive discovery probe is connected but unavailable to
report information to the Data Flow Probe.

o Disconnected. The passive discovery probe is not connected.

Last The date and time the passive discovery probe was last accessed.
access
time

Passive Discovery Ranges Pane

This pane lists the RUM Probes that report to the RUM Engine. This information is obtained from
the RUM Server.

User interface elements are described below :

Ul Element Description

Passive The name of the RUM Probe.

Discovery

Agent Name

Range The IP address range defined for the RUM Probe. Information from within

this range is reported to the RUM Engine (passive discovery probe).

Ports The ports defined for the RUM Probe over which information is reported.

Passive Discovery Integrated Ranges Pane

User interface elements are described below :

Ul Element Description

Use All Ranges Of Data Enables passive discovery over all IP address ranges of the
Flow Probe <Data Flow connected Data Flow Probe, over selected ports:

Probe name> . . .
o All available ports. Enables passive discovery over all

available ports.

« Selected ports Enables passive discovery over ports that

you select from the Global Ports List. Click [Lexel to select
ports to monitor.

Use Selected Ranges Of Enables the IP Ranges Definition area where you can select
Data Flow Probe <Data existing Data Flow Probe IP ranges of over which to perform
Flow Probe name> passive discovery. See below.
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Ul Element Description

Note: IP ranges must be a subset of the connected Data Flow
Probe's IP ranges.

IP Ranges Definition Area

User interface elements are described below :

Ul
Element

(A-2) Description

| : | New IP Range. Enables you to define a new IP address range for the passive
discovery probe to monitor.

Note: This IP range must be a subset of one of the Data Flow Probe's IP address
ranges.

For details about defining an IP address range, see "New/Edit IP Range Dialog Box"

on page 35
ﬁ Delete IP Range. Enables you to remove an IP address range defined for passive
discovery.
|¥| Select IP Range Enables you to select defined IP ranges for the passive discovery
o probe to monitor from the ranges defined for the connected Data Flow Probe.
|§| Edit IP Range. Enables you to modify a selected IP range.

For example, you can select one of the Data Flow Probes ranges, and then exclude
some IP address from that range for passive discovery.

|«:§_‘-| ,| Export Data To File.

Note: Not enabled for passive discovery probes.

=) Import Ranges from CSV File.

o Note: Not enabled for passive discovery probes.

|§| Expand All. Expands the hierarchical tree structure to display all of the defined
o IP ranges, including the excluded IP ranges.

|§| Collapse All. Collapses the hierarchical tree structure, hiding excluded IP ranges.
|E| Show/Hide Legend. Shows/Hides the legend for the Ranges pane.

o . Denotes the range of IP addresses included for the selected passive
discovery probe.

) . Denotes a range of IP addresses to exclude from the parent IP range.

<Ranges | Lists the IP address ranges and ports selected for the passive discovery probe to
grid> monitor.
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Passive Discovery Probes Pane

This pane enables you to globally configure notification types for all passive discovery probes that
integrate with the Data Flow Probes of the same domain. The passive discovery probes notify
UCMDB of changes in traffic, such as an unseen IP address or software not running.

To access Select Data Flow Management > Data Flow Probe Setup.

Inthe Domains and Probes pane, select a domain and select Passive
Discovery Probes.

Important The definitions defined here are valid for all of the passive discovery probes that
information | integrate with the Data Flow Probes of the same domain.

Relevant "How to Configure Just-In-Time Discovery" on page 193
task
See also "Just-In-Time Discovery" on page 187

Notification Types Pane
Note: By default all types of notifications are enabled.

User interface elements are described below :

Ul Element Description

Report IP ¢ Reports new IP addresses seen on the network.

notifications
fmeati ¢ Reports unseen IP addresses.

» Select the amount of time that the passive probe should wait
before triggering a notification that the IP address was not seen.

» After this notification is sent, the Data Flow Probe performs a
verification. Select an action that should be taken upon
verification:

o set the IP address as a candidate for deletion

o remove the IP address from UCMDB

Report running o Reports new running software seen on the network
software .
. . ¢ Reports unseen running software.
notifications
= Select the amount of time that the passive probe should wait

before triggering a notification that the software is not running.

» After this notification is sent, the Data Flow Probe performs a
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Ul Element Description

verification. Select an action that should be taken upon
verification:

o set the RunningSoftware Cl as a candidate for deletion

o remove the RunningSoftware Cl from UCMDB

Report dependency | Enables notification of dependency relationships.
link notifications

Removal Verification Policy Pane

User interface elements are described below:

Ul Element Description

Verify ports by Enables verification of listening ports by scanning.

scanning

Ping configuration Enables you to specify the number and frequency of pings to verify
for verification unseen |IP addresses before removal, as well as the overall number of
process simultaneous pings allowed.

Passive Probes Pane

Lists the passive discovery probes that are connected to Data Flow Probes.

User interface elements are described below:

Ul Element (A - 2) Description

Data Flow Probe The name of the Data Flow Probe to which the passive discovery probe
reports.

IP Address The IP address of the passive discovery probe (RUM Engine) machine.

Last access time The date and time the passive discovery probe was last accessed.

Name The name given to the passive discovery probe (RUM Engine) when it

was defined in HP RUM.

Status Indicates the status of the passive discovery probe:

o Connected. The passive discovery probe is connected and
available to report information to the Data Flow Probe.

o Suspended. The passive discovery probe is connected but not
available to report information to the Data Flow Probe.

+ Disconnected. The passive discovery probe is not connected.

Version The HP RUM version.
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Protocol Parameter Dialog Box

Displays the attributes that can be defined for a protocol.

To access | Data Flow Management > Data Flow Probe Setup > Domains and Probes >
Domain > Credentials, select a protocol and click the Add or Edit button.

Important For a description of each protocol, see the HP Universal CMDB Discovery and
Information | Integration Content Guide.

Scope Definition Dialog Box

Enables you to define ranges of IP addresses that a protocol must discover.

To access Click the Edit button in the Protocol Parameters dialog box.

User interface elements are described below:

Ul
Element

(A-2Z) Description

Selected | To select specific Probes whose IP range must be changed, click Edit. For details,
Probes | see"Choose Probe Dialog Box" on page 207.

Selected | « All. The protocol runs discovery on all ranges for the domain.

R
anges |, Selected Range. For the procedure to select a specific range on which the

protocol runs discovery or to define an excluded range, see "New/Edit IP Range
Dialog Box" on page 35.

Selecting Probes

The Choose Probe, Edit Probe Limitations for Query Output, and Edit Related Probes dialog boxes
include the following elements:

Ul Element (A—Z) Description

\ | Add Selected Probe. Click to add a Probe to the Selected Probes
column.

S——— Remove Selected Probe. Click to remove a Probe from the Selected
Probes column.

All Data Flow ¢ Select to add all Probes in the Non-selected Probes list.

Probes o Clearto add a specific Probe from the Non-selected Probes list.

Non-selected Probes that are not included in the policy/filter/limitations.

Probes

Selected Probes Probes that are included in the policy/filter/limitations.
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DataFlowProbe.properties File

A DFM process needs several parameters to be activated. These parameters specify the method to
be used (for example, ping five times before declaring a failure) and against which Cl a method
should be run. If parameters have not been defined by the user, the DFM process uses the default
parameters defined in the DataFlowProbe.properties file. To edit the parameters, open
DataFlowProbe.properties in a text editor.

The DataFlowProbe.properties file is located in the following folder:
C:\hp\UCMDB\DataFlowProbe\conf.

Caution: If you update the parameters in the DataFlowProbe.properties file, you must restart
the Probe so that it is updated with the changes.

The DataFlowProbe.properties file is divided into the following sections:

o Server Connection Definitions. Contains parameters that are needed to set up the connection
between the server and the Probe, such as the protocol to be used, machine names, default
Probe and domain names, time-outs, and basic authentication.

« Data Flow Probe Definitions. Contains parameters that define the Probe, such as root folder
location, ports, and Manager and Gateway addresses.

+ Probe Gateway Configurations. Contains parameters that define time intervals for retrieving
data.

o Probe Manager Configurations. Contains parameters that define Probe Manager
functionality, such as scheduled intervals, touching, result grouping, chunking, threading, time-
outs, filtering, and reporting multiple updates.

« I18N Parameters. Contains parameters that define language settings.

« Internal Configurations. Contains parameters that enable DFM to function efficiently, such as
thread pool size.

Caution: Internal configuration parameters should not be changed without an advanced
knowledge of Data Flow Management.

DataFlowProbe.properties Parameters

This section describes the DataFlowProbe.properties file parameters.
These include:

o "Server Connection Definitions" on next page

o "Data Flow Probe Definitions" on page 58

« "Probe Gateway Configurations" on page 60

¢ "Probe Manager Configurations" on page 61

o "I18N Parameters" on page 64
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Server Connection Definitions

Parameter Name (A-Z) Purpose Type Value Description
appilog.agent.Probe.BasicAuth.Realm | Used only when the string | Default: None
Probe should be
connected to the
UCMDB server using

proxy server

appilog.agent.Probe.
DownloadingTimeout

Timeout in ms. for
download configuration
files and userExt files
(that is, serverData
files).

long | Default: 300000

appilog.agent.probe.protocol

Defines the protocol
used to communicate
between the Probe
Gateway and the
Server.

string | HTTP or HTTPS
(SSL)

Default: HTTP

appilog.agent.Probe.
ServerTimeout

Timeout in ms. for Probe
requests going to the
server.

long | Default: 180000

appilog.agent.Probe.
BasicAuth.User

appilog.agent.Probe.
BasicAuth.Pwd

Basic authentication
feature of Probe to
Server. These properties
are supplied by the
admin who configured
the Web server.
Deprecated: certificate-
based, mutual SSL
authentication should be
used instead.

string | All keys must be
used to indicate
usage of this feature.
Values can be empty
to represent non-
values.

appilog.agent.Probe.JMX.
BasicAuth.User

appilog.agent.Probe.JMX.
BasicAuth.Pwd

Authentication data for
the Probe JMX.

string | All keys must be
used to indicate
usage of this feature.
Values can be empty
to represent non-
values. Password
has to be encrypted.
Encrypt password
using the Probe JMX
(that is, the
getEncryptedKey
Password operation
in the MainProbe
MBean).

bytes
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Parameter Name (A-Z) Purpose Value Description

appilog.collectors. The domain which the string | Default:
domain Probe Gateway belongs DefaultProbe
to (formerly known as
the Domain of the
Probe).

appilog.collectors. The type of the domain. | string | customer; external

domain.type
yp Default: customer

appilog.collectors.probe.name The Probe name used string | Uses the value
for identification on defined during
UCMDB server installation

appilog.collectors. The Probe ID attribute. string | Default: the machine
probe.name Used to identify the name

Probe Gateway by the
UCMDB server. The
server uses this ID to
transfer tasks to the
appropriate Probe
Gateway.

http.proxyHost Used only when the string | DNS names
Probe should be
connected to the
UCMDB server using
proxy server

http.proxyPass Used only when the string | Default: None
Probe should be
connected to the
UCMDB server using
proxy server

http.proxyPort Used only when the int Default: None
Probe should be
connected to the
UCMDB server using
proxy server

http.proxyRealm Used only when the string | Default: None
Probe should be
connected to the
UCMDB server using
proxy server

http.proxyUser Used only when the string | Default: None
Probe should be
connected to the
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Parameter Name (A-Z) Purpose Value Description
UCMDB server using
proxy server

jettyHttpPort The port of the jetty int Default: 8090
server used by Probe.

jettyHttpsPort The https port of the int Default: 8453
jetty server used by
Probe

server.webApp. Name of the server Web | string | Default: mam-

name application (.war file) collectors
responsible for the
Probe.

serverName Defines the Server DNS | string | The DNS name

name to which the Probe
Gateway connects.

serverPort The port number for int Default: 8080
HTTP communication.

serverPortHttps The port number for int Default: 8443
HTTPS communication.

Data Flow Probe Definitions

Parameter Name Purpose Value Description
appilog.agent. My SQL authentication | string To change the DB password:
local.jdbc.user info. .
bytes 1. The OOTB script set_dbuser
appilog.agent. password.cmd can be used in
local.jdbc.pwd order to change the password
of the default MySQL user.

2. The password value in the
properties file should be
encrypted. Encrypt the
password using the Probe
JMX (that is, getEncryptedKey
Password operation in

MainProbe MBean).
appilog.agent. Probe GW database info | string Default:
probe.jdbc.driver ) com.mysql.jdbc.Driver
string
appilog.agent. Default:
probe.jdbc.uri jdbc:mysql://localhost/probeMgr

?autoReconnect=true
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Parameter Name

Purpose

Value Description

storeDomain
ScopeDocument

DomainScope
document is stored on
file system and internal
DB.

false: Encrypted
DomainScope
document is retrieved
from server each startup

appilog.agent. Probe GW string Password has to be encrypted.
probe.jdbc.user authentication info byt Encrypt password using the Probe
| ) ytes JMX (that is, getEncryptedKey
appl °9-age” ) Password operation in MainProbe
probe.jdbc.pwd MBean)
appilog.agent.local. Probe Manager string Default: com.mysql.jdbc.Driver
jdbc.driver database info .
string Default:
appilog.agent.local. jdbc:mysql://localhost/probeMgr
jdbc.uri ?autoReconnect=true
appilog.agent.netflow. | Netflow database info boolean | jdbc:mysql://localhost/netflow
jdbc.uri ?autoReconnect=true
&jdbcCompliantTruncation=false
appilog.collectors. true: Probe GW process | boolean | Default: true
probelLocal should also run a Probe
Union Manager on same JVM.
false: Probe manager
runs separately
appilog.collectors. Internal communication | int Default: 1199
ProbeUseSpecific port ) .
RMIPortFrom 0: Ports are allocated automatically
appilog.collectors. Communication port int Default: 1742.
rmi.gw.port between Probe GW and R
Probe Managers in case Note: ;I'hlsl;/glute ﬁhgtgd t:)e the
they are installed on :/|ame or ablTs a. © ¢ rt(|)q'ep b
separate processes anagers belonging to this Probe
Gateway.
appilog.collectors. Internal communication | int Default: 1741.
rmi.port port )
Note: This value should be the
same for all installed Probe
Managers belonging to this Probe
Gateway.
appilog.collectors. true: Encrypted boolean | Default: true
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Parameter Name Purpose Value Description
and stored only in
memory.
appilog.collectors. The Probe Manager & string DNS Names
local.ip Gateway IP addresses i
. or DNS names string
appilog.collectors.
probe.ip
appilog.collectors. Probe JMX console int Default: 1977
probe.html.port ports. Usedtomanage | . ¢ Default: 1978
) the Probe components. n etault.
appilog.collectors.
local.html.port
Probe Gateway Configurations
Value
Parameter Name Purpose Type Description
appilog.agent. The interval in ms. between | long Default: 30000
probe. reconnection attempts of
reconnection. the Probe Gateway to its
interval Probe Managers.
appilog.agent. The interval in ms. between | long Default: 15000
probe.retrieve task requests from the
tasksFromServer. server by the Probe
interval Gateway.
appilog.agent.probe. true: Results sent to the boolean | Default: false
saveResultsInBKPTable Server are stored in the

database in a backup table.

false: Results are not
stored in a backup table.

appilog.agent.probe. Downloaded jar file long
restartProbeAfterJarDownload.interval | resources can cause the
Data Flow Probe to restart
before all the other
resources of an adapter
package have downloaded.
This parameter prevents the
restart from occurring.

Default: 180000
msec
(3 minutes)

Note: The delay
until a restart on
the first
resource
download (that
is, for afirst
start or after
clearing the
Probe data) is
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Value
Parameter Name Purpose Description
10
milliseconds.
Probe Manager Configurations
Value
Parameter Name Purpose Type Description
appilog.agent. Maximal time (in msec) which a long Default:
local.max.worker.runtime worker thread is allowed to run. After | . ¢ 900000
. this period it is considered as stuck. In
appilog.agent. bool Default: 10
local.max.stuck Maximal number of worker threads oolean Default:
i " which can be considered as stuck at ¢ efault:
lappllogﬁagin : K the same time. When the number is rue
_I?;a -check.stuc reached, the Probe schedules a
reads restart to release these threads.
true - the Probe Manager should
detect stuck threads.
false - otherwise.
appilog.agent.local.services. The maximum number of remote int Default: -1
maxRemoteProcesses processes allowed to be created (no limit)
during discovery. Remote processes
are used to separate specific
discovery from Probe process to
prevent the Probe from possible
memory issues.
Used, for example, in J2EE
Discovery.
appilog.agent.local.services. The maximum number of remote int Default: 3
maxRemoteProcessesPerJob processes per job that are allowed to
run simultaneously.
appilog.agent.local.process.result. | Defines whether to validate data boolean | Default:
dataValidation.content reported to the UCMDB server by true
content. Deals mainly with reported
values (i.e. attribute value), rather
than metadata of objects.
appilog.agent.local.process.result. | Defines whether to check data boolean | Default: true
checkMultiUpdate consistency on objects.
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Parameter Name

Purpose

Value

Description

ResultSize

appilog.agent.local.process.result. | e true. If Cls were ignored by boolean | Default:
filterRedundant.filterignoredCls reconciliation on a discovery true

cycle, as long as they have not

undergone any changes, they are

filtered by the Probe on

subsequent discovery cycles, and

awarning is displayed on the

trigger Cl level. Toresend these

objects, you must clear the results

cache.

o false. Evenif Cls that were

ignored by reconciliation, they are

still sent to the UCMDB on each

discovery cycle, together with new

and updated Cls.
appilog.agent. Maximal number of concurrent int Default: 80
local.services.poolThreads threads allocated for the multi-

. . threaded job's execution activity. .
appilog.agent.local.services. int Default: 8
defaultMAxJobThreads Maximal number of concurrent i

) , threads running on a specific job. int Default: 20
appilog.agent.local.services.
adHocMaxThreads Maximal number of threads for ad-hoc

tasks.
appilog.agent. true - validate links are legal. boolean | Default: true
I;Zillf(;(;fsss' false - do not validate links.
Validation.
validLinks
appilog.agent. true - filter results which have been boolean | Default:
local.process. already sent to server. true
result. boolean
filter false - disable filter. Default:
Redundant true
appilog.agent. True: DiscoveryAnalyzer is executed | boolean | Default:
local.discovery from Eclipse. false
AnalyzerFrom . .
Eclipse False: DiscoveryAnalyzer is not

executed from Eclipse.
appilog.agent Chunk maximal size of results being | int Default:
local.maxTask sent to the server. 20000
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Parameter Name

Purpose

Value
Description

appilog.agent. Interval (in msec) before auto-restarts | long Default;
local.probe.restart.interval of the Probe Manager. 900000
appilog.agent. true - send autodelete notification to boolean | Default:
local.process. Server for aged objects, not true
result.autoDelete discovered by the Probe.

false - do not send

Note: This can be enabled only if

appilog.agent.local.process.

result.filterRedundant is enabled.
appilog.agent true - filter results be predefined rules | boolean | Default:
.local.process. (Cl types). true
result.filterCl )

false - otherwise
appilog.agent.local. true - fix direction of illegal links. boolean | Default:
process.result.fixLinks . true
Direction false - otherwise.
appilog.agent.local. true - Reports multiple update boolean | Default:
process.result.warnOn warnings to the UCMDB server. true
MultiUpdate ) ,

Note: This parameter is global. It can

be overridden on the adapter level by

the warnOnDuplicates parameter

which is absent by default, but gets

its value from the global parameter.
appilog.agent. Timeout (in msec) for the Probe to long Default:
local.serverdata. sync with Server data before starting 60000
sync.timeout executing tasks.
appilog.agent. Filter characters from string attributes | string Default:
local.special of result objects which are reported to empty string
Characters server by Probe. (do not filter)
Remove
appilog.collectors.probemgr. Probe Mgr - Result Grouping defaults | long Default:
DefaultResultGroupMaxObjs (used when DFM adapter does not 5000

) override). Grouping means holding on long

appllog.collectors.propemgr. to results and sending them to the Defaultf
DefaultResultGroupMinTime Gateway only upon meeting one of 30000 (in

the grouping thresholds. This is used ms.)

to control the rate of data flowing from Relation

Probes to the Server. between

two keys:
OR
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Value
Parameter Name Purpose Description
appilog.agent.probe. The touch window defines the period | boolean | Default:
touchWindowMechanism.isActive | when touch process is allowed . The false
parameter defines whether the touch
window mechanism is active.
appilog.agent.probe. Defines the time, in hours and string Format:
touchWindowMechanism.startTime | minutes, when the touch window HH:MM
starts
Values:
00:00-23:59
Default:
00:00
appilog.agent.probe. Defines the time, in hours and string Format:
touchWindowMechanism.endTime | minutes, when the touch window HH:MM
ends
Values:
00:00-23:59
Default:
23:59

118N Parameters

Parameter Name Purpose Type Value Description
appilog.collectors.encoding.ANSI | Default encoding used for string | Default: empty (ANSI
Windows applications encoding is chosen
(requiring ANSI encoding) from the Data Flow
Probe operating
system)
appilog.collectors.encoding.OEM | Default encoding used for string | Default: empty (OEM
DOS/UNIX Shells/IBM encoding is chosen
encoded applications. from the Data Flow
Probe operating
system)
chcpCodeTo Mapping entry between chcp string | Syntax: chcpCodeTo
CharasetName. code page to specific encoding CharasetName.
XXX name (used for cases where <code>=<encoding_
the cp+<code> rule is not name>
followed) Example:
chcpCodeTo
CharasetName.
932=MS932
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Parameter Name Purpose Value Description
collectors_ Language settings (must be string | Default: English
language manually configured for non- Options: get=German

English environments). )
rus=Russian

Content Data Validation Jython Scripts

The Content Data Validation Jython scripts are divided into main scripts and library scripts. Each
"main" script must have the ValidateData function which is the entry point for the execution of data
validation. The ValidateData function has the following parameters:

« TaskResults. Provides the AP| accessing data objects.

« Environment. Provides the API for accessing Environment information, such as the Probe
Gateway name, the Probe Gateway IP, and the domain name.

The dataValidationlibs.xml file is a configuration file where you define which scripts to execute
and which to execute as libraries. The file is divided into sections which logically define the data
validation execution.

Example of the dataValidationlibs.xml File

<datavalidation parserClassName="com.hp.ucmdb.discovery.
library.communication.downloader.cfgfiles.
ContentDataValidationConfigFile">

<script name="dataValidatorl.py">
<library name="validatorl.py"/>
</script>
<script name="dataValidator2.py" cit="Node,Process">
<library name="validator2.py"/>
<library name="validator3.py"/>
</script>

</datavalidation>

where:
o validator<x>.py is a library script.

Libraries must be ordered according to their dependency. In this example, validator3.py uses
validator2.py, so validator3.py appears after first validator2.py.

o The cit parameter lists the CITs that the script receives for validation. In this example, the
dataValidator2.py script receives only Node and Process CITs for validation.
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Handling Errors and Warnings

o addError/addWarning. Use this API from the TaskResults parameter to attach error/waming
to triggered Cls. Bulk is reported to the UCMDB server.

« raise ContentDataValidationException. Use to report an error message if the bulk should be
discarded.

Example of APl Usage
o Main Script

fdataValidatorl.py
import validatorl

def ValidateData (TaskResults, Environment) :

logger.info ('probe gateway is :', Environment.
getProbeGatewayID())

logger.info ('probe gateway ip is :', Environment.
getProbeGatewayIP ())

logger.info ('probe domain is :', Environment.

getProbeManagerDomain () )

objectsForUpdate = TaskResults.getResultObjects ()
size = objectsForUpdate.size ()
if size > 0:
for i in range (0, size):
object = objectsForUpdate.get (i)
validatorl.validate (object, TaskResults)
if object.getObjectClass () == 'host':

TaskResults.addError (100, 'host CIT is not in class
model"')

pass

o Library Script

#validatorl.py
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from com.hp.ucmdb.discovery.library.results.resultprocess import
ContentDataValidationException

def validate (object, TaskResults):
if object.getAttribute ('description') == None:

TaskResults.addWarning (100, 'No description set for the object
of type ' + object.getObjectClass())

if object.getAttribute ('host hostkey') == None:

// fatal error, all bulk and all previous errors will be removed
from bulk

// this error will be shown in UI

raise ContentDataValidationException, 'Attribute host hostkey is
absent'

Data Flow Probe Log Files

Probe logs store information about job activation that occurs on the Probe Gateway and Probe
Manager. The log files can be accessed from the following location:

C:\hp\UCMDB\DataFlowProbe\runtime\log

Note: Alternatively, to access the Probe's log files, log in to the JMX console (http://<probe
machine>:8090/jmx-console/) and, from the main page, select the GeneralUtils mbean.
Activating the executeLogGrabber function zips all the Probe's log files. Save the .zip file
locally on your client machine.

Log files include:

e "General Logs" below

o "Probe Gateway Logs" on next page

o "Probe Manager Logs" on page 69

General Logs

WrapperProbeGw.log

Records all the Probe's console output in a single log file.

Level Description

Error Any error that occurs within the Probe Gateway.

Information | Important information messages, such as the arrival or removal of a new task.

Debug N/A
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Basic Troubleshooting. Use this file for any Probe Gateway problems to verify what occurred
with the Probe Gateway at any time as well as any important problems it encountered.

probe-error.log

Summary of the errors from the Probe.

Error All errors in the Probe components.
Information N/A
Debug N/A

Basic Troubleshooting. Check this log to verify if errors occurred in the Probe components.

probe-infra.log

List of all infrastructure messages.

Error All infrastructure errors.
Information Information about infrastructure actions.
Debug Messages mainly for debug purposes.

Basic Troubleshooting. Messages from the Probe's infrastructure only.

wrapperlLocal.log

When running the Probe in separate mode (that is, the Probe Manager and Probe Gateway are
installed on separate machines), a log file is also saved to the Probe Manager.

Level Description

Error Any error that occurs within the Probe Manager.

Information | Important information messages such as received tasks, task activation, and the
transferring of results.

Debug N/A

Basic Troubleshooting. Use this file for any Probe Manager problems to verify what occurred
with the Probe Manager at any time as well as any important problems it encountered.

Probe Gateway Logs

probeGW-taskResults.log

This log records all the task results sent from the Probe Gateway to the server.
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Level Description

Error N/A

Information | Result details: task ID, job ID, number of Cls to delete or update.

Debug The ObjectStateHolderVector results that are sent to the server (in an XML
string).

Basic Troubleshooting

o If thereis a problem with the results that reach the server, check this log to see which results
were sent to the server by the Probe Gateway.

o The results in this log are written only after they are sent to the server. Before that, the results
can be viewed through the Probe JMX console (use the ProbeGW Results Sender MBean).
You may have to log in to the JMX console with a user name and password.

probeGW-tasks.log

This log records all the tasks received by the Probe Gateway.

Level Description

Error N/A
Information N/A
Debug The task's XML.

Basic Troubleshooting

o If the Probe Gateway tasks are not synchronized with the server tasks, check this log to
determine which tasks the Probe Gateway received.

e You can view the current task's state through the JMX console (use the Discovery Scheduler
MBean).

Probe Manager Logs

probeMgr-performance.log

Performance statistics dump, collected every predefined period of time, which includes memory
information and thread pool statuses.

Level Description

Error N/A
Information N/A
Debug N/A

Basic Troubleshooting
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o Check this log to investigate memory issues over time.
o The statistics are logged every 1 minute, by default.

probeMgr-adaptersDebug.log

This log contains messages that are created following a job execution.

Troubleshooting and Limitations

Troubleshooting

Problem. You cannot transfer a Data Flow Probe from one domain to another. Once you
have defined the domain of a Probe, you can change its ranges, but not the domain.

Solution. Install the Probe again:

1. (Optional) If you are going to use the same ranges for the Probe in the new domain, export the
ranges before removing the Probe. For details, see "Data Flow Probe Setup Window - Details
Pane" on page 40.

2. Remove the existing Probe from UCMDB. For details, see the Remove Domain or Probe
button in "Domains and Probes Pane" on page 47.

3. Install the Probe. For details, see the section about installing the Data Flow Probe in the HP
Universal CMDB Deployment Guide.

4. During installation, make sure you give a different name to the Probe from the one used by the
old Probe.

Problem. Discovery shows a disconnected status for a Probe.
Solution. Check the following on the Probe machine:

¢ That the Probe is running

e That there are no network problems

Problem. The connection between the HP Universal CMDB server and the Probe fails due
to an HTTP exception.

Solution. Ensure that none of the Probe ports are in use by another process.

Problem. A Data Flow Probe node name cannot be resolved to its IP address. If this
happens, the host cannot be discovered, and the Probe does not function correctly.

Solution. Add the host machine name to the Windows HOSTS file on the Data Flow Probe
machine.

Problem. After uninstalling the Data Flow Probe, mysqld.exe and associated files are not
deleted.

Solution. To delete all files, restart the machine on which the Data Flow Probe was installed.

Limitations

Limitation.If you reconfigure a Data Flow Probe to work with a different UCMDB server, you must
first run the clearProbeData.bat file before you restart the Probe.
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Data Flow Probe Status

This chapter includes:

Data Flow Probe Status OVerview. . . ... .. 71
View Current Status of Discovered Cls. .. ... ... 71
Data Flow Probe Status User Interface. . . ... ... e 71

Data Flow Probe Status Overview

You use Data Flow Probe Status to view the current status of the discovered Cls in the Probes.
Data Flow Probe Status retrieves the status from the Probes and displays the results in a view.

The view is not automatically updated; to refresh the status data, click the Get snapshot i
button .

View Current Status of Discovered Cls

This task describes how to view the current status of discovered Cls.
This task includes the following steps:

o "Prerequisites" below

o "Access Data Flow Probe status" below

1. Prerequisites

Verify that the Probe is enabled and is connected to the HP Universal CMDB server. For
details, see "How to Start the Data Flow Probe" on page 27.

2. Access Data Flow Probe status

a. Goto Data Flow Management > Data Flow Probe Status.
b. Select a connected Probe.

All current jobs in the Probe are listed, together with their status. For details, see "Data
Flow Probe Status Window" on next page.

c. Click the Get Snapshot {@l button.

d. Select jobs from the Progress list and click the View Job progress g}\'j button. The Job
Details window opens.

Data Flow Probe Status User Interface

This section includes:
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o "[Job Name] Dialog Box" below

e "Data Flow Probe Status Window" below

[Job Name] Dialog Box

Enables you to view details about a job, including its scheduling, as well as job statistics.

To access

In the Progress pane of the Data Flow Probe Status window do one of the following:

€]

e Select ajob and click the View job progress button

e Double-click ajob

User interface elements are described below:

Ul
Element
(A-Z)

Description

Job o Status. Can be Scheduled (the job runs according to a defined schedule) or
Details Running (the job is running now).

o Last updated. The last time that the job was updated.

o Threads. The number of threads currently allocated to this job.

o Progress. The number of Trigger Cls in the job and the number of Trigger Cls
that the Probe has finished working on.

Schedule | « Previous invocation. The last time that Universal Discovery ran the job.

« Next invocation. The next time that Universal Discovery is scheduled to run the
job.

o Last duration. The length of time, in seconds, taken to run the job in the previous
invocation. This is calculated according to the start time of the first trigger until
the end time of the last trigger, even if triggers were added later on.

o Average duration. The average duration (in seconds) per trigger of the time it
took the Probe to run this job.

« Recurrence. The number of times the job ran via the scheduler (manual runs are
not counted).

Statistics | For details, see "Statistics Results Pane" on page 75.
Results

Data Flow Probe Status Window

Enables you to view the current status of discovered Cls and all active jobs running on the Probes.

To access

Data Flow Management > Data Flow Probe Status
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Important
Information

Depending on what you select in the Domains Browser pane, different
information is displayed in the viewing pane.

If you select:
e adomain, you can view details and CIT statistics for the domain.

e aProbe, you can view details on the Probe (such as the Probe IP), the
progress of a job and you can view CIT statistics.

For details see

= "Details Pane (Domain)" below
= "Details Pane (Probe)" below

= "Progress Pane" on next page

= "Statistics Results Pane" on page 75

Relevant
tasks

"View Current Status of Discovered Cls" on page 71

See also

"Data Flow Probe Status Overview" on page 71

Domain Browser Pane

Displays the domains and Probes defined in the UCMDB system in a tree view.

Details Pane (Domain)

Displays the details of the domain selected in the Domains Browser pane.

User interface elements are described below:

Ul

Element
(A-2) Description

Domain | «
Type

For details on defining domains, see "Add New Domain Dialog Box" on page 38.

Customer. A private domain used for your site. You can define several domains
and each domain can include multiple Probes. Each Probe can include IP ranges
but the customer domain itself has no range definition.

External. Internet/public domain. A domain that is defined with a range. The
external domain can contain only one Probe whose name equals the domain name.
However, you can define several external domains in your system.

Details Pane (Probe)

User interface elements are described below:
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Ul

Element
(A-2) Description

m Refresh. Displays the most current status of the discovered Cls and jobs on the
selected Probe.

Last The date and time at which the Get snapshot button was last pressed (that is, the
updated date and time of the data displayed in Data Flow Probe Status).

Probe IP The IP address which the Probe communicates with UCMDB.

Running The number of jobs running on the Probe.

jobs

Scheduled | The number of jobs that are scheduled to run according to the settings in the

jobs Discovery Scheduler. For details, see "Discovery Scheduler Dialog Box" on page
227.

Status The status of the Probe:

« Connected. The Probe has successfully connected to the server (the Probe
connects every few seconds).

e Connected (suspended). The Probe is suspended such that no jobs can run on
the Probe.

o Disconnected. The Probe is not connected to the server.

Threads The sum of all threads currently allocated to the running jobs.

Progress Pane

Displays the progress of the jobs on the selected Probe.

User interface elements are described below:

Ul Element

(A-2) Description

(E View Job progress. Opens the [Job Name] dialog box, enabling you to view
the view details of the selected job.

Available: When a job in the Progress pane in selected.

Tip: Alternatively, double-click a job to display its details. For details, see "[Job
Name] Dialog Box" on page 72.

Job The name of the job scheduled to run on the Probe.
Next The next time that the Probe is scheduled to run.
invocation
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Ul Element

(A-2) Description

Previous The last time that the Probe ran.

invocation

Progress o Ifajob has not started running, the Progress column displays Scheduled.

e Ifajobis running, the progress of the running job is displayed.

Thread count

The number of threads currently allocated to this job.

Triggered Cls

The number of Cls triggered in the job.

Statistics Results Pane

Enables you to view details and CIT statistics.

To access

Click the Default Domain or Probe name in the Domains Browser pane.

User interface elements are described below:

Ul Element
(A-2) Description
|%| Enables you to retrieve the latest data from the Probe.
Note: This data is not automatically updated.
S| Set Filter. Enables you to set the time range for which to display statistics about
the CITs.
o All. Displays statistics for all job runs.
o Last Hour/Day/Week/Month. Choose a period of time for which to display
statistics about the CITs.
¢ Custom Range. Click to open the Change Timeframe dialog box: Enter the
date or click the arrow to choose a date and time from the calendar, for the
From and To dates (or click Now to enter the current date and time). Click Last
Day to enter the current date and time in the To box and yesterday's date and
time in the From box. Click OK to save the changes.
CIT The name of the discovered CIT.
Created The number of CIT instances created by the Probe.
Deleted The number of CIT instances deleted by the Probe.
Discovered | The sum of all the Cls for all the invocations.
Cls
Filter The time range set with the Set Filter button.
Last The date and time that the statistics table was updated for a particular Probe.
updated
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Ul Element
(A-2) Description
Updated The number of CIT instances that have been updated.
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Adapter Configuration

This chapter includes:

Discovering Running Software. . .. ... . 78
Identifying Running Software by Processes. ... ... . . ... 79
Automatically Deleted Cls and Relationships and Candidates for DeletionCls................. 80
How to Configure Adapter Settings. .. ... . 81
How to Configure Full Population Run. ... ... 82
How to Configure Cl Aging Settings. . . ..o 82
How to Discover Running Software —Scenario. . . . ... oL 83
How to Attach Discovery Documentation to a Discovery Package. ............. . .............. 85
How to Attach Readme to a Discovery Package. ... ... . . ... 86
How to Filter Probe Results. . . ... ... i 86
Adapter Management UserInterface.......... ... i 88
Internal Configuration Files. .. ... . 123

Discovering Running Software

You can discover software (for example, a specific Oracle database) running in your environment.
This section includes the following topics:

o "Discovery Process" below

¢ "Running Software Default View" on next page

Discovery Process

The discovery process runs as follows:

e The Host Resources and Applications jobs are activated.

o DFM searches for processes on the machines in your environment.

o DFM saves the process data (including open port and command line information) to the Probe
database.

e The jobs run on this data in the Probe database, build the new RunningSoftware Cls according
to the data in the database, and extract the key attributes from the process data. The jobs send
the Cls to the UCMDB Server.

Page 78 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 4: Adapter Configuration

Running Software Default View

A default view displays the mapping of relationships between applications: Modeling > Modeling
Studio > Resources pane > Root > Application > Deployed Software.

You can configure DFM to discover running software. For details, see "How to Discover Running
Software — Scenario" on page 83.

Identifying Running Software by Processes

An application is identified by the existence of one or more running processes which are defined by
their names and by command line (optional).

A process can be optionally marked as a key process or as a main process.
An application is identified if the following holds true:

o Atleast one process was found.

o All processes that are marked as key processes exist.

If an application is identified, a result RunningSoftware Cl is created for the application obeying the
following rules:

o If none of the processes is marked as a main process, a single RunningSoftware Cl will be
created, linked to all discovered processes by dependency relationships.

o If there are processes that are marked as main processes, a RunningSoftware CI will be created
for each instance of these main processes.

For example, assume that rules are defined for the identification of two applications, application_a
and application_b:

o application_ais identified by proc.exe and unique_ proc_a.exe.
o application_b is identified by proc.exe and unique_ proc_b.exe.

Say that proc.exe is found but none of its processes are marked as key or main processes. In this
case, RunningSoftware Cls are created for both application_a and application_b. These Cls are
linked by a dependency relationship to the same process (that is, proc.exe).

Assume too that unique_proc_a.exe and unique_proc_b.exe are marked as key processes:
o If the proc.exe process only is discovered, a RunningSoftware Cl is not created.

o Ifunique_ proc_a.exe is discovered, RunningSoftware Cls are created for application_a
linked by a dependency link to unique_ proc_a.exe. If in addition, proc.exe is discovered, it is
linked to the same CI. The same holds for application_b.

Assume that two instances of unique_proc_a.exe are discovered:

o If the process is not marked as a main process, a single RunningSoftware Cl is created for
application_a linked to both processes.

o If the process is marked as a main process, two separate RunningSoftware Cls are created for
application_a.

For details on the key field in the Software Identification Rule Editor dialog box, see "Identifying
Processes" on page 122.
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Automatically Deleted Cls and Relationships and
Candidates for Deletion Cls

During discovery, the Data Flow Probe compares Cls found during the previous, successful
invocation with those found during the current invocation. A missing component, such as a disk or
software, is assumed to have been removed from the system, and its Cl is deleted from the Probe's
database.

You can define that Cl instances are to be deleted for specific jobs. For details, see "How to
Configure the Data Flow Probe to Automatically Delete Cls" on page 32.

By default, the Data Flow Probe deletes Cl instances of certain CITs, for example, the current
configuration for the Host Resources and Applications jobs (snmp: file system, installed software,
osuser, service).

Note: The Data Flow Probe does not wait for the aging mechanism to perform the calculation
but immediately sends a deletion request to the server. For details about aging, see "The Aging
Mechanism Overview" in the HP Universal CMDB Administration Guide.

Candidates for Deletion

You can mark a Cl instance as a candidate for deletion. This enables you to isolate Cls instead of
them being automatically deleted when they are not discovered.

Note:
e The change is defined on the job's adapter.

o If discovery fails and errors occur, objects are sent for deletion according to how the results
are managed. For details, see "Results Management Pane" on page 97.

o Carefully choose the Cls that are to be candidates for deletion. For example, process CITs
are not good candidates because they are often shutting down and starting up again and as
aresult may be deleted at every invocation.

¢ You can use this procedure to delete relationships, too. For example, the containment
relationship is used between a node and an IP address. A laptop machine is allocated a
different IP address very often; by deleting the relationship, you prevent the accumulation of
old IP addresses attached to this node.

Example of Automatic Deletion

During the previous invocation, the Data Flow Probe ran the Host Resources and
Applications by WMI job and discovered a host with disks a, b, ¢, and d. During the current
invocation, the Probe discovers disks a, b, and ¢, compares this result with the previous
result, and deletes the Cl for disk d.
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More Information

¢ You can view deleted Cls in the Probe log and in the Deleted column in the Statistics Results
pane. For details, see "Data Flow Probe Log Files" on page 67 and "Statistics Results Pane" on
page 220.

o Fordetails on setting automatic deletion, see "Adapter Configuration Tab" on page 96 in the
Results Management pane.

How to Configure Adapter Settings

You should edit adapter and XML files in one of the following ways:

Change the adapter's definitions in the Adapter Management module
Note: This method is recommended.

1. Navigate to Data Flow Management > Adapter Management.

2. Inthe Resources pane, select the adapter file in the Packages > <package name> >
Adapters folder.

3. Do one of the following:

= To edit general adapter settings, use the Adapter Definition and Adapter Configuration
tabs. For details, see "Adapter Definition Tab" on page 89 and "Adapter Configuration Tab"
on page 96.

= To define specific settings for the selected adapter, right-click the adapter and select Edit
Adapter Source from the shortcut menu.

Edit the adapter package and redeploy it using the Package Manager

Export the package to your local drive, edit the package and redeploy it. For information see, Export
a Package and Deploy a Package in the HP Universal CMDB Administration Guide.

Use the JMX Console

1. Launch the Web browser and enter the server address, as follows:
http://<UCMDB Server Host Name or IP>:8080/jmx-console.

You may have to log in with a user name and password.

2. Under UCMDB, click UCMDB:service=Packaging Services to open the JMX MBEAN View
page.

Locate the listSubsystems operation.
Enter the Customer ID value and click Invoke.

Click the discoveryPatterns or discoveryConfigFiles link.

o o »> W

Click the resource to edit.
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How to Configure Full Population Run

Because the UCMDB 9.0x adapter only synchronizes changes, over time Cls are not touched and
are aged out. Therefore, by default, the UCMDB 9.0x adapter runs a full population job every seven
days.

To change the full population value of the UCMDB 9.0x adapter:
1. Open the CmdbAdapter adapter source.

a. Select Data Flow Management > Adapter Management > Resources pane >
CmdbAdapter.

b. Under Adapters, right-click CmdbAdapter, and select Edit Adapter Source.
2. Inthe source file, locate the following tag:
<full-population-days-interval>
7
</full-population-days-interval>

3. Edit the value as follows:

Value Description

7 Run full population job every 7 days
1 Run full population job each day

0 Always run a full population job

-1 The option is disabled

How to Configure Cl Aging Settings

This task explains how to configure the aging mechanism for adapters.

To learn more about aging, see "The Aging Mechanism Overview" in the HP Universal CMDB
Administration Guide.

To enable aging of Cls:
1. Select the adapter: Adapter Management > Resources pane > Packages > <adapter>

2. Inthe Adapter Configuration tab, under Results Management, select an Enable Aging
option as follows:

System Enables aging of Cls using the default aging setting defined in each CIT type's
Default attribute settings.

For details, see "Configuration Item Properties Dialog Box" on page 1 in the
HP Universal CMDB Modeling Guide.
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Always Always enables aging of Cls discovered by jobs that use this adapter.
Enabled

Note: When this option is selected, the default aging setting defined in each
CIT type's attribute settings is ignored.

Always Disables aging of Cls discovered by jobs that use this adapter.
disabled

Note: This option overrides the default aging setting defined in each CIT type's
attribute settings.

3. Saveyour changes.

How to Discover Running Software — Scenario

This scenario explains how to set up the discovery of Oracle databases so that there is no need to
enter a specific set of credentials to discover each database instance. DFM runs an extract
command that retrieves the database name attribute.

In this scenario, we assume that the following syntax is used in the Oracle command lines:

c:\oralO\bin\oracle.exe UCMDB

This task includes the following steps:

"Prerequisites" below

"Create a Command Line Rule" on next page

"Define the Value of an Attribute" on next page

"Activate the Job" on page 85

Prerequisites

Display the Attribute Assignment Rules dialog box:

a.

Select Data Flow Management > Discovery Control Panel. In the Discovery Modules
pane, select the Network Discovery module > Host Resources and Applications >
Software Element CF by Shell. In the Properties tab, select Global Configuration

Files > applicationSignature.xml. For details, see "Global Configuration Files Pane" on
page 95.

Tip: If the Global Configuration Files pane does not display, click the arrow below the
Trigger Queries pane.

Click the Edit button to open the Software Library dialog box. For details, see "Software
Library Dialog Box" on page 122.

Choose the signature to be edited. Click the Edit button to open the Software Identification
Rule Editor dialog box. For details, see "Software Identification Rule Editor Dialog Box" on
page 121.
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d. Click the Set Attributes button to open the Attributes Assignment Editor dialog box. For
details, see "Attribute Assignment Editor Dialog Box" on page 102.
2. Create a Command Line Rule

The command line rule is text that identifies the process to be discovered, for example,
oracle.exe c:\oralO\bin\oracle.exe UCMDB. You can substitute the text entry with
a regular expression, so that discovery is more flexible. For example, you can set up a rule that
discovers all Oracle databases, whatever their name.

Subsequently, DFM uses the information in the command lines discovered by the regular
expression to populate a Cl's name attribute with the database name.

a. Tocreate a Command Line rule that includes a regular expression, in the Attributes
Assignment Rules dialog box, click the Add button in the Parsing Rules pane. For details,
see "Parse Rule Editor Dialog Box" on page 113.

b. Inthe Parse Rules Editor dialog box, build the rule:
o Entera unique name in the Rule ID field: r1.
o Choose Command Line in the Process Attribute field.
o Enter the following regular expression in the Regular Expression field: .+\s+(\w+)$:

This expression searches for any character (.), followed by a space or spaces (+\s+),
followed by a word or words ((\w+)) that appear at the end of the line ($). You can use
the following characters: a-z, A-Z, or 0-9. The following command line fulfils this
expression: c:\oralO\bin\oracle.exe UCMDB.

3. Define the Value of an Attribute

In this step, you define which attribute is used by DFM to discover the Oracle databases, and
the value it should take.

a. Inthe Attributes Assignment Rules dialog box, click the Add button in the Attribute
Assignments pane, to select the attribute.

b. Inthe Attribute Editor dialog box:

o Choose the attribute that holds the database name, from the list of Oracle CIT
attributes, in this case The Database instance name.

o Enter a value, using the following syntax: ${<rule ID name>(<group number>)}, in
this case, ${r1(1)}.
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| £ Attributes Assignments Editor
Attribute assignments for type [oracle]
Gl
Name | Type | Value
The Catabase instance name string Fr1010}
T

Parsing Pules

Gl
[ Process Attribute | Regular Expression
1 cmdline A+ (w+)E

This dialog box is configured as follows: DFM enters the value of the first group ((\w+)$)
in the command line regular expression (${r1(1)}) in the name attribute of the Oracle
database Cl.

That is, during discovery, DFM searches through the process files for command lines
with a word or words at the end of the line. For example, the following command line
matches this regular expression: c: \oralO\bin\oracle.exe UCMDB.

4. Activate the Job

For details, see "How to Manually Activate Modules/Jobs/Cls" on page 195 and "Discovery
Modules Pane" on page 222.

How to Attach Discovery Documentation to a
Discovery Package

This task describes how to attach updated or new documentation to a discovery package.
1. Prerequisites
a. Create the help document in PDF format.
b. Create afolder called docs, and copy your PDF into that folder.
c. Zipthe docs folder, and copy it to your local file system.
2. Deploy the document on the UCMDB server
Navigate to Administration > Package Manager, and click the Deploy packages to server

& button to deploy the .zip file containing the PDF you want to deploy. For details, see
"Deploy a Package" (on page 1) in the HP Universal CMDB Administration Guide.

3. Attach the document to the relevant discovery package
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a. Navigate to Data Flow Management > Adapter Management.

b. Inthe Resources pane, expand the adapter file: Packages > <package name> >
Adapters and select the adapter to which to attach the document.

c. Do one of the following:

o Inthe Adapter Definition tab, under Details, click the Edit £ button adjacent to the
Content Help box, and select the help document that you deployed.

o Right-click the adapter and select Edit Adapter Source from the shortcut menu. Look
for RelatedDocument in the code, and replace the line with:

<RelatedDocument>name of pdf.pdf</RelatedDocument>

where name_of_pdfis the name of the help document you deployed.

How to Attach Readme to a Discovery Package

This task describes how to attach an updated or new Readme file to a discovery package.

1.

Prerequisite

To attach a Readme file to a discovery package, the package's .zip file must be located
somewhere on your local file system.

If you are updating the Readme file of a discovery package that is already deployed on your
UCMDB server, you must export the package's .zip file to your local file system before
attaching the updated file. For details on exporting packages, see "Export a Package" in the
HP Universal CMDB Administration Guide.

Add the Readme file to the discovery package's .zip file

= Create or update the Readme file, and save it with the name, Readme.txt.
= Copy the Readme.txt file into the root of the package's .zip file.

Deploy the package on the UCMDB server

Navigate to Administration > Package Manager, and click the Deploy packages to server

& button to deploy the .zip file containing the Readme. For details, see "Deploy a Package" in
the HP Universal CMDB Administration Guide.

How to Filter Probe Results

Global filtering enables you to filter Probe results for all adapters, so that only results of interest to
you are sent to the UCMDB Server.

You can also filter specific adapters. For details, see "Adapter Configuration Tab" on page 96.

Note:
e You can use regular expressions in filters.

o Attributes in the filter should be of type string only. For details on Cl attribute types, see
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"Attributes Page" in the HP Universal CMDB Modeling Guide.

o Avresultis considered to be a match only if all filter attributes have the same values as those
in the CI. (If one of a Cl's attributes is not specified in the filter, all the results for this
attribute match the filter.)

e A Cl can match more than one filter. The Cl is removed or remains according to the filter in
which it is included.

o Recursive Filtering. Using global filtering, you can filter out a Cl so that it is not included in
the filter results. This Cl may be a root Cl, containing other Cls or relationships. By default,
during the filter process, the contained Cls and relationships, as well as any Cls related to
them, are added to the filter results—including the root Cl. This causes undesired filter
results. Recursive filtering corrects this by ensuring that if a root Cl is filtered out, then
any contained Cls or relationships are filtered out too, such that the root Cl cannot be found
again.

To enable recursive filtering:
In the globalFiltering.xml file, set the recursiveFilter, attribute to true.
Note: By default, recursive filtering is disabled, that is recursiveFilter = false.)

o DFM filters first according to the <includeFilter> and then applies the <excludeFilter> on
the results of <includeFilter>.

Configure a Filter

Open the globalFiltering.xml file. (Adapter Management module > Resources pane >
Packages > DDM Infra > Configuration Files)

The code in displayed in the View pane:

<resultFilters>
<excludeFilter>
<vector />
</excludeFilter>
<includeFilter>
<vector />
</includeFilter>
</resultFilters>

o <excludeFilter>. When a vector marker is added to this filter, all Cls that match the filter are
removed. If this marker is left empty, all results are sent to the server.

¢ <includeFilter>. \When a vector marker is added to this filter, all Cls that do not match the filter
are removed. If this marker is left empty, all results are sent to the server.

The following example shows an IpAddress Cl that has address and domain attributes:

<vector>
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<object class="ip address">
<attribute name="name"
type="String">192\.168\.82\.17.*</attribute>
<attribute name="routing domain"
type="String">DefaultProbe</attribute>
</object>
</vector>

If this vector is defined in <includeFilter>, all results not matching the filter are removed. The
results sent to the server are those where the ip_address matches the regular expression
192\.168\.82\.17.* and the ip_domain is DefaultProbe.

If this vector is defined in <excludeFilter>, all results matching the filter are removed. The results
sent to the server are those where the ip_address does not match the regular expression
192\.168\.82\.17.* and the ip_domain is notDefaultProbe.

The following example shows an ip_subnet Cl that has no attributes.

<vector>
<object class="ip_ subnet">
</object>

</vector>

Configure a Filter to Ignore Case

You can configure a filter to ignore case by prefixing a regular expression with (?i). For example,
(?i)DefaultProbe finds defaultprobe as well as DefaultProbe.

The following example removes all occurrences of the DefaultdoMain attribute because the vector
code is located in the <excludeFilter> section:

<resultFilters>
<excludeFilter>
<vector>
<object class="ip address">
<attribute name="routing domain" type="String">(?1)
DefaultdoMAin</attribute>
</object>
</vector>
</excludeFilter>
<includeFilter>
<vector />
</includeFilter>
</resultFilters>

Adapter Management User Interface

This section describes:
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o "Adapter Definition Tab" below

o "Adapter Configuration Tab" on page 96

o "Adapter Management Window" on page 101

o "Adapter Source Editor Window" on page 101

o "Attribute Assignment Editor Dialog Box" on page 102
o "Attribute Editor Dialog Box" on page 103

e "Choose Discovered Class Dialog Box" on page 104
o "Configuration File Pane" on page 105

o "Edit Process Dialog Box" on page 107

¢ "Find Resource/Jobs Dialog Box" on page 108

o "Find Text Dialog Box" on page 109

¢ "Input Query Editor Window" on page 110

o "Parse Rule Editor Dialog Box" on page 113

¢ "Permission Editor Dialog Box" on page 114

e "Resources Pane" on page 116

o "Script Editor Window" on page 118

e "Script Pane" on page 119

o "Software Identification Rule Editor Dialog Box" on page 121

o "Software Library Dialog Box" on page 122

Adapter Definition Tab

Enables you to define an adapter by specifying which CITs the adapter should discover and which
protocols are needed to perform discovery.

To access Adapter Management > Resources pane > Packages > <adapter>
Relevant "Implement a Discovery Adapter" in the HP Universal CMDB Developer
tasks Reference Guide

User interface elements are described below:

Ul Element (A—Z) Description

Adapter Used to arrange adapters by category.
Category
Content Help The Help document associated with the adapter, in PDF format.

To change the Help document associated with the adapter, do one of the
following:
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Ul Element (A-Z) Description

« Click (€] and select the relevant PDF file.

¢ Right-click the adapter in the Packages tree and click Edit adapter
source. Find the following line in the code:

<RelatedDocument>name _of pdf.pdf</RelatedDocument>

and change the name of the PDF file.

xH
At

To detach the selected Help document, click

Description A detailed description of the adapter's purpose, including relevant
comments.

Display Name A display name to identify the adapter.

Type For Discovery adapters: jython; for Integration adapters: can be of various
types.

Used as Select to define that this adapter is an integration adapter.

Integration . . .
Note: These adapters cannot be used for defining Discovery jobs, and are

Adapter . . .
accessible only through the Integration Studio.

Input Pane

User interface elements are described below:

Ul

Element
(A-2Z) Description

Input Cl | Theinput CIT is used as the adapter input. For details, see "Define Adapter Input
Type|z| (Trigger CIT and Input Query)" in the HP Universal CMDB Developer Reference
Guide.

Click the button to choose a CIT to use as the input.

|§| Edit Input Query. Enables you to edit the input query.
E Remove Input Query. Enables you to delete the input query.

Input Defines a query for validation of the triggered Cls for jobs that run this adapter. (Cls
Query matching the job's triggered query must match the Input query as well.)

¢ Click the Edit Input Query |£| button to open the Input Query Editor window.

e Click the Remove Input queryl #
adapter.

To define which Cls can be Trigger Cls for jobs that run a specific adapter, see

button to remove the Input query from the
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Ul
Element
(A-Z)

Description

"Input Query Editor Window" on page 110. For more information, see "Trigger Cls
and Trigger Queries" on page 20.

For an example of an input query definition, see "Example of Input Query Definition"
inthe HP Universal CMDB Developer Reference Guide.

Note:

o Because this field is optional, not all adapters include an Input query. None
signifies this adapter does not have an Input query definition.

o Toensure that the Data Flow Probe is always kept up to date with possible
changes to the Trigger Cl data, you can configure UCMDB to periodically
recalculate the Trigger Cl data and send any changes to the Data Flow Probe.
For details, see "How to Configure Periodic Data Flow Task Updates" on page
29. This option is disabled by default because it can interfere with performance.

Triggered
Cl Data

\#| Add Trigger CI data to the adapter.

. Remove Trigger CI data from the adapter.

|£| Edit the Trigger Cl data in the Parameter Editor dialog box.

« Name. The information that is needed to perform a task on a specific CI. This
information is passed to the Cl queried in the task.

Important: Do not use id for a Triggered C| Data entry, as it is a reserved name.
o Value. The attribute value. Variables are written using the following syntax:

${VARIABLE NAME.attributeName}

where VARIABLE_NAME can be one of three predefined variables:

= SOURCE. The Cl that functions as the task's trigger.

= HOST. The node in which the triggered Cl is contained.

= PARAMETERS. The parameter defined in the Parameter section.

You can create a variable. For example, $ { SOURCE.network netaddr}
indicates that the trigger Cl is a network.

Used Scripts Pane

Displays the scripts used by the selected adapter.

Important Information Available for Jython adapters only

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element

(A-2) Description

|ﬂ| 4 Move up/Move down. Enables you to change the order of the scripts. DFM runs
o the scripts in the order in which they appear here.

|¥| Add script. Enables you to add a script to the adapter.
ﬁ Remove script. Enables you to remove a script from the adapter.
|§| Edit. Enables you to edit the selected script in the Script Editor that opens.

<Scripts> | Alist of Jython scripts used by the adapter.

Workflow Steps Pane
Displays only the workflow element of the selected adapter script.

Important Information Available: Only for the adapters that contain workflows

Example: UDAgentManagement adapters

User interface elements are described below:

Ul Element
(A-2) Description

|E| Find text. Enables you to find specific text in the workflow steps. For details, see
T "Find Text Dialog Box" on page 109.

|% Go to line. Enables you to jump to a specific line in the workflow steps. In the Go
o To Line dialog box, enter the line number, and press ENTER.

|| Open External Editor. Opens the workflow steps in an external text editor.

Prerequisite: Click the Edit the External Editor Preferences |£_i| button to
define the path to an external editor. If no extemnal editor path is defined, you will
be prompted to provide one when you try to open the external editor.

|j_j| Edit the External Editor Preferences. Click to edit the external editor
o preferences. You can run the editor by adding flags to the path.

Note: You cannot specify the file name. Instead, you can use flags relevant to
your external editor to retrieve the file name, such as -file.

In the following example, :file sets the place of the file in relation to the flags.
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Ul Element
(A-2) Description

Full Path [C:\any TextEditor exe |

Flags |-l -k :file -v |

If no flags are defined, the file name is automatically added to the end of the path.

|§| Switch Editor Mode. Enables you to switch between the default advanced editor
o and a simple text editor.

Validation | Displays if the definition is valid or not:

Information

. Indicates that the definition is valid.

Q

. Indicates that there is an error in the definition.

Required Permissions Pane

Enables you to view the permissions that you have configured for an adapter.

To access Data Flow Management > Adapter Management > select an adapter >
Adapter Definition tab > Required Permissions pane.

Important o Workflow:
Information = Configure the permissions in the Permission Editor dialog box.

= View the permissions in this pane.

= When working with jobs in the Discovery Control Panel window, view
these permissions for a specific job.

o For details on the fields in this pane, see "Permission Editor Dialog Box" on
page 114.

See also o "Permission Editor Dialog Box" on page 114

¢ "Discovery Permissions Window" on page 226

o "Viewing Permissions While Running Jobs" on page 188

User interface elements are described below:
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Ul
Element

Description

Add. Opens the Permission Editor dialog box, enabling you to add a permission
object. The Permission Editor dialog box opens. For details, see "Permission Editor
Dialog Box" on page 114.

|§| Edit. Opens the Permission Editor dialog box, enabling you to edit a selected

o permission object. For details, see "Permission Editor Dialog Box" on page 114.

E Remove. Enables you to delete a selected permission object.

|H UA Move up/Move down. Enables you to change the order of the permissions. Select

—— 7 | the permission object and click the up or down button. The order given here is the
order in which the credentials are verified.

|EI_'-| ,| Export Data to File. Enables you to export a permission object in Excel, PDF, RTF,

CSV, or XML format. For details, see "Browse Views Mode" in the HP Universal
CMDB Modeling Guide.

Required Discovery Protocols Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

|¥| Add required protocol. Enables you to add a required protocol.

ﬁ Remove required protocol. Enables you to remove an existing protocol that is

no longer required.

<Protocols> | List of protocols required by the adapter for the task. For example, the NTCMD

protocol, together with its user name, password, and other parameters, is needed
for DFM to access a Windows system.

For information about the supported protocols, see the HP Universal CMDB
Discovery and Integration Content Guide.

Discovered CITs Pane

User interface elements are described below:

Ul
Element
(A-2Z)

Description

Add Discovered CIT. Opens the Choose Discovered Class dialog box, enabling you
to select a CIT to be discovered by the adapter. For details, see "Choose Discovered
Class Dialog Box" on page 104.

Page 94 of 279

HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 4: Adapter Configuration

Ul
Element

Description

E Remove Discovered CIT. Enables you to remove the CIT from the list of CITs that
the adapter discovers.
|@| View Discovered CITs as Map. Opens the Discovered CITs Map window enabling

view a graphical map of the CITs and relationships that are discovered by the adapter.

CITs List of CITs that the adapter discovers.

Global Configuration Files Pane

Enables you to add default configuration files to the adapter, as well as the specific configuration
files that the adapter needs.

Important | The applicationsSignature.xml file contains a list of all applications that DFM
Information | attempts to find in the environment.
The configuration file applicationsSignature.xml opens the Software Library
dialog box. For details, see "Software Library Dialog Box" on page 122.
Relevant "How to Discover Running Software — Scenario" on page 83
tasks

User interface elements are described below:

Description

Add. Opens the Global Configuration Files dialog box, enabling you to select
configuration files that are needed by the adapter.

Remove. Enables you to delete a selected configuration file.

Edit. Opens the selected configuration file in an appropriate editor.

For example, the file msServerTypes.xml opens the Script Editor.

Adapter Parameters Pane

User interface elements are described below:

Ul
Element

(A-2) Description

| Add Parameter. Opens the Parameter Editor dialog box, enabling you to enter details
o about a new parameter. The value you enter here is assigned to the attribute.

Remove Parameter. Enables you to remove a selected parameter.
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Ul
Element

(A-2) Description

|§| Edit Parameter. Opens the Parameter Editor dialog box, enabling you to make
o changes to the parameter definition.

Name Each row represents the definitions for one parameter.

Value Separate values with commas.

Adapter Configuration Tab

Enables you to define additional options relevant to adapter execution and result filtering.

To access Select a specific adapter in the Resources pane and click the Adapter
Configuration tab.

Important Click the Save button to save any changes you make.

Information

See also "DataFlowProbe.properties File " on page 55

Probe Selection Pane

Enables you to specify which Probe to use with an adapter. For more information, see the section
Override Probe Selection - Optional in the HP Universal CMDB Developer Reference Guide.

Execution Options Pane

User interface elements are described below:

Ul Element (A—
2) Description
Create Choose to create a log file that logs the connection between the Probe and a
communication | remote machine.
lo
9 o Always. A communication log is created for this session.
o Never. A communication log is not created for this session.
¢ On Failure. A communication log is created for this session, only if the
execution fails.
That is, DFM reports an error (report of a warning does not create a
communication log). This is useful when you need to analyze which
queries or operations take most of the time, send data for analysis from
different locations, and so on. If the job completes successfully, no log is
created.
When requested (in the Discovery Status pane), DFM displays the log
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Ul Element (A—

Z)

Description

retrieved from the Probe (if a log has been created). For details, see
"Discovery Status Pane" on page 216.

Note: For debug purposes, you can always retrieve the communication logs
for the last 10 executions, even if Create communication logs is set to On
Failure.

Communication log files are created on the Probe Manager under the
C:\hp\UCMDB\DataFlowProbe\runtime\

communicationLog folder. For details on how the communication logs work,
see Record DFM Code in the HP Universal CMDB Developer Reference
Guide.

in

log

Include results | Select to enable capturing the discovered results with the created

communication log; these discovered results may help in investigating

communication | various discovery problems.

time

Max. execution | The maximum time allowed for an adapter to run on one Trigger ClI.

Max. threads

Each job is run using multiple threads. You can define a maximum number of
threads that can be used concurrently when running a job. If you leave this
box empty, the Probe's default threading value is used (8).

The default value is defined in the DiscoveryProbe.properties file, in the
appilog.agent.local.services.defaultMaxJobThreads parameter.

Note: The jobs in the Network — Host Resources and Applications module
require a permanent connection to the Probe's internal database. Therefore,
these jobs are limited to a maximum number of 20 concurrent threads (which
is the maximum number of concurrent connections permitted to the internal
database). For details, see "Host Resources and Applications Discovery" in
the HP Universal CMDB Discovery and Integration Content Guide.

Results Management Pane

User interface elements are described below:

Ul Element

(A-2)

Enable
aging

Description

The aging mechanism specifies how long a period must pass in which Cls are
discovered, before DFM treats these Cls as no longer relevant and removes
them. Choose from one of the following aging options:

o System Default: Use the system's default value for the Enable Aging attribute
of each Cl type.
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Ul Element
(A-2Z)

Description
o Always Enabled: Select this option to always enable the aging mechanism.
o Always Disabled: Select this option to always disable the aging mechanism.

The value you set here is for each Cl result that is reported to the UCMDB by the
jobs of this adapter.

For details on aging, see The Aging Mechanism Overview in the HP Universal
CMDB Administration Guide.

Enable
Automatic
Deletion

Choose between:

o Always. Automatic Deletion or Candidate for Deletion is always enabled,
regardless of whether discovery succeeds or fails.

¢ On Success or Warnings. Automatic Deletion or Candidate for Deletion is
enabled only when discovery finishes with a success or warning status. In the
case of a discovery error, nothing is removed and Cls are not marked as a
candidate for deletion.

e Only on Success. Automatic Deletion or Candidate for Deletion is enabled
only when discovery finishes with a success status. In the case of a discovery
error or warning, nothing is removed and Cls are not marked as a candidate for
deletion (this is the default).

Selecting this option enables the Automatic Deletion box where you select
specific CITs for deletion or as candidates for deletion, if the Data Flow Probe
does not find them during its next invocation.

To select CITs, click the Add |i| button. In the Choose Discovered Class dialog
box, choose the CITs that should be automatically deleted.

The changes you make here are added to the adapter file, for example:

<resultMechanism isEnabled="true">
<autoDeleteCITs isEnabled="true">
<CIT>shell</CIT>
<candidateForDeletionCIT>node
</candidateForDeletionCIT>
</autoDeleteCITs>
</resultMechanism>

For details on how the Data Flow Probe handles Cl deletion, see "Automatically
Deleted Cls and Relationships and Candidates for Deletion Cls" on page 80.

Enable
collecting
'Discovered
by' data

o Selected. DFM collects data on the results of running the adapter. This data is
then used to enable rediscovery of Cls. The data is necessary for the
Discovery tab in IT Universe to function correctly. It is also used for the View
Based Discovery Status functionality which leverages the data to aggregate
the complete discovery status for certain views.
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Ul Element
(A-2Z)

Description

o Cleared. DFM does not collect this data. The check box needs to be cleared
for adapters where rediscovery is not helpful. For example, the Range IPs
by ICMP job has this check box cleared by default because its Trigger Cl is
the Probe Gateway and so all Cls discovered by this job have the same
Trigger Cl. If the check box was not cleared, a rediscovery attempt on any
view containing any single IP would result in a ping sweep throughout the
entire customer network, certainly not desirable behavior.

The job results of this adapter are displayed in the Discovery for View dialog box
only if this check box is selected. For details, see Check Status of Application
Discovery (Rediscover a View) and Show Discovery Status and Changes Dialog
Box in the HP Universal CMDB Modeling Guide.

Enable
reporting of

empty
values

When selected, the Data Flow Probe reports empty values for discovered
properties to UCMDB.

Default: Enabled

Enable
update
'Last
Access
Time'

When selected, if a Cl is touched when a discovery or integration job runs, the
Last access time property of the Cl is updated. This indicates that the Cl
represents an active component in the system, and prevents the Cl from
becoming a deletion candidate.

For details about the aging mechanism and deletion candidates, see The Aging
Mechanism Overview in the HP Universal CMDB Administration Guide .

Note: If this option is not selected:

e Fornew Cls, the Last access time property is given the same value as the
Create Time property

o Forexisting Cls, subsequent activations of the job do still update the
LastModifiedTime property, but the Last access time property is not
updated.

Use-Case Example

When importing data from an external data source, this data may include meta-
data about Cls. If this option is enabled, the Cls are updated with the metadata
and their Last Access Time value is updated. Disabling this option can be
useful if you do not want to affect the aging status or the deletion candidacy of
these Cls. In this case, the information is added to the Cls but their Last
Access Time remains unchanged.

Fail entire
bulks due
to invalid
Cls

If a set of objects (for example, 1,000 objects) includes even one invalid CI (for
example, a node cannot be identified because of missing topological information),
the reconciliation engine drops the entire set and does not send it to the CMDB.
This is the default behavior.

Clear the check box to have the results sent to the CMDB with only the invalid
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Ul Element

(A-2)

Description

Cls (and their topology) dropped from the results. In the above example, 999
objects would be processed. UCMDB displays an error message when you view
the results.

Result Grouping Pane

User interface elements are described below:

Ul Element
(A-2) Description
Grouping To group results in the Probe before they are sent to the server, type the value
Interval that indicates how long results are stored in the Probe before being transferred to
(Seconds) the server.
The default value is 30 seconds.
Note: If you enter a value in both boxes, DFM applies the value of whichever
occurs first.
Max. Cls in | Specify the number of Cls that should accumulate in the Probe before being
group transferred to the server.
The default value is 5000.
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Adapter Management Window

Enables you to view or edit default parameter values used for the DFM process.

To access | Data Flow Management > Adapter Management or right-click a job in the
Discovery Control Panel window and click Go to Adapter.

Important Note: An asterisk (*) next to a resource (adapter, script, or configuration file)

Information | signifies that the resource has changed since the package (in which it is included)

was deployed. If the original package is redeployed, the changes are deleted from
the resource. To save the changes, move the resource to a new package and
deploy the package (the asterisk disappears).

Caution: Only administrators with an expert knowledge of the DFM process
should delete packages.

See also

o "Adapter Definition Tab" on page 89

¢ "Global Configuration Files Pane" on page 95
¢ "Adapter Configuration Tab" on page 96

e "Script Pane" on page 119

¢ "Resources Pane" on page 116

e "Configuration File Pane" on page 105

e HP Universal CMDB Discovery and Integration Content Guide

Adapter Source Editor Window

Enables you to edit an adapter script.

To access

Right-click an adapter in the Resources pane and select Edit Adapter Source.

See also

"Resources Pane" on page 116

User interface elements are described below:

Ul Element

(A-2)

i

Description

Find text. Enables you to find specific text in the adapter definition. For
details, see "Find Text Dialog Box" on page 109.

=

Go to line. Enables you to jump to a specific line in the adapter definition. In
the Go To Line dialog box, enter the line number, and press ENTER.

&)

Open External Editor. Opens the adapter definition in an external text editor.

Prerequisite: Click the Edit the External Editor Preferences |§_;| button to
define the path to an external editor. If no external editor path is defined, you
will be prompted to provide one when you try to open the external editor.
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Ul Element
(A-Z)

Description

&z

Edit the External Editor Preferences. Click to edit the external editor
preferences. You can run the editor by adding flags to the path.

Note: You cannot specify the file name. Instead, you can use flags relevant to
your external editor to retrieve the file name, such as -file.

In the following example, :file sets the place of the file in relation to the flags.

Sdect Exdemal editor path

Full Path [C:\anyTextEditor exe |

Flags |-l -k :file -v |

If no flags are defined, the file name is automatically added to the end of the
path.

2/

Switch Editor Mode. Enables you to switch between the default advanced
editor and a simple text editor.

Validation
Information

Displays if the definition is valid or not:

O

. Indicates that the definition is valid.

Q

. Indicates that there is an error in the definition.

v

. Indicates that the definition could not be validated.

Note: This may occur due to an internal error while performing the
validation. This does not, under any circumstances, harm the process of
saving your definition to the server. See %temp%\UcmdbLog\error.log
for details. For further assistance, contact HP Software Support.

Attribute Assignment Editor Dialog Box

Enables you to define a regular expression that discovers specific running software according to a
CIT's attribute value.

To access

Click Set Attributes in the Software Identification Rule Editor dialog box.

Relevant tasks

"How to Discover Running Software — Scenario" on page 83
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See also

¢ "Parse Rule Editor Dialog Box" on page 113
o "Attribute Editor Dialog Box" below

o "Software Identification Rule Editor Dialog Box" on page 121

User interface elements are described below:

Ul Element (A-2)

£

Description

Click to add a regular expression that determines the attribute of the ClI to
be discovered, or to add an attribute.

assignments for

type

|§| Click to edit an existing regular expression or attribute.
5 Click to delete the regular expression or the attribute.
Attribute For details, see "Attribute Editor Dialog Box" below.

Parsing Rules

For details, see "Parse Rule Editor Dialog Box" on page 113.

Attribute Editor Dialog Box

Enables you to define a rule that discovers a CIT according to an attribute. The attribute is defined
according to a regular expression.

To access

Software Identification Rule Editor > Set Attributes button >
Attributes Assignment Editor. Click the Add button in the Attributes
Assignment for Type pane.

Relevant tasks

"How to Discover Running Software — Scenario" on page 83

See also

"Parse Rule Editor Dialog Box" on page 113

User interface elements are described below:

Ul

Element
(A-2) Description

Name Choose from the list of attributes of the CIT selected in the Editor. This attribute name
is replaced by the value found by the regular expression. To find an attribute, start
typing the name.

soon.

Type The type of operation defined for the attribute, for example, Boolean, string, date, and

box.

Value The value that replaces the name in the Rule ID field in the Parse Rule Editor dialog

Page 103 of 279

HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 4: Adapter Configuration

Ul
Element
(A-Z)

Use the following syntax for the value:
S{<rule ID name> (<group number>) }

For example, ${DB_SID(1)} means that DFM should search for the Rule ID with the
name DB_SID and retrieve its regular expression.

DFM should then retrieve the code for the first group (1). For example, in the regular
expression .+\s+(\w+)$, the first group is (\w+)$, that is, a word or words that appear
at the end of the line.

Description

Choose Discovered Class Dialog Box

Enables you to choose CITs that are to be discovered by a selected adapter and to limit links so
that they are mapped only when they connect specific CITs.

To
access

o Data Flow Management > Adapter Management. In the Resources pane, select

an adapter. In the Adapter Definition tab > Discovered CITs pane, click the Add
Discovered CIT button.

Data Flow Management > Adapter Management. In the Resources pane, select
an adapter. In the Adapter Configuration tab > Results Management pane,
select the Enable Automatic deletion check box and click the Add button in the
Automatic Deletion pane.
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User interface elements are described below:

]

Element
(A-2) Description

Link Enables DFM to discover CITs only when they are linked by link types you choose in
this box.

Note: This section is relevant only when adding a discovered CIT, not for defining
CITs for automatic deletion.

Select a link type from the list and click the [.«««] button in the End 1 and End 2 boxes to
open the Choose Configuration Item Type dialog box. Choose the CITs that DFM
should map when they are linked by the selected link type.

Note: DFM automatically recognizes the links between Cls and adds them to the map
of discovered CITs. However, during adapter writing, you may need to exclude links
between certain CITs. For example, both nodes and IPs and nodes and ports are
linked by usage. You may need to receive results only for nodes and IPs that are
connected by the usage link, and not nodes and ports. The End 1 and End 2 links
determine the result received from the adapter, and this result is reflected in the map,

as can be seen in the following example:
Uaage x

CnnfguratmnDn [pAddress  IpServiceEndpoi ModeElement TCPAP Port
cument ht

RunningSoftaar

WebServer
Lsage_a
lsage_5 lzage_1

f

Object | Select a CIT to be added to the list of CITs that an adapter is to discover. Save the
changes by clicking the Save button at the bottom of the Adapter Definition pane.

Configuration File Pane

Enables you to edit a specific configuration file that is part of a package. For example, you can edit
the portNumberToPortName.xml file so that specific port numbers, names, or types are
discovered.

To access Click a specific configuration file in the Resources pane.
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Important
Information

The following files are for internal use only and should only be changed by users
with an advanced knowledge of adapter-writing:

o discoveryPolicy.xml
¢ jythonGlobalLibs.xml

For details, see "How to Define Discovery Rules" on page 125 and "Internal
Configuration Files" on page 123.

User interface elements are described below:

Ul Element (A-2) Description

|E| Find specific text in the configuration file. For details, see "Find Text
T Dialog Box" on page 109.
|% Click to go to a specific line in the configuration file. In the Go To Line
o dialog box, enter the line number.
|| Click to opens the configuration in an external text editor.
Prerequisite: Click the Edit the External Editor Preferences |£_:|
button to define the path to an external editor. If no external editor path
is defined, you will be prompted to provide one when you try to open
the external editor.
|§_j| Edit the External Editor Preferences. Click to edit the external
o editor preferences. You can run the editor by adding flags to the path.
Note: You cannot specify the file name. Instead, you can use flags
relevant to your external editor to retrieve the file name, such as :file.
In the following example, :file sets the place of the file in relation to
the flags.
Select External editor path x|
Full Path |CZ".3I'|':,-’TE>dEdi‘tDI'.EXE | S
Flags |l -k :file -v |
If no flags are defined, the file name is automatically added to the end
of the path.
|§| Click to toggle between the advanced editor and a simple text editor.
o You can use the simple editor when the advanced editor causes
problems.
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Ul Element (A-2) Description

CJ' For XML files, signifies that the code is valid.

0 For XML files, signifies that the code is not valid.

Edit Process Dialog Box

Enables you to add a process that can identify specific running software.

To Click the Add button in the Identifying Processes pane in the Software Identification
access | Rule Editor dialog box.

See "Software ldentification Rule Editor Dialog Box" on page 121

also
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User interface elements are described below:

Ul
Element
(A-2Z)

Description

Attributes | Opens the Attributes Assignments Editor dialog box for the identifying process.
Command | The running software can also be mapped using the process name. In this case,
Line you must add a process command line (or part of it) with which the process name
uniquely identifies the software, for example, c¢:\\ora10\\bin\\oracle.exe UCMDB.
Key Select this check box if, during discovery, DFM must distinguish between
Process applications that run similar processes (IP, port, command line, or owner). For an
explanation of this box, see "ldentifying Running Software by Processes" on page
79.
Main Select this check box to mark this process as a unique and distinguishing process.
process For such processes there need to be several instances of the software Cl.
Name Enter the exact name of the process, for example, java.exe.
Port Add a port number or name, either by typing a number or by clicking the Add button
then selecting the ports in the Global Ports List.
o If the process has to listen at a specific port, the port should be listed. You can
enter more than one port, separated by commas, for example, 8888,8081,8080,
81,8000,82,80.
o If the process does not have to listen at a specific port (that is, the running
software can use any port), select the All Ports option.
Port o Select this check box to enable discovery of processes that are not listening at
match is any of the ports entered in the Port field (that is, identification is by process
optional name only).
o Clear this check box to enable discovery of processes based on process name
and the port number entered in the Port field.

Find Resource/Jobs Dialog Box

Enables you to build a search query to find a particular resource or job.

To o Discovery Control Panel > Discovery Modules pane. Click the Search for
access Discovery Job button.

o Adapter Management > Resources pane. Click the Find resource button.
See "Resources Pane" on page 116
also

User interface elements are described below:
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Ul Element

(A-2) Description

= Click to select a CIT from the dialog box that opens. Click OK to return to the Find
Resource dialog box.
Note: This button is not accessible when Name is selected.

Direction Searches forwards or backwards through the packages.

Find All Click to highlight all instances of the text entered in Name.

Find Choose between:

Discovery .

Job byl « Name. Enter the name, or part of it, of the resource.

Find o Input type/Adapter input type. Cls that trigger the job. Click the button to

Discovery open the Choose Configuration Item Type dialog box. Locate the Cl type

resource by that you are searching for.
o Output type/Adapter output type. Cls that are discovered as a result of the

job or the adapter.

Find Next The next job/resource meeting the search criteria is highlighted in the Discovery

Modules/Resources pane.

Find Text Dialog Box

Enables you to find text in a script or configuration file.

To access | Select a script or configuration file and click the Find text button in the file pane.

User interface elements are described below:

Ul Element (A—

Z) Description

" Find ¢ Click Find to find one instance of the text you are searching for.

- Fine AT ¢ Click Find All to find all instances of the text.

Direction Search forwards or backwards through the script or configuration file.

Find what Type the text to be found or click the down arrow to choose from previous
searches.
Click the adjacent arrow to display a list of symbols you can use in wildcard or
regular expression searches. This arrow is enabled when you select the Use
option.

Options Select an option to narrow your search.

Origin Enables a search of the entire scope or from the current cursor position.
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Ul Element (A-

Z) Description

Target o Global. Searches throughout the file.

o Selected Text. Searches through the selected text.

Input Query Editor Window

Enables you to define which Cls can be Trigger Cls for jobs that run a specific adapter.

To access Data Flow Management > Adapter Management > select an adapter >
Adapter Definition tab > Input pane > click the Edit Input Query button
next to the Input Query box.

Important To ensure that the Data Flow Probe is always kept up to date with
information possible changes to the Trigger Cl data, you can configure UCMDB to
periodically recalculate the Trigger Cl data and send any changes to the
Data Flow Probe. For details, see "How to Configure Periodic Data Flow
Task Updates" on page 29. This option is disabled by default because it
can interfere with performance.

See also e "Trigger Cls and Trigger Queries" on page 20

o "Trigger Query Editor Window" on page 243

User interface elements are described below:

Ul Element (A-2Z) Description

<Panes> e "Cl Type Selector Pane" below
o "Editing Pane" on next page

¢ "Information Pane" on next page

Query Name The name of the adapter's Input query.

Cl Type Selector Pane

Displays a hierarchical tree structure of the Cl Types found in the CMDB. For more details, see "Cl
Type Manager User Interface" in the HP Universal CMDB Modeling Guide.

Note: The number of instances of each CIT in the CMDB is displayed to the right of each CIT.

To access To create or modify a query, click and drag nodes to the Editing pane and
define the relationship between them. Your changes are saved to the
CMDB.

Note: Each time you select the same object from the tree, you must
rename the object node to have a unique name.
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Relevant tasks o "Define a TQL Query" in the HP Universal CMDB Modeling Guide
o "Create a Pattern View" in the HP Universal CMDB Modeling Guide

See also "Add Query Nodes and Relationships to a TQL Query" in the HP
Universal CMDB Modeling Guide

Editing Pane
User interface elements are described below:
Ul Element (A—
Z) Description
<node> Hold the cursor over a node to view information about the node:
|2 Input Query Editor
Query Mame : -
Mode: | k Select I" | k Layout: i:gé:f.__lj_i_u
— .-Element Mame: SEJLIF-U:IEmi
SOURCE Cl Type: Mode
Visible: true
<right-click For details, see "Shortcut Menu Options" in the HP Universal CMDB
menu> Modeling Guide.
<Toolbar> For details, see "Toolbar Options" in the HP Universal CMDB Modeling
Guide.

Information Pane

Displays the properties, conditions, and cardinality for the selected node and relationship.

Important Information | Hold the pointer over a node to view information:
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User interface elements are described below:

Ul Element

(A-Z)

Attributes

Description

Displays the attribute conditions defined for the node or the relationship. For
details, see "Attribute Tab" in the HP Universal CMDB Modeling Guide.

Cardinality

Cardinality defines how many nodes you expect to have at the other end of a
relationship. For example, in a relationship between node and IP, if the cardinality
is 1:3, the query retrieves only those nodes that are connected to between one and
three IPs. For details, see "Cardinality Tab" in the HP Universal CMDB Modeling
Guide.

Details

e CI Type. The CIT of the selected node/relationship.

Page 112 of 279

HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 4: Adapter Configuration

Ul Element
(A-Z) Description
o Visible. A tick signifies that the selected node/relationship is visible in the
topology map. When the node/relationship is not visible, abox & is displayed to
the right of the selected node/relationship in the Editing pane:
IpAddres
ontainment
'ﬁ' mMembership .
«— g
Windows .
[rethmet
¢ Include subtypes. Display both the selected Cl and its descendants in the
topology map.
Note: To change the visible and subtype settings, select a node in the Editing
pane and click the Edit button. In the Query Node Properties dialog box, select
or clear the boxes.
Edit Select a node or relationship in the Editing pane and click the Edit button to open
button the Query Node Properties dialog box. For details, see "Query
Node/Relationship Properties Dialog Box" in the HP Universal CMDB Modeling
Guide.
Qualifiers | Displays the qualifier conditions defined for the node or the relationship. For
details, see "Qualifier Tab" in the HP Universal CMDB Modeling Guide.
Selected Displays the element instances that are used to define what should be included in
Identities | the query results. For details, see "Identity Tab" in the HP Universal CMDB
Modeling Guide.

Parse Rule Editor Dialog Box

Enables you to create a rule that matches an attribute to process-related information (1P, port,
command line, and owner).

To access Software Identification Rule Editor > Set Attributes > Attributes
Assignment Editor > Parsing Rules > Add

Important Only users with a knowledge of regular expressions should make changes to a

Information rule.

Relevant "How to Discover Running Software — Scenario" on page 83

tasks
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See also

o "Attribute Editor Dialog Box" on page 103

o "Software Identification Rule Editor Dialog Box" on page 121

User interface elements are described below:

Ul Element

(A-2Z) Description

Process Choose between the Port, IP, Command Line, Name, or Owner process-related

Attribute information. The rule is invoked on the attribute you choose here.

Regular Enables you to create a dynamic expression that finds at least one process that

Expression | defines this running software. The regular expression is invoked on the value in the
Process Attribute field.
For example, a command line process includes the following regular expression:
Hs+(\w+)$
This expression searches for any character, followed by a space or spaces,
followed by a word or words (a-z or A-Z or 0-9) that appear at the end of the line.
The following command line matches this regular expression:
c:\ora10\bin\oracle.exe UCMDB

Rule ID Enter a unique name for the rule. The Rule ID is needed to identify the rule in the
Attributes Assignment Editor pane. For details, see "Additional Attributes" on page
121.

Permission Editor Dialog Box

Enables you to configure an adapter you have written, so that users can view permissions for the

job.
To access | Data Flow Management > Adapter Management > select an adapter >
Adapter Definition tab > Required Permissions pane > click the Add button.
Important | The information you define here is not dynamic, that is, if an adapter is changed,
Information | the information in this dialog box is not updated.
See also e "Discovery Permissions Window" on page 226
¢ "Viewing Permissions While Running Jobs" on page 188
o "Adapter Definition Tab" on page 89
¢ "Discovery Module/Jobs - Details Tab" on page 214
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User interface elements are described below:

Ul Element

(A-2)

Operation

Description

The action that is being run.

Permission

Enter a name for the permission, to appear in the Required Permissions pane.

Usage

Description

Free text that you enter to describe the permission object and its parameters. This
text is usually a general comment on the type of permission object, whereas the
description is a more specific comment. For example, you could enter
Permissions for host machines here, and Permissions for host machines
running on Windows for a particular row.

Permission Objects and Parameters Pane

Ul Element

(A-2) Description

|¥| Click to open the Permission Object and Parameter pane. You can enter more

o than one object or parameter for each permission.
The information you enter in this dialog box appears in the Required
Permissions pane, in the Objects and Parameters column.

E Click to delete a permission object.

|§| Click to edit an existing permission object.

Context Specific information about the permission object's environment, for example,
Windows or UNIX.

Parameter | The parameters that are needed during the job run. For example, the UNIX
permission object cat needs the /etc/passwd parameter.

Permission | The name of the command, table, or other content of the Jython script.

Object
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Resources Pane

Enables you to locate a specific package, adapter, script, configuration file, or external resource.
You can also create an adapter, Jython script, configuration file, or Discovery activity, and you can
import an external resource.

To access | Data Flow Management > Adapter Management

Important Depending which level you select in the Resources pane, different information is
Information | displayed in the View pane.

If you select:

¢ One of the following folders: Discovery Packages root, a specific package, an
adapter, script, configuration file, or external resource: a list of the resources in
that folder is displayed. To access aresource directly, double-click the
resource in the View pane.

¢ A specific adapter: The Adapter Definition and Adapter Management tabs
are displayed. For details, see "Adapter Definition Tab" on page 89 and
"Adapter Configuration Tab" on page 96.

o A script or configuration file: The script editor is displayed. For details, see
"Script Pane" on page 119.

o An external resource: Information about the file is displayed.

See also "Package Manager User Interface" in the HP Universal CMDB Administration
Guide.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-2Z)

Description

Create New Resource. Enables you to create a resource in a selected package.
Select a resource, enter its details, click the ellipsis e button, and select a
package to which to add the resource. If you do not select a package, the new
resource is created in the <No Package> folder:

o New Adapter. Enter the adapter name. Choose whether it should be used as a
discovery adapter or for integration. For integration adapters, choose the
integration type from the list of available types. Click OK. Edit the adapter. For
details, see "Adapter Definition Tab" on page 89 and "Adapter Configuration Tab"
on page 96. For details on moving an adapter to a package, see "Create a Custom
Package" on page 1 in the HP Universal CMDB Administration Guide. For details
on creating integration adapters, see "Discovery and Integration Adapters" on page
18.

o New Jython script. Enter the script name. For details, see "Script Pane" on page
119.

« New Configuration File. Enter the configuration file name. By default, the file
takes an .xml extension. To give the file another extension, for example,
* . properties, name the file and include the extension. Add the appropriate
XML code or other content. For XML files, you can save the file only if it is valid.
For details, see "Configuration File Pane" on page 105.

o Import External Resource. In the browser that opens, locate the resource to be
imported and click Open.

o New Discovery Wizard. Name the new wizard. By default, the file takes an .xml
extension. The file is in template format.

¢ New Scanner Configuration Configure the new scanner using the Scanner
Configuration Generator wizard. For more information see section about the
Scanner Generator in the HP Universal CMDB Discovery and Integration Content
Guide.

S Delete the Selected Item. Deletes the resource.

|E| Find Resource. Opens the Find Resource dialog box. For details on filtering, see
T "Filtering Results" on page 26.

|%| Refresh. Refreshes the list of packages.

I Packages tree. Displays a list of all packages.

L Package root. Displays a list of all resources included in the package. Expand the

folders to see available resources:

Right-click a resource to do one of the following:

Page 117 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 4: Adapter Configuration

Ul
Element

(A-2)

Description

e Save As. Enables you to clone an existing resource. The new resource includes all
attributes of the existing resource. Give the resource a name, and click the ellipsis

S button to select a package to which to add the resource.

o Delete. Enables you to delete the resource. The resource is removed completely
from the system.

¢ Open in Frame. Enables you to view or edit the resource script in the Script
Editor.

Available for: Configuration files and scripts

e Go to Discovery Job. Enables you to open the discovery job associated with the
selected adapter in the Discovery Control Panel

Available for: Adapters only. This option is enabled if the adapter is included in a
discovery job.

e Go to Integration Point. Enables you to view and edit the integration point that
uses this adapter in the Integration Studio.

Available for: Adapters only. This option is enabled if the adapter is used by an
integration point.

« Edit Adapter Source. Enables you to view or edit the adapter's XML file in the
Adapter Source Editor. For details, see "Adapter Source Editor Window" on page
101.

Available for: Adapters only.

Script Editor Window

Enables you to edit a specific script that is part of a package.

To « Right-click a script in the Resources pane and choose Open in Frame.
access o Select a configuration file in the Global Configuration Files pane and click the
Edit button.
For details, see "Script Pane" on next page.
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Script Pane

Enables you to edit a specific script that is part of a package.

To access

Click a specific script in the Resources pane.

Important
Information

The script pane title bar includes the actual physical location of the script. For
example, the following script is located in
C:\hp\UCMDB\DataFlowProbe\runtime\
probeManager\discoveryScripts (or probeGateway

\discoveryScripts):

‘Q%F@é

See also

"Adapter Development and Writing" in the HP Universal CMDB Developer
Reference Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

i

Find text. Enables you to find specific text in the script definition. For
details, see "Find Text Dialog Box" on page 109.

=

Go to line. Enables you to jump to a specific line in the script
definition. In the Go To Line dialog box, enter the line number, and
press ENTER.

&

Open External Editor. Opens the script definition in an external text
editor.

Prerequisite: Click the Edit the External Editor Preferences |§_;|
button to define the path to an external editor. If no external editor
path is defined, you will be prompted to provide one when you try to
open the external editor.

Edit the External Editor Preferences. Click to edit the external
editor preferences. You can run the editor by adding flags to the path.

Note: You cannot specify the file name. Instead, you can use flags
relevant to your external editor to retrieve the file name, such as -file.

In the following example, :file sets the place of the file in relation to
the flags.
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Ul Element (A-2Z) Description

Full Path [C:\anyTextEditor exe |

Flags |-k :file -v |

hl..iﬂlll‘ h..iﬂﬁﬂlli

If no flags are defined, the file name is automatically added to the end
of the path.

Switch Editor Mode. Enables you to switch between the default
advanced editor and a simple text editor.

See "Validation Information" below.

Note: This button is displayed when a script contains Framework
API errors.

<script definition>

The Jython script used by the package. For details on working with
Jython, see "Create Jython Code" in the HP Universal CMDB
Developer Reference Guide.

Validation Information

Displays if the script definition is valid or not:

o C) For Jython files, indicates that the script definition is
valid.
. 0 For Jython files, indicates that the script definition is not

valid, and displays the errors in the script.
For example:
Script has failed validation.

At line 48: Factory.getProtocolProperty (
found. This is a problem - Usage of Factory is
deprecated. Use Framework.getProtocolProperty
instead.

Click W then OK to update the script.

The error may occur due to changes in the Framework object's
API. For details, see the HP Universal CMDB Developer
Reference Guide.
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Ul Element (A-2) Description

o For Jython files, indicates that the script definition could
not be validated.

Note: This may occur due to an internal error while performing the
validation. This does not, under any circumstances, harm the
process of saving your definition to the server. See
%temp%\UcmdbLog\error.log for details. For further
assistance, contact HP Software Support.

Software Identification Rule Editor Dialog Box

Enables you to define a new running software rule.

To access | Data Flow Management > Discovery Control Panel. In the Discovery
Modules pane, select Network Discovery > Host Resources and
Applications > Software Element CF by Shell. In the Properties tab, select
Global Configuration Files > applicationsSignature.xml. In the Software
Library dialog box, click the Add button or select an existing element and click
the Edit button.

Important Each parse rule must be matched by at least one process.

Information

Relevant "How to Discover Running Software — Scenario" on page 83
tasks

See also "Global Configuration Files Pane" on page 95

User interface elements are described below:

Ul Element (A-2Z) Description

M Click to add attributes to the component. For details, see "Attribute
Assignment Editor Dialog Box" on page 102.

| Set Configuratic =3 Click to open the Optional Configuration Files dialog box.

|£| Click to add a process.

E Select a process and click to delete.

|E| Select a process and click to edit.

Additional To add attributes, click the Set Attributes button. For details, see
Attributes "Attribute Assignment Editor Dialog Box" on page 102.
Category You can:

Page 121 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 4: Adapter Configuration

Ul Element (A-2) Description

e Choose the category under which the new running software should
appear.

¢ Change the category for an existing element.
e Add a new category by typing its name in this field.

The changes you make here are immediately displayed in the Software
Library dialog box.

Cl Type

Select the CIT that is to be discovered.

Discovered Product
Name

The name of the running software to be created by this signature.

Configuration Files

Identifying To add a process that can identify specific running software, click the

Processes Add button. The Edit Process dialog box opens. For details, see "Edit
Process Dialog Box" on page 107.

Optional A list of configuration files.

Click the Set Configuration Files button to open the Optional
Configuration Files dialog box.

To add a configuration file, in the Optional Configuration Files dialog
box, click the Add button and, in the Configuration File Names box,
enter the full path to the running software's configuration file and the file
name.

Software Signature
ID

The name of the definition.

Note: This is not the running software's name but a name you give to
differentiate this discovery from similar discoveries.

Supported versions

Versions supported for this running software.

Vendor

The vendor of this running software.

Software Library Dialog Box

Enables you to view the logical groups of running software.

To access

o Discovery Control Panel window > Network Discovery > select one of the
Host Resources and Applications module jobs. Locate the Global
Configuration Files pane in the Properties tab. Select
applicationsSignature.xml and click the Edit button.

o Adapter Management window > select one of the Host_Resources_By
SNMP/TTY/WMI adapters. Locate the Global Configuration Files pane in
the Adapter Definition tab. Select applicationsSignature.xml and click the
Edit button.
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Important | The software elements are organized in logical categories. You can change the

Information | names of these elements, you can move an element to another category, and you
can define new elements and categories. For details, see the Category entry in
"Software ldentification Rule Editor Dialog Box" on page 121.
The code you define in this dialog box and the Software Element Editor dialog box
overwrites the code in applicationsSignature.xml.

Relevant "How to Discover Running Software — Scenario" on page 83

tasks

See also "Global Configuration Files Pane" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2Z) Description
-V Select a check box to include a category or software element in the discovery.
v :

Clear a check box to remove the category or element from the discovery.
|;| Click to define a new software element. For details, see "Software
o Identification Rule Editor Dialog Box" on page 121.
ﬁ Select a software element and click to delete the element.
|}| Select a software element and click to make changes to the element. For
o details, see "Software Identification Rule Editor Dialog Box" on page 121.
<List of List of objects that are software elements.
software
elements>

Internal Configuration Files

The following files are for internal use only and should be changed only by users with an advanced
knowledge of content writing.

¢ discoveryPolicy.xml. Includes the schedule when the Probe does not execute tasks. For
details, see "New/Edit Policy Dialog Box" on page 37. Located in Data Flow Management >
Adapter Management > Packages > AutoDiscoveryinfra > Configuration Files.

« jythonGlobalLibs.xml. A list of default Jython global libraries that DFM loads before running
scripts. Located in Data Flow Management > Adapter Management > Packages >
AutoDiscoveryContent > Configuration Files.
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This chapter includes:

Discovery Rules ENGiNe. .. ... . 124
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How to View Discovery Rules in JMX ... il 126
How to Disable the Discovery Rules Engine. . . .. ... . . L 127
Discovery Rule Engine Log Files. ... 127

Discovery Rules Engine

When Universal Discovery discovers data, the Discovery Rules Engine processes the given set of
input data, and returns a set of output attribute values.

For example,
o Input: A Node contains the string Cisco and the string Version 12.3a,
o Output : The operating system for the Node is recognized as Cisco 10S Version 12.3(3a).

The Data Flow Probe then activates the Rules Engine to fill in additional information on the
discovered data.

All discovery jobs uses the discovery rules engine. Out of the box rules are applied to data that can
be completed by the discovery jobs (sys_object _id, mac_address etc.)

Moreover, you can add user-defined rules to the Discovery Rules Engine.

Limitations

e The Discovery Rules Engine completes empty fields only in UCMDB. It does not overwrite
existing values.

o Rules runin arandom order. User-defined discovery rules have no priority over out-of-the-box
discovery rules. If the input suits more than one rule, the output is returned from the rule that ran
first. It is important to make sure that rules are accurate (existing and new rules). If rules are
accurate there is no need for prioritization.

o There are no dependencies between rules. A field that was completed using the Discovery
Rules Engine cannot be used as input for another rule.

See Also

o Fordetails on defining new rules, see "How to Define Discovery Rules" on next page.
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o For details on viewing out-of-the-box rules, see "How to View Discovery Rules in JMX" on next
page.

o Todisable the Rules Engine on a particular population adapter, see "How to Disable the
Discovery Rules Engine" on page 127.

o Forlogfiles, see "Discovery Rule Engine Log Files" on page 127.

How to Define Discovery Rules

This task describes how to define a new discovery rule in the Discovery Rules Engine.

If you are working on an upgraded version of UCMDB, you can also edit user-defined rules from
your previous version.

To learn more about the Discovery Rules Engine, see "Discovery Rules Engine" on previous page.

To add new user-defined discovery rules:

1. Goto Adapter Management.

2. Inthe Resources pane, click New L=, and select New Configuration File.

Enter a name for the new discovery rule. The name must begin with ruleEngine/ and end with
.xml.

For example: ruleEngine/myRule.xml.
3. Inthe Package field, select NormalizationRules.
4. Inthe Editor pane that opens on the right, enter the new rule.

An example of valid rules can be found under NormalizationRules > Configuration Files, in
ruleEngine/samples.xml.

5. Click OK.

To edit an existing discovery rule from a upgraded version of UCMDB:
1. Goto Adapter Management.
2. Inthe Resources pane, select the UserDefinedRules package.

3. Under Configuration Files, select the .xml file for the rule that you want to edit.

Note:

= Rules that were defined in previous versions of UCMDB (for example in
oidToHostClass.xml), can be found under the UserDefinedRules package, in the
configuration file UserDefinedOidToHostClass.xml.
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» Out-of-the-box OidToHostClass rules can be found under NormalizationRules
> External resources in the ruleEngine/snmp.gz file.

How to View Discovery Rules in JMX

The Discovery Rules Engine is very large. You can search the rule base using search commands
on the JMX-console.

To search for a rule:

¢ Logintothe JMX console using the server administrator credentials (by default:
sysdmin,sysadmin)

o Gotothe service: Normalization Rule Base Services, and enter one of the following search

commands:

scanForSNMPRules Retrieves SNMP discovery rules that apply to the
specified input attributes.
Note:
= the sys_object_id value must always have aleading
= Leave empty toignore

scanForScanFileRules Retrieves Scan File discovery rules that apply to the
specified input attributes.
Note: Leave empty to ignore

viewNormalizationRuleByld Retrieves discovery rules by ID

viewNormalizationRuleByNiceld | Retrieves discovery rules by user friendly 1D
(NiceRulelD),

Example: 4323@SNMP

viewNormalizationRules Retrieves discovery rule outputs that apply to the
specified input attributes

Format:

= Pair attributes in the following format:
attrName;attrValue

» Pairs must be separated by commas.

Example: Name;HP,Version;10
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How to Disable the Discovery Rules Engine

All population adapters are set up, by default, to use the Discovery Rules Engine adapters.
To disable the Discovery Rules Engine for a particular population adapter:
1. In Adapter Management, open the population adapter's configuration file (<adapter>.xml).
2. Search for the following parameter: normalizationRules isEnabled
= If youfind it, ensure that the value is set to false.

= If you do not find it, add the following line: <normalizationRules isEnabled="false"/>

Discovery Rule Engine Log Files

The section describes the Discovery Rules Engine log files. These files can be found in <Data Flow
Probe Installation>\runtime\log\.

normalization.audit.log

Logs information about the processing of the Discovery Rules Engine.

Level Description

Information | Audits the number of element processed and the number of Cls that were changed.

Example:

Normalization (OSHV: 8 elements) (Time: 125 ms) (Modified Cls: 1)

normalization.log

Logs detailed information about the processing of the Discovery Rules Engine, enabling you to
trace detailed information of the Discovery Rule Engine process.

Level Description

Error All discovery rule processing errors.

Information | Logs all levels of information about the processing of the Discovery Rules Engine.

Debug Logs mainly for debugging purposes.

Basic Troubleshooting. Check this log when you need to analyze why a Cl was not enriched by
the Discovery Rules Engine.
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Integration Studio Overview

The Integration Studio is where you manage your UCMDB integration points and connect and share
information with external repositories, such as other CMDBs, IT Performance Suite products, or
third-party products.

Integration with other products is performed over secure communication channels through Data
Flow Probes.

Alternatively, if your remote managed data repositories are accessible from the UCMDB server
machine, non-Jython-based integrations can be performed using the HP UCMDB Integration
service, enabling the Data Flow Probe resources to be used for other discovery tasks.

Integration points in the CMDB are based on adapters, which are entities that are capable of
communicating with external data repositories. A basic set of adapters is provided with the CMDB;
however, you can create additional adapters using the Federation Framework SDK. For details, see
"Add an Adapter for a New External Data Source" in the HP Universal CMDB Developer Reference
Guide.
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You can also create adapters in the Adapter Management module. For details, see "Resources
Pane" on page 116.

For details about how to set up integration points for data integrations, see "Integration Studio Page
" on page 155.

Integration points can be of one of the following types:
o "Population" below
o "Federation" below

o "Data Push" on page 132

Population

An integration of Population type copies data from an external data repository into the CMDB, so
that the CMDB now controls the data.

You use population in one of the following scenarios:
¢ When you need to track changes made by the CMDB at the Cl level.

o When a remote repository is not reliable in terms of response time; for example, a network delay
prohibits you from setting up run-time federation with the repository.

« When a remote repository does not support federation capabilities (no appropriate adapter
exists).

Federation

An integration of Federation type includes data in the CMDB from other sources in such a way that
the source of the data still retains control of the data.

You use the CMDB's federation capabilities to extend the scope of the existing Topology Query
Language (TQL) capabilities to encompass data that is stored and maintained in an external
repository. The ability to include such information is important as it prevents you from having to
copy large amounts of data and, instead, bring it into your CMDB only when it is really needed.

Federation also has the benefit that the federated data does not burden the CMDB in terms of
capacity; theoretically, you can set up an integration that federates trillions of Cls and relationships.
Federated data is fetched at runtime, as requested, which lessens the impact on system
performance.

Note: The CMDB does not offer change tracking on federated data because the data does not
reside within the CMDB and the CMDB is not notified when external data is modified.

Federated integration creates a federated integration point, which can then be used when defining

TQL queries. For details on TQL, see "Topology Query Language" in the HP Universal CMDB
Modeling Guide.

Note: Federation can be configured in Actual state only, but can be performed in either Actual
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or Authorized state.

Retrieving Data from Multiple Federated Data Sources

During TQL query calculation, you can retrieve data for the same CIT from several federated data
sources. The data is retrieved from the local CMDB, as well as from other federated data sources,
according to how you have configured integration points. As data arrives at the CMDB, it is
identified and reconciled, with the end result determined according to the configured reconciliation
priority given to the various integrations.

Each Cl that is retrieved from an external data repository includes an attribute (Created By) to
show from which federated data source the Cl has been retrieved.

For limitations, see "Limitations" on page 168.

Retrieving Attributes from an External Data Repository

¢ You can retrieve the attributes of a Cl from an external data repository, when the core Cl data is
stored in the CMDB.

e The core data repository must be the CMDB.
o The CIT must be located in a data repository for its attributes to be defined.
o The same attributes can be retrieved from multiple data repositories.

o Fordetails on retrieval options, see the Cl Type Retrieval Mode field on the "Federation Tab" on
page 146.

¢ When you configure an integration point to include federated Cls, you must select full federation
of a Cl or the federation of an attribute alone. You cannot set up two integrations for the same
CIT where one is mapped to an external CIT and the other is mapped to that same CIT with an
external attribute.

o A CIT can support external attributes if the adapter (which is federating the CIT data) supports
mapping information (reconciliation) for this CIT.

Reconciling Information

Federated queries should use the mapping file to reconcile the Cl from the CMDB with the
attributes from the external data repository.

For details on the Mapping Engine, see "Federation Framework Flow for Federated TQL Queries" in
the HP Universal CMDB Developer Reference Guide.

For details on selecting attributes to be included in the federation, see "Federation Tab" on page
146.

For details on how reconciliation is performed, see "Entity Reconciliation" on page 250.
Use Cases

¢ You need to discover the SMS or Altiris desktops in your system. The desktop CIT is a core CIT
and is already synchronized with the CMDB. However, you do not want to store all the desktop
datain the CMDB as this is inefficient and unnecessary. It is enough to store core attributes
such as name and MAC address in the CMDB, and to define the other details of the desktops as
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external attributes in two data repositories: SMS and Altiris.

« VMware creates virtual machines that contain a virtual machine monitor (hypervisor) that
allocates hardware resources dynamically and transparently. Multiple operating systems can
run concurrently on a single physical computer. Since the allocation resources—for example,
memory—are dynamic, DFM cannot discover these resources (DFM runs once every 24 hours
and the resource data can change hourly). To enable UCMDB to always be updated with real-
time data, the solution is to divide the data into two: the core data of the virtual hosts should be
discovered and placed in the CMDB; the resource attributes should be retrieved from the
external source. In this use case, the data for these attributes is retrieved from two data
repositories: CMDB and VMware.

Data Push

An integration of Data Push type copies data from the CMDB to an external data repository, so that
the CMDB no longer retains control over this data.

You use data push integrations to feed important data from your CMDB into an external system to
facilitate your necessary business processes. An example of this is pushing data discovered by
DFM into HP Service Manager, where tickets may be opened that are connected to the actual Cls
in your IT infrastructure.

If an authorized state has been defined, you can perform data push from the authorized or actual
state.

For limitations on Data Push jobs, see "Limitations" on page 168.

Integration in a Multi-Tenancy Environment

When executing integration queries or jobs in a multi-tenancy environment, all Cls and relationships
that are federated or populated from the remote data source are assigned an owner tenant.

If the data source environment is multi-tenancy aware, when you run a query or a job, only the Cls
and relationships of those tenants that you have permissions to view are federated or populated.
The owner tenant value is brought in with all of the other attributes.

If the data source environment is not multi-tenancy aware, when you run the query or a job,
UCMDB automatically assigns a specified owner tenant value to each of the federated/populated
Cls and relationships. For details about selecting an owner tenant value to assign to
federated/populated Cls and relationships, see "New Integration Point/Edit Integration Point Dialog
Box" on page 159.

HP UCMDB Integration Service

If your remote managed data repositories are accessible from the UCMDB server machine, you can
use the UCMDB Integration Service, installed on the UCMDB Server to run non-Jython-based
integrations, instead of a Data Flow Probe.

This enables running non-Jython-based integrations without using Data Flow Probe resources that
may be better used for other discovery tasks.

For information on using the HP UCMDB Integration Service to run integrations, see "How to Set
Up an Integration Point" on page 136.
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Note:

e The HP UCMDB Integration Service must be started on the UCMDB Server.

o Ifthereis a Data Flow Probe installed and running on the UCMDB Server machine, you
must first stop the Data Flow Probe before you can start the UCMDB Integration Service.
For details, see "How to Check the HP Universal CMDB Integration Service Status" on
page 144.

How to Work with Federated Data

This task explains how to set up and work with data that is federated from different CMDB sources.
This task includes the following steps:
o "Set up the federation type integration " below
o "Set areconciliation priority" below
¢ "View Instances in IT Universe Manager" below
o "View Reports" below
1. Set up the federation type integration

Set up the integration that will federate the data, including the CITs that should be federated.
For details, see "How to Set Up an Integration Point" on page 136.

2. Set a reconciliation priority
In the Integration Point pane, select the integration, and click the Reconciliation Priority
Manager G button. For more details, see "Reconciliation Priority Window" on page 274.
3. View Instances in IT Universe Manager

For details about viewing the federated Cl instances, see "Working with Views in IT Universe
Manager" in the HP Universal CMDB Modeling Guide.

4. View Reports
You can view reports about the integration in the Modeling Studio. For details see the section
about reports in the HP Universal CMDB Modeling Guide.

How to Work with Population Jobs

This task explains how to schedule population jobs and select the queries that are used to populate
the CMDB with data.

This task includes the following steps:
o "Create an integration point" on next page
o "Set areconciliation priority" on next page

¢ "Run the population job" on next page
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o "Build a view of the population results" below
¢ "View instances in IT Universe Manager" below
o "View reports" below

1. Create an integration point

Set up the integration to populate the data. For details, see "How to Set Up an Integration
Point" on page 136.

2. Set a reconciliation priority
In the Integration Point pane, select the integration, and click the Reconciliation Priority
6

Manager button. For more details, see "Reconciliation Priority Window" on page 274.

3. Run the population job

Population jobs are set to run according to a default schedule setting. However, you can
manually run the integration at any time from the Integration Jobs pane. For user interface
details, see "Integration Jobs Pane" on page 147.

Select the job.

= To synchronize all data for the first time, click the Run Job - Sync All Data |@| button.
= Tosynchronize only the data changes since the job last ran, click the Run Job - Sync
Changes |£| button.
4. Build a view of the population results

For details about viewing the populated data, see "Working with Views in IT Universe
Manager" in the HP Universal CMDB Modeling Guide.

5. View instances in IT Universe Manager

For details about viewing the Cl instances, see "Working with Views in IT Universe Manager"
in the HP Universal CMDB Modeling Guide.

6. View reports

You can view reports about the integration in the Modeling Studio. For details see the section
about reports in the HP Universal CMDB Modeling Guide.

How to Work with Data Push Jobs

This task explains how to schedule data push jobs and select the queries that are used to send data
from the CMDB to another data repository.

This task includes the following steps:
o "Create an integration point" on next page
o "Set Reconciliation priority" on next page

¢ "Runthe Data Push job" on next page
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o "Build aview of Data Push results" on next page

¢ "View instances in IT Universe Manager" on next page

1. Create an integration point
Set up the integration to push the data from UCMDB. For details, see "How to Set Up an
Integration Point" on next page.

2. Set Reconciliation priority
In the Integration Point pane, select the integration, and click the Reconciliation Priority

Manager G button. For more details, see "Reconciliation Priority Window" on page 274.

3. Run the Data Push job

Data Push jobs are set to run according to a default schedule setting. However, you can
manually run the integration at any time from the Integration Jobs pane. For user interface
details, see "Integration Jobs Pane" on page 147.

Select the job.

= Tosynchronize all data for the first time, click the Run All-Data Sync = button.
= Tosynchronize only the data changes since the job last ran, click the Run Changes Sync
= button.

Note:

o If Cls in a data push job fail, the query is displayed in the Query Status tab with the
status: Passed with failures. You can drill down to see the errors that occurred and
the Cls affected. This error data is saved in the system. When the job runs again to
synchronize changes, UCMDB remembers the failed Cls and repushes these as
well. For user interface details, see "How to Work with Data Push Jobs" on previous

page.

o You can define a limit on the number sequential Cl failures allowed during a running
data push job. When this limit is reached, the job automatically stops running,
enabling you to troubleshoot the reason for so many failures before waiting for the
entire job to end.

In the Administration modul€e's Infrastructure Setting Manager, select Integration
Settings and set the value of Maximum number of data push job failures
allowed in a sequence. The default value for this setting is 20,000.

o If, since the last synchronization, you have changed a TQL query (other than
changes to conditions on existing nodes), all data is synchronized and the following
message is written to the log: TQL was changed between syncs - performing
Full sync!

o High Availability environment: If a data push job is running, and there is a failure
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on the UCMDB environment, the data push job fails. You can wait for the next
invocation of the job schedule, or alternatively rerun the data push job manually.

4. Build a view of Data Push results

For details about viewing the data push results, see "Working with Views in IT Universe
Manager" in the HP Universal CMDB Modeling Guide.

5. View instances in IT Universe Manager

For details about viewing the Cl instances, see "Working with Views in IT Universe Manager"
in the HP Universal CMDB Modeling Guide.

How to Set Up an Integration Point

This task describes how to set up an integration point for a particular integration with UCMDB.

Note: The integration adapters provided with the Discovery and Integration Content Pack
come predefined with the basic setup recommended to perform integration with UCMDB,
including adapter properties, integration jobs and, where relevant, federation settings. You can
use these settings or configure them to suit your needs.

This task includes the following steps:

o "Prerequisites" below

o "Create an integration point" below

o "Add the integration jobs and schedule the jobs to run" on next page

o "For afederation-type integration, define the data to be federated" on next page

o "Save the integration point" on next page

1. Prerequisites

The integration adapter must be correctly configured before setting up the integration.

= Pre-configured Integration Adapters: These are provided out-of-the-box with the product.
It is recommended to use the adapters as they come, without any further configuration.

However, if you do need to modify the adapter configuration, you are encouraged to do this
from the Adapter Management module rather than manually. For details about adapter
configuration, see "How to Configure Adapter Settings" on page 81.

= New External Data Source Adapters: To configure an adapter for an new extermnal data
source, see "Add an Adapter fora New External Data Source" in the HP Universal CMDB
Developer Reference Guide.

2. Create an integration point
In UCMDB, select Data Flow Management > Integration Studio, and click the New

Integration Point 2] button. For user interface details, see "New Integration Point/Edit
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Integration Point Dialog Box" on page 159.
a. Enter a name and description for the integration point.

b. Select the appropriate integration adapter. For details on existing adapters, see "Select
Adapter Dialog Box" on page 162.

c. Select whether or not to activate the integration upon creation.

d. Upon selecting the adapter, the Adapter Properties section is populated with the relevant
adapter properties. Provide the relevant information. For details, see the relevant section in
HP Universal CMDB Discovery and Integration Content Guide.

e. Configure the adapter's protocol credentials, where required. For a list of supported
protocols, see the HP Universal CMDB Discovery and Integration Content Guide.

f. Select the Probes to use for the integration.

Note: If your remote managed data repositories are accessible from the UCMDB
server machine, you can use the UCMDB Integration Service instead of a Data Flow
Probe to run non-Jython-based integrations.

In this case, in the Probe Name box, select UCMDB Integration Service.

If UCMDB Integration Service does not appear in the Probe Name list, ensure that
the UCMDB Integration Service is running on the UCMDB Server machine. For
details, see "How to Check the HP Universal CMDB Integration Service Status" on
page 144.

g. For Jython-based integration adapters only: Create or select a trigger Cl instance for
the integration.

3. Add the integration jobs and schedule the jobs to run

In the Integration Jobs pane, click the New Integration Job | | button.
= Where relevant, define the job queries.

= Population and Data Push integration jobs are set to run according to a default schedule
setting. You can change the schedule in the Schedule Definition pane.

For user interface details, see "New Integration Job/Edit Integration Job Dialog Box" on page
156.

4. For a federation-type integration, define the data to be federated
In the Federation tab, select the CITs to be federated.
For user interface details, see "Federation Tab" on page 146.

5. Save the integration point

Make sure to save the integration point settings.
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How to Save an Integration Point Configuration as
an Adapter Default

You can save an integration point configuration as an adapter default. This is useful if you want to
use an integration point's configuration to create other integration points with a similar configuration.

This task describes how to save an integration point configuration as an adapter default.

1. Prerequisites

a. Define an integration point based on a particular adapter. For example, MSSMS, based on
the Microsoft SMS adapter.

b. Define population or push jobs and federation details.
c. Save the integration point.

2. Save the integration point configuration as an adapter defaulit

a. Inthe Integration Point pane, right-click the integration point that you created, and select
Save as Adapter Default.

Integration Point MSEMS Population | Federation

* & K g ﬁ;' ':} :;:' ¢::' Population jobs update the locsl CMDEB with Cl Types and sttributes from an external dats repostory
& .
) Histary Dstesource Integration Jobs
5 masms
E"‘ & Edit
5] UCMDBDiscovery % Delete Jobh Name ‘ Status

i @ Disabled

@ Refresh
@ Goto Adapter

ﬁ;' Reconciligtion Priority hManager...
{:‘ Activate Integration Point

1 Export To XML,
|- Sawe as Adapter Defaul [
—

av

b. Inthe Save as Adapter Default dialog box, enter details for the adapter default as follows:

o Name and Description. A name for the adapter default and a description.

Caution: If you give the adapter default the same name as an existing adapter
default, UCMDB treats this as though you are redefining the existing adapter
default, and the new definition overwrites the existing definition. If you do not want
to overwrite an existing adapter default, give the new adapter default a different
name.

o Path. (Optional) The path to the folder under which your adapter should be displayed in
the Select Adapter dialog box (when creating a new integration point). The adapter
default is displayed under the same category as the adapter that was originally used to
create the integration point, in the path that you define here.
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Note:
o Use only forward slashes (/) in the path.

o If you define a new folder in the path, the adapter default is displayed in that
folder, under the same category as the original adapter.

o If you leave the path empty, the adapter default is displayed directly under the
same category as the original adapter.

Using the MSSMS integration point example introduced in the Prerequisites section above,
you could save this integration point as an adapter default, calling it my_mssms_defaults
and defining the path as MyAdapters/MSSMS.

E Save as Adapter Default m

|__ " Save as Adapter Default
Save integration poirt configuration as adapter default,

Mame: | my_rmssms_defaults |

Description: | Populates hasts from 53 databaze using default jobs |

Path: | MyAdaptersiMSSMS |
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The next time you create a new integration point, the my_mssms_defaults adapter default
is displayed under the Third Party Products category (because the out-of-the-box
Microsoft SMS adapter appears under this category), in the MyAdapters>MSSMS folder,
as you specified in the path:

Select Adapter m

Select Adapter
Select the Adapter to uze for the new Integration Poirt

o 4

CM
External Source Import
HP ETO Products
FH ] Push Adagter
—H—— Third Party Products
BMC
EI—El My Sclapters
MSSME
l—D h'lj.l' MESms defaurts|
[T Trowe
— [ Aperture WISTA by SGL
—[ 9 cacMDe
—[ ] EMC Cartral Center
—[ 9 Microsoft SMS
—D Service Mow Pushbdapter
[ software &G SRS
—[ ] UCHMDE &F1 Population
[ UCMDE to XML

my_mssms_defaults

Populates hosts from SMS database using default jobs

Note:

o When you save the adapter default, integration point parameters that are not related to the
connection itself are saved in the adapter default definition.

o The code for the adapter default is added to the adapter's xm file. To delete the adapter
default, see "How to Remove Adapter Defaults" on next page.

Page 140 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 6: Integration Studio

How to Remove Adapter Defaults

To remove an adapter default, you must delete the code that defines it from its base adapter's .xml
file.

To remove an adapter default:

1. Locate the adapter on which the adapter default was based. (Adapter Management >
Resources pane).

Tip: Alternatively, you can access the adapter from the Integration Point pane by right-
clicking the relevant integration point and selecting Go To Adapter.

2. Right-click the adapter and click Edit Adapter Source.

3. Inthe adapter's .xml file, locate the following line:

= Non-Jython adapters:
<adapterTemplate name="<adapter default>" description="">

= Jython adapters:
<adapterJythonTemplate name="<adapter default>" description="">

where adapter_default is the name of the adapter default.

4. Delete the all the code from this opening tag to the closing </adapterTemplate> (or
</adapterJythonTemplate>)tag.

Caution: Do not delete the following line: </adapterTemplates>
5. Save your changes.

Example
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EAdapler Source Editor - SMS5Adapter x|

QEDE |2
75 <jcron-expression-list>- -
78 <start-time>zZ010-01-01T00:00:00.000<fstart-time>
77 <fdata-acyquisition-schedule:>
78 < /population-schedules:
79 <fadapterTemplate:
80 <adapterTemplate nane="wy sms defaults” description="'"o»
51 <destination-config destination-id="MIZM3">
&2 <adapter-id=SM3idapter</adapter-id>
a3 <type-values>
84 “<type-value nome="dhtype” type="string"=50L3erver<ftype-value:>
85 <type-value nane="dbname” type="stringrsnsbpn<jtype-value>
&6 <ftype-values:-
a7 <fdestination-config-
a3 “population-jobs:
59 <data-acquisition-population-job:>
an <amit-id=5M3 Population job-Cfunit-id-=
a1 <Uery-nanes Delete the text
92 <iquery-selection- P
a3 <guery-name:-hostDataFron3M3-< fquery-names: in the box
94 <allow-deletion-false<fallow-deletion>-
as <fyquery-=selection>
a6 <fquery-names:>
97 <allow-deletion-false<fallow-deletion>
a3 <fdata-acyuisition-population-joh-
99 </population-johs-
100 <population-schedules:>
101 <data-acquisition-schedule> =
102 <job-name-3M5 Population job</job-name-
103 <cron-type:l<fcron-type:-
104 <Cron-expression-list:>
105 “Cron-expressionzDays_l<fCron-expressions
108 <fcron-expression-list:-
107 <start-time>-2010-01-01T00;00:00. 000<Fstart-times-
108 “ig-full-sync:false<fis-full -sync:
109 <fdata-acquisition-schedule:
110 </population-schedules>
111 =, terT late:
11z </adapterTemplates> - Caution! Do not delete this line!
113 <imputClass:destination_config<finputClass>
114 “protocols fF>

How to Create a Cl Topology

You can save a topology to the CMDB for a new adapter. This adapter can include elements from a
defined topology already existing in the CMDB as well as new elements that you have added to the

topology.

For details on creating the topology, see "Topology CI Creation Wizard" on page 165.

How to Deploy a Package to a Remote Data
Repository

You can deploy a package to a data repository located on a remote machine without logging in to
the remote machine. This feature is useful if you need to deploy queries, views, or other UCMDB
resources created on one machine to other machines running UCMDB.

Note: You perform the following procedure for each data repository that the package is to be

deployed to.

This task includes the following steps:
o "Prerequisites" on next page
o "Change timeout - optional" on next page

o "Select the integration point" on next page
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o "Select the package" below

o "View deployment results" below

o "View Log files" on next page

1.

Prerequisites

= Verify that the Data Flow Probe is configured correctly and is connected to UCMDB.
» Verify that the version of UCMDB running on the remote machine is version 9.02 or later.
= Verify that UCMDB running on the remote machine is up and running.

= Create the package that must be deployed to the remote machine, and deploy this package
to the local UCMDB Server.

Note: By default, you cannot deploy a package that is larger than 10 MB.

Create an integration point on the local UCMDB Server, that uses the UCMDB 9.x/10.x
adapter.

Change timeout - optional

You can change the time after which UCMDB times out package deployment. If UCMDB
cannot connect to the remote machine in 5 minutes, by default, the deployment is timed out.

To change the default: Select Administration > Infrastructure Settings Manager >
Integration Settings > Remote package deploy Timeout. (The refresh rate indicates when
the change takes effect in UCMDB after the value is modified.)

Select the integration point

a. Inthe Integration Point pane, select the integration point that you created in "Prerequisites”
above. For details, see "Integration Point Pane" on page 153.

b. Click the Deploy Remote Package button.
Select the package

a. Inthe Deploy Remote Package dialog box, select a package from the list of packages
existing on the local UCMDB Server. This is the package that you created in
"Prerequisites" above. For details, see "Deploy Package to Remote Data Repository using
<Integration Point>" on page 146.

b. Click OK to deploy the package.
View deployment results
Answer the message that is displayed: click OK to begin deploying the package.

The status of the deployed package is displayed together with the status of each individual
resource in the package.

= Successful deployment: A package is successfully deployed if all its resources are
successfully deployed.

= Failed deployment: If even one resource fails, the package deployment is considered to
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have failed. Even if package deployment fails, all the successful resources are deployed on
the remote machine.

The reason for the failure, for example, a missing CIT, is displayed in the Deployed
resources section:

Deployed resources

Resource = | Status
tglfviewtesting . xml €3 Class not in class model

6. View Log files

The following table shows the locations of the log files that record any issues that might arise
during deployment:

Location Log File Name

Remote UCMDB machine, version 9.02 or later ucmdb-api.log

mam.packaging.log

Data Flow Probe probeTasks.log

probe-infra.log

adapters.log

Local UCMDB machine ucmdb-api.log

If a resource fails to deploy, an error is displayed in the Status column as well as in the log file
on the remote machine.

How to Check the HP Universal CMDB Integration
Service Status

If your remote managed data repositories are accessible from the UCMDB server machine, you can
use the UCMDB Integration Service for non-Jython-based integrations instead of a Data Flow
Probe.

To use this service, ensure that it is running on the UCMDB Server machine:
¢ Windows:Control Panel > Administration Tools > Services
¢ Linux:/opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh status

To start the service if the service is not running, do the following:
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e Windows:
= Select Start > Programs > HP UCMDB > Start HP UCMDB Integration Service

= Select Start > Control Panel > Administration Tools > Services, and start the UCMDB
Integration Service

o Linux: Enter the following command:
lopt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh start

Note: If there is a Data Flow Probe installed and running on the UCMDB Server machine, you
must first stop the Data Flow Probe before you can start the UCMDB Integration Service.

To stop the Data Flow Probe:
o Windows: Select Start > Programs > HP UCMDB > Stop Data Flow Probe.

e Linux: Enter the following command:
lopt/hp/UCMDB/DataFlowProbe/bin/probegateway.sh stop

Integration Studio User Interface

This section includes (in alphabetical order):

e "Data Push Tab" below

o "Deploy Package to Remote Data Repository using <Integration Point>" on next page
o "Federation Tab" on next page

¢ "Integration Jobs Pane" on page 147

o "Integration Point Pane" on page 153

o "Integration Studio Page " on page 155

¢ "New Integration Job/Edit Integration Job Dialog Box" on page 156

+ "New Integration Point/Edit Integration Point Dialog Box" on page 159
o "Population Tab" on page 162

o "Select Adapter Dialog Box" on page 162

o "Topology CI Creation Wizard" on page 165

Data Push Tab

This tab enables you to:

o Specify the queries that are used to push data to external data repositories, and to schedule jobs
that contain those queries. For details, see "Integration Jobs Pane" on page 147.

o View statistics results for jobs that have run. For details, see "Statistics Tab" on page 150.

To access Select the Data Push tab on the Integration Studio page.

Page 145 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 6: Integration Studio

Important This tab is enabled only when data push is supported by the adapter on which
information you are basing your integration point.

See also "New Integration Job/Edit Integration Job Dialog Box" on page 156

Deploy Package to Remote Data Repository using
<Integration Point>

Enables you to deploy a package to a remote data repository using an integration point, and to view
the results of the deployment.

To access Click the Deploy a Remote Package button in the Integration Point
pane. For details, see "Integration Point Pane" on page 153.

Relevant tasks "How to Deploy a Package to a Remote Data Repository" on page 142

User interface elements are described below:

Ul Element

(A-2) Description

Deployed The status (success or failure) of each deployed resource in the package
resources named under Deployment status.

Deployment The name and status (success or failure) of the complete package.
status

Package A list of all available packages.
Name

Federation Tab

This tab enables you to select which CITs or attributes are to be supported by the integration point.
For example, if a TQL query includes a node that represents a specific CIT, the instances of this
CIT are accepted from this external data repository.

For details about selecting Cls, see "Cl Selector Overview" in the HP Universal CMDB Modeling
Guide.

To access Select the Federation tab on the Integration Studio page.

Important This tab is enabled only when data federation is supported by the adapter on
information which you are basing your integration point.

User interface elements are described below:

Ul Element (A-Z) Description

= Click to clear all selected items.
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Ul Element (A-Z) Description

&= Click to invert the selections.
|§| Click to expand the entire hierarchical tree structure.
|§| Click to collapse the hierarchical tree structure.

Cl Type Retrieval Mode

¢ Retrieve Cls of selected Cl Type. All a Cl's data, including all
its attributes, are retrieved from the data repository.

+ Retrieve selected attributes. The selected attributes are
retrieved from the data repository. The Cls must already exist in
the CMDB.

« Retrieve the attribute from the UCMDB too. The attribute
can be federated as well as physically retrieved from the CMDB
(if any attributes of Cl instances exist in the database).

Note:

e Aparent CIT and all its child CITs included in an integration
point definition must use the same retrieval mode.

e You cannot select both CITs and attributes for the same
integration point.

Select Attributes

You can define which attributes of an external CIT are to be
included in the federation:

¢ Inthe Cl Type Retrieval Mode pane, select Retrieve selected
attributes.

o Inthe Select Attributes list, select the attributes that are to be
included in the federation.

o Save the changes.

Note: Attributes are defined in the CIT Manager. For details, see
"Add/Edit Attribute Dialog Box" in the HP Universal CMDB
Modeling Guide.

Supported and Selected
Cl Types

Displays a hierarchical tree containing the supported and selected
Cl Types and attributes.

When queried by an TQL query, the CITs you select here are
configured to retrieve the data from this external data repository.

Select the CITs to be supported by this integration point.

Integration Jobs Pane

This pane enables you to schedule integration jobs to run with external data repositories. The
Statistics, Query Status, and Job Errors tabs display runtime details about the selected jobs.
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To access o Select the Population or Data Push tab on the Integration Studio page.

o Toaccess the Statistics, Query Status, or Job Error tabs, select an integration
point, select the Population or Data Push tab on the Integration Studio
page, then select a job.

Important This pane is displayed only when population or data push is supported by the
information | adapter on which you are basing your integration point.

Relevant e "How to Work with Population Jobs" on page 133

tasks ¢ "How to Work with Data Push Jobs" on page 134

See also o "Discovery Scheduler Dialog Box" on page 227

User interface elements are described below:

Ul Element (A-Z) Description

New Integration Job. Enables you to create an integration job. For details,
see "New Integration Job/Edit Integration Job Dialog Box" on page 156.

2]

Edit Integration Job. Enables you to edit an existing integration job.

Delete Integration Job. Deletes the selected integration job from the list.

Refresh. Refreshes the list of integration jobs.

Note: If you refresh the list of jobs before you save a new job, you are given
a choice:

e Yes. Thejobis saved and the integration is refreshed.
e No. Thejobis not saved and the integration is refreshed.

e Cancel. The jobis not saved and the integration is not refreshed.

Run Job - Sync Changes. Runs the selected population or data push job
and synchronizes only the changes in the data since the last time the job
was run.

By default, scheduled jobs synchronize only changes except for the first
time ajob runs. In that case, a full population or data push job runs, in which
all relevant data for the job is synchronized.

Note:

¢ Ifthe job is scheduled to run an all-data synchronization while you are
running a changes synchronization, the scheduled all-data
synchronization will run when the job has finished synchronizing the
changes.

¢ If Cls inadata push job fail, the query is displayed in the Query Status
tab with the status: Passed with failures. You can drill down to see the
errors that occurred and the Cls affected. This error data is saved in the
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Ul Element (A-Z) Description

system. When the job runs again to synchronize changes, UCMDB
remembers the failed Cls and repushes these as well. For details, see
"Query Status Tab" on page 151.
|E| Run Job - Sync All Data. Runs a full population or data push job. This job
o copies or pushes all the relevant data for the job.
Note: If the job is scheduled to run a changes synchronization while you are
running an all-data synchronization, the scheduled changes synchronization
will run when the job has finished synchronizing all of the data.
[:| Stop Running Job. Stops running the selected job.
Available for: Data Push jobs only
<right-click In addition to the options described above, the right-click menu provides the
integration job | following functionality:
menu>
e Show Results For Job. DFM sends an ad-hoc request to the Probe and
retrieves the latest results of the job.
This ad-hoc request does not run the job, but brings the results of the
previous job run that are stored in the Probe's database. If the job has not
yet run, a message is displayed.
Available for: Population jobs only.
Note: Results are not displayed if the total number of results exceeds
10,000.
¢ View Communication log. Opens the log that includes information
about the connection between the Probe and the remote machine. This is
on condition that you have set the Create communication log to
Always or On failure. For details, see "Execution Options Pane" on page
96.
Available for: Population jobs based on Jython adapters only.
Job Name Name given to the population or data push job.
Last The type of the last run:
Synchronization N The iob h vt
Type e None. The job has not yet run.
e Changes. The job synchronized only the changes in the data since the
last time it ran.
¢ Full. The job synchronized all the relevant data for the job.
Available for: Data push jobs only
Status Population jobs:
o Waiting for Probe. The job is waiting to be received by the Probe.

Page 149 of 279

HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 6: Integration Studio

Ul Element (A-Z) Description

Data push jobs:

Did not run. The job has been received by the Probe but the Probe is not
yet ready to run the job.

Preparing to run. The Probe is preparing to run the job.

Note: The status is preceded by another instance of the Waiting for
Probe status, but this time Waiting for Probe indicates that the Probe is
now ready to prepare the job for the run.

Running. The job is running.
Succeeded. The job ran successfully.

Succeeded with warnings. The job ran successfully but warnings were
reported.

Failed. The job did not run successfully.

Disabled. The integration point is deactivated or the trigger Cl is missing.

Did not run. The job has not yet run.
Running. The job is currently running.
Ended. The period between Running and Succeeded or Failed.

Passed with failures. The last run passed , but some Cls failed. These
failures can be viewed in the Query Status tab. For details, see "Query
Status Tab" on next page.

Succeeded. The last run was successful.

Failed. The last run was not successful.

Start time / The time that the integration job actually started running, and when it finished
Finish time running. These columns are refreshed every time the job goes into the
Running state.
Available for: Population jobs only
Statistics Tab

This tab displays information about the Cls synchronized by the job.

Note: Statistics for population jobs are accumulative and therefore can be filtered, whereas the
data push statistics are always relevant for the last job run only.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element

Description

Click to refresh the list of CITs.

Select the time range or Probe for which to display statistics about the selected job.

« By Time Range.

Available for: Population jobs only

= All. Displays statistics for all job runs.

= From Now/Last Minute/Last Hour/Last Day/Last Week. Choose a period
of time for which to display statistics about the CITs.

= Custom Range. Click to open the Change Timeframe dialog box: Enter the
date or click the arrow to choose a date and time from the calendar, for the
From and To dates (or click Now to enter the current date and time). Click
Last Day to enter the current date and time in the To box and yesterday's
date and time in the From box. Click OK to save the changes.

By Probe. To view statistics for a specific Probe, select to open the Choose
Probe dialog box.

<Statistics
table>

CIT. The name of the discovered CIT. Displayed for population jobs only.

Query Name. (Data push jobs only) The name of the query whose data is being
pushed.

Created. The number of Cls created in the period selected or for the selected
Probe.

Updated. The number of Cls that were updated in the period selected.

Deleted. The number of Cls deleted in the period selected or for the selected
Probe.

Failed. (Data push only) The number of Cls that failed to be pushed.

Available for: Service Manager 9.3 adapter only

Last
updated

The date and time that the Statistics table was last updated for the selected job.

Valid to

The date when the data was last synchronized.

Query Status Tab

This tab displays information about the queries defined for the job.

User interface elements are described below:
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ul
Element
(A-2) Description
|%| Refresh. Refreshes the list of queries.
||,_| Push Failed Data. Enables you to repush the selected query/Cl manually.
Available: When a failed query or Cl is selected
<Query | Displays the details of the selected job's queries:
details>
e Query NameThe name of the query.
¢ Query Status
= Population jobs. The latest status of the query after the job finishes running.
= Data push jobs. The current status or the last known status of the query. If a
query passed with failures, you can double-click the query to view the errors
that occurred and on_which Cls they occurred. To repush the query, click the
Push Failed Data !/ button.
o Start Time/Finish Time The time at which data push for this query started and
finished.
Available for: Data push jobs only
<Errors> | Displays errors that occurred, the Cl type affected, and the number of Cls that failed.
Double-click a row to see the Cls that failed due to a particular error.
Torepush the Cls, click the Push Failed Data |"_| button.
Available for: Data push jobs only
<Failed | Displays the exact errors that occurred, the Cls on which they occurred, and when
Cls> they occurred.
To repush the Cl, click the Push Failed Data ||'_| button.
Available for: Data push jobs only

Job Errors Tab

This tab displays the errors or warnings reported during the job run.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A—

Description

Click to refresh the list of errors.
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Ul Element (A—
Z)

=]

Description

Select a row and click this button to view details of a message.

<List of error
messages>

« Message. A message describing warnings (if the job succeeded with
warnings) or the cause for failure if the job failed.

o Severity. For details, see "Error Severity Levels" in the HP Universal
CMDB Developer Reference Guide.

« Reported. The time at which the error is being reported by the job.

¢ Query. Displayed for data push jobs only. The name of the query for which
the error is being reported.

Integration Point Pane

This pane enables you to define integration points, and schedule population and data push jobs.

Integration points are based on adapters, each of which is predefined to transmit information in
specific ways. For example, CMDBAdapter populates Cls and links from a remote CMDB, in
which case the CMDB then has a local copy of these Cls, while the ServiceManagerAdapter
adapter retrieves data from HP ServiceCenter and HP Service Manager, but HP ServiceCenter or
HP Service Manager still retains control.

For details about defining a discovery adapter as an integration adapter, see the "Used as
Integration Adapter" field in "Adapter Definition Tab" on page 89.

To access Located in the left pane of the Integration Studio.
Relevant o "How to Set Up an Integration Point" on page 136
tasks ¢ "How to Save an Integration Point Configuration as an Adapter Default" on
page 138
¢ "How to Deploy a Package to a Remote Data Repository" on page 142
See also o "Data Push Tab" on page 145
o "Federation Tab" on page 146
o "Population Tab" on page 162

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

Description

New Integration point. Enable you to create an integration point. For
details, see "New Integration Point/Edit Integration Point Dialog Box"
on page 159.
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Ul Element (A-Z) Description

|§| Edit Integration Point. Enables you to edit an integration point's
o properties.
E Delete Integration Point. Deletes the selected integration point.

Save Integration Point. Saves the changes you made to the
definition of an integration point.

Full Integration Refresh. Refreshes the list of integration points and
fully refreshes the selected integration point.

Deploy Remote Package. Opens the Deploy Remote Package
dialog box, enabling you to deploy a package to a data repository
located on a remote machine without logging in to the remote
machine. For details, see "How to Deploy a Package to a Remote
Data Repository" on page 142.

Note: This button is enabled for integration points based on the
UCMDB 9.x adapter (which supports package deployment
capabilities).

Open Reconciliation Priority Manager. Opens the Reconciliation
Priority Manager, a centralized location for viewing and changing the
reconciliation priority for all integration points. For details, see
"Reconciliation Priority Window" on page 274.

Activate Integration Point. Activates the selected integration point.

Deactivate Integration Point. Deactivates the selected integration
point.

Import From XML. Enables you to import the integration point's
configuration in XML format.

Export To XML. Enables you to export the integration point's
configuration in XML format.

Note: You must save a new integration point before you can export
its configuration.

<List of integration
points>

Displays the list of previously defined integration points.

<right-click integration
point menu>

In addition to the options described above, the right-click menu
provides the following functionality:

o Go to Adapter. Opens the adapter used by the integration job
in the Adapter Management module.
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Ul Element (A-Z) Description

o Save as Adapter Default. Opens the Save as Adapter
Default dialog box, enabling you to save the configuration of the
selected integration point as an adapter default that can be used
as a basis for other integration points.

Enter a name and description for the adapter default, and specify
the path where the default adapter should be saved.

For example, to save an adapter default in a user-defined folder, in
the Path box, enter:

MyAdapters/Default
Note:
» Useforward slashes (/) to separate folders in the path

» If apathis not defined, the default adapter template is saved,
by default, under the same category as the adapter that it was
based on.

Integration Studio Page

This page enables you to create and manage integration points.

To access Select Data Flow Management > Integration Studio.

User interface elements are described below:

Ul Element (A-Z) Description

78 Reconciliation Priority Manager. Opens the Reconciliation Priority
Manager. For details, see "Reconciliation Priority Window" on page
274.

Integration Point pane | Enables you to create integration points and edit their configuration.
For details, see "Integration Point Pane" on page 153.

Right pane Displays data transfer configuration options for an integration point.
Depending on the adapter on which you base your integration point,
one or more of the following tabs is enabled:

e "Data Push Tab" on page 145
¢ "Federation Tab" on page 146

e "Population Tab" on page 162
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New Integration Job/Edit Integration Job Dialog Box

This dialog box enables you to create or edit population and data push jobs and to schedule them to
be run at specific times.

To access Click |:| on the Population or Data Push tabs.
Relevant tasks e "How to Work with Federated Data" on page 133
e "How to Work with Population Jobs" on page 133
e "How to Work with Data Push Jobs" on page 134
See also "Integration Jobs Pane" on page 147

User interface elements are described below:

Ul Element (A-Z) Description

Name Enter a name for the job.

Note: The name must not exceed 45 characters.

Job Definition Enables you select integration queries for the job definition. For details, see
area "Job Definition" on next page below.

Available for: Non-Jython adapters only.

Scheduler Enables you to schedule when to run the integration job.

Definition area ) ,
For data push jobs, you can set different schedules for all-data

synchronization and change synchronization.

For details about the scheduling options, see "Scheduler Definition" on page
158 below.
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Job Definition

Ul Element (A-Z) Description

Add Query. Opens the Enables you to add an available integration query
to the job definition.

E Delete Query. Enables you to delete the selected query from the job
definition.
|F| 4 Move Query Up/Down. Enables you to determine the order in which the

queries should run.

<Query table>

Displays the queries selected for the integration job.

For non-Jython-based Data Push jobs: Selecting a query's Allow
Deletion check box enables the deletion of Cls or links for the query from
the remote data repository.

Allow Integration
Job to delete
removed data

Enables the deletion of Cls or links per job from the local CMDB.

Available for: Non-Jython-based Population jobs only.

Select the Job Type

Enables you to select the type of job queries to use for the integration.

o Changes - History-based. Cls and direct links, not virtual links. Has
better performance.

e RMI - Full Topology Comparison. Supports Cls and all links types.
Note: Calculated links are not supported.

Available for: Service Manager Data Push jobs only
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Scheduler Definition

Ul Element (A-Z) Description

All-Data Sync tab Enables you to schedule an all-data synchronization.

Available for: Data Push jobs only

Changes Sync tab Enables you to schedule a changes synchronization.

Available for: Data Push jobs only

Cron Expression Enter a Cron expression in the proper format. For a description of the
fields used in Cron expressions and examples of how to use them,
see "Cron Expressions" in the HP Universal CMDB Modeling Guide.

Ends Enables you to select when the job should stop running.
¢ Never. The job continues to run until manually stopped.

¢ Until. Enables you to select the date when the job should stop
running.

Note: This option is disabled when you select Once.

Repeat Enables you to select how often to run the integration job. The
available options are:

e Once. Runs the job only once.
¢ Interval. Runs the job at a set time interval.
o Day of Month. Runs the job on selected days of the month.

o Weekly. Runs the job on a weekly basis, on the days of the week
selected.

¢ Monthly. Runs the job on a monthly basis, according to months
selected.

¢ Yearly. Runs the job every so-many years, according to the
number of years specified.

e Cron. Use a Cron expression to schedule a job. For a description
of the fields used in Cron expressions and examples of how to use
them, see "Cron Expressions" in the HP Universal CMDB
Modeling Guide.
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Repeat every

Enables you to type a value for the interval between successive runs.
Available: When you select Repeat > Interval or Yearly.

Unit of time:

¢ Interval. Minutes; Hours; Days; Weeks

e Yearly. Years

Repeat on

e Sun - Sat. When you select Repeat > Weekly, enables you to
select the day or days of the week to run the job.

¢ January - December. When you select Repeat > Monthly,
enables you to select the months of the year to run the job.

Repeat on the
following dates every
month

When you select Repeat > Day of Month, enables you select days
of the month to run the job. The job runs every month.

To clear the selection click the m button.

Scheduler enabled

When selected, you can choose scheduling options for the
integration job.

Server Time The time on the UCMDB server.

Starts Enables you to select the date and time when you want the job to
begin running.

Time Zone Enables you to set the required time zone. To reset default settings,

click the |§| button.

New Integration Point/Edit Integration Point Dialog Box

This dialog box enables you to create a new integration point or edit the properties of an existing

integration point.

To access

Do one of the following:

o Click the New Integration Point button * in the Integration
Point pane.

o Click the Edit Integration Point button |£| in the Integration
Point pane.

Important information

The list of fields contains all of the items that may be specified when
you create an integration point. Not all of the fields are displayed for
all adapters.

Each mandatory field is marked with an asterisk.
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Relevant tasks

"How to Create a Cl Topology" on page 142

See also

For Multi-tenancy users: "Integration in a Multi-Tenancy
Environment" on page 132

User interface elements are described below

Ul Element (A-Z) Description

| Testconnection

Enables you to verify Probe connectivity using the parameters
provided.

Note: If you have defined additional Probes, these Probes are tested
for connectivity as well.

Additional Probes

Enables you to select additional probes over which to run a data push

or federation-type integration. Click [L.=] to select the additional
probes.

When the integration runs, if additional Data Flow Probes are
defined, the server uses the most available Probe.

Available for: Data push and federation-type integrations only.

Adapter

The adapter for the integration point. Click 22! to select an adapter.
For details about each adapter, see "Out-of-the-Box Integration
Adapters" on page 163.

For help on the selected adapter, click the Show Content Help | 2 |
button.

CMDB State
(Data Push)

The state of the source machine. Values are:
e Actual
e Authorized

Note: This field is visible only when using an adapter that supports
data push and on a UCMDB for which authorized state has been
defined.

Credentials ID

Enables you to select protocol credentials for relevant adapter

integration points. Click [l to open the Choose Credentials dialog
box.

Note: Only the required protocols for the selected integration adapter
are displayed here. For information about protocols required for each
integration adapter see "Required Discovery Protocols Pane" on
page 94.

Default Owner Name

The name of the owner tenant that should be assigned to the
federated or populated Cls and relationships.

Note:
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Ul Element (A-Z) Description

o This field is displayed when creating a federation or population
type integration point in a multi-tenancy environment only.

« If no owner tenant is specified, or if the data source is not a multi-
tenancy environment, the system owner tenant is assigned by
default.

Integration Description

Enter a brief description of the integration point.

Integration Name

Enter a name for the integration point.

Note: The name may not exceed 45 characters.

Is Integration Activated

Select this check box to create an active integration point. You clear
the check box if you want to deactivate an integration, for example,
to set up an integration point without actually connecting to a remote
machine.

Probe Name

The name of the Data Flow Probe used to run integration jobs.
Do one of the following:

¢ Usethe Auto-Select option. In this case, the CMDB attempts to
choose the correct Probe according to the IP ranges that were
defined for the available Probes.

o Select the name of a specific Probe to use for these integration
jobs. When you manually select a Probe, any IP ranges that you
defined in the Probe settings are ignored.

Note: If your remote managed data repositories are accessible
from the UCMDB server machine, you can use the UCMDB
Integration Service option to run non-Jython-based integrations,
instead of a Data Flow Probe.

If UCMDB Integration Service does not appear in the Probe
Name list, ensure that the UCMDB Integration Service is running
on the UCMDB Server machine. For details, see "How to Check
the HP Universal CMDB Integration Service Status" on page 144.

Note: A Probe installed on a Linux machine is defined as an
Integration Probe and appears in this list.

Trigger Cl Instance

Displays the Cl that is to be used by the new integration point as a
trigger during integration with Cls on a remote machine.

o Select Existing Cl. Enables you to select the trigger Cl through
which data is collected during integration. For details, see
Element Instances Dialog Box in the HP Universal CMDB
Modeling Guide.

o Create New CI. Enables you to create the topology of the Cl to
be used as the trigger. For details, see "Topology Cl Creation
Wizard" on page 165.
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To manage or view the trigger Cl, right-click the CI. For details on
these operations, see IT Universe Manager Shortcut Menu in the HP
Universal CMDB Modeling Guide.

Available for: Jython-based integration adapters only

Note: If the trigger Cl instance used for the integration point is
deleted, the integration point's jobs become disabled and cannot run.
In this case, you must edit the integration point and select a new
trigger ClI for the integration.

Note: Additional fields are available, depending on the adapter you select. Descriptions of
each field may be viewed by hovering your mouse over that field on the screen. See the HP
Universal CMDB Developer Reference Guide for details about specific adapters.

Population Tab

This tab enables you to:

o Schedule jobs that populate the CMDB with data from external data repositories. For details,
see "Integration Jobs Pane" on page 147.

o View statistics results for jobs that have run. For details, see "Integration Jobs Pane" on page

147.
To access Select the Population tab on the Integration Studio page.
Important This tab is enabled only when data population is supported by the adapter on

information which you are basing your integration point.

See also "New Integration Job/Edit Integration Job Dialog Box" on page 156

Select Adapter Dialog Box

This dialog box enables you to select from a list of predefined adapters that are provided out of the
box.

You also have the option of adding a custom adapter for a new external data repository. For details,
see Add an Adapter for a New External Data Source in the HP Universal CMDB Developer
Reference Guide.

The Integration Framework SDK enables you to create new adapters that connect HP Universal
CMDB with external products and services. For details, see Developing Java Adapters in the HP
Universal CMDB Developer Reference Guide.

To access Click == in the New Integration Point/Edit Integration Point Dialog Box.
Important The list of adapters displayed depends on your UCMDB License. If you
information
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have the UCMDB Foundation License, only the HP Product adapters are
displayed.

Relevant tasks ¢ "How to Work with Federated Data" on page 133
¢ "How to Work with Population Jobs" on page 133
e "How to Work with Data Push Jobs" on page 134

See also "New Integration Job/Edit Integration Job Dialog Box" on page 156

User interface elements are described below:

Ul Element (A-Z) Description

|E| Click to collapse the hierarchical tree structure.
|§| Click to expand the hierarchical tree structure.
5 Click to display help about the selected adapter.

<list of adapters> Displays a list of out-of-the-box adapters. For details, see "Out-of-the-Box
Integration Adapters" below.

Out-of-the-Box Integration Adapters

Note: Most of the adapters listed below are provided with the Discovery and Integrations
Content Pack. Unless otherwise indicated, information about each of these adapters can be
found in HP Universal g/IDB Discovery and Integration Content Guide, or by clicking the

9

Show Content Help button for each adapter.

Adapter Name (A-Z) Description

HP Product Adapters

AM population and Used to populate and federate data from Asset Manager.
federation

Asset Manager Push Adapter | Used to push data from UCMDB to Asset Manager.

BSM 9.x Used to perform a population sync from BSM to UCMDB.
CMKpiAdapter Used to federate Kpi data from Configuration Manager.
CM Policy Adapter Used to federate Policy data from Configuration Manager.
DDMI Used to populate and federate data from DDMI.

NNMi: Population from NNMi | Used to populate data from NNMi.
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Adapter Name (A-Z) Description

NNMi: Push IDs into NNMi

Used to push UCMDB Node IDs to NNMi.

ServiceCenter 6.2x

Used to federate data from HP ServiceCenter version 6.2x.

Service Manager 7.0x

Used to federate data from HP Service Manager version 7.0x.

Service Manager 7.1x - 9.2x

Used to federate data from and push data to HP Service
Manager versions 7.1x-9.2x.

ServiceManagerAdapter 9.x

Used to federate data from and push data to HP Service
Manager version 9.3 and later.

Storage Essentials

Used to populate Cls and relationships from Storage
Essentials.

Systems Insight Manager

Used to populate Cls and relationships from HP SIM.

UCMDB 9.x Used for populating and federating data from UCMDB
version 9.x.
For details, see "Multiple Deployments with Version 9.x/10.x
CMDBs" on page 171.

UCMDB 10.x Used for population and federating data from UCMDB

version 10.x.

For details, see "Multiple Deployments with Version 9.x/10.x
CMDBs" on page 171.

UCMDB to XML

Used to export the results (Cls and relationships) of TQL
queries and convert these to XML files.

Third Party Product Adapters

Atrium to UCMDB

Used to populate Cls and relationships from Atrium.

CiscoWorks Layer 2

Used to populate server data from CiscoWorks.

CiscoWorks NetDevices

Used to populate network device data from CiscoWorks.

CA CMDB

Used to push Cls and relationships to CA CMDB.

Data Push into Atrium

Used to push Cls and relationships to BMC Atrium.

EMC Control Center

Used to populate Cls and relationships from EMC Control
Center.

Import topology (CSV,

File)

Database, Excel, Properties

Used to import topology from a specified file type.

Microsoft SMS

Used to populate and federate data from Microsoft SMS.

Service-Now Integration

Used to push Cls and relationships to ServiceNow.
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Adapter Name (A-Z) Description

Software AG ARIS

Used to populate Cls and relationships from IDS Scheer
ARIS.

Troux: Population from
Troux

Used to populate Cls from Troux.

Troux: Data Push into Troux | Used to push data to Troux.

Other

UCMDB API Population

Used to define an integration that specifies the reconciliation
priority for data that is added to the CMDB using the CMDB
API. For details, see the HP Universal CMDB Developer
Reference Guide.

Topology CI Creation Wizard

This wizard enables you to save a topology to the CMDB for a new adapter. This adapter can
include elements from a defined topology already existing in the CMDB as well as new elements.

For example, say a node and its IP address exist in the CMDB as a defined topology. However, the
adapter Input query defines a Microsoft SQL Server database element related to that node. This
extended topology does not exist in the CMDB. When using the wizard to create the topology,

CMDB identifies the existing node and IP address by the properties values you enter, connects the
new MSSQL database Cl to the topology, and saves the complete topology in the CMDB.

Note: You cannot use an abstract or federated CIT to create a Trigger Cl.

To access

Select a discovery Jython adapter in the New Integration Point
dialog box. In the Trigger Cl Instance menu, choose Create New CI.

Note: This wizard is available for discovery Jython adapters only,
when the Used as Integration Adapter check box is selected.
Moreover:

o All conditions (attributes, cardinality, qualifiers, and so on) are
disregarded in the Input query.

e Only regular links (that is, not join or compound links) are allowed
in the Input query.

For details on the Used as Integration Adapter check box, see
"Adapter Definition Tab" on page 89.

Important information

e Prerequisite: To ensure that reconciliation rules work with the
created topology, prepare details of the Cls (for example, values
for key properties) as these details are needed during the wizard
creation procedure.
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o If there are any errors during creation, the Summary page
includes an error message and a link to the error details.

o At the end of the topology creation, the source Cl is defined as the
Trigger Cl instance.

See also "New Integration Point/Edit Integration Point Dialog Box" on page
159
Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define Cl: <Cl name>" > "Define
Credentials" > "Topology Creation" > "Summary"

Topology Preview

Enables you to preview the topology definition of the integration point.

Wizard | The Topology Cl Creation wizard contains:

Ma
P "Topology Preview" > "Define Cl: <Cl name>" > "Define Credentials" > "Topology

Creation" > "Summary"

User interface elements are described below:

Ul Element (A-2) Description

[E] Show Legend. Toggles between hiding and displaying the topology
legend.

<toolbar and For details, see "Toolbar Options" in the HP Universal CMDB Modeling

legend> Guide.

Define Cl: <Cl name>

Enables you to define properties of a new Cl instance of the CIT.

Important ¢ This page of the wizard is displayed for each element in the query.

Infi i
nformation o Several elements of the same CIT may exist in the query.

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define Cl: <Cl name>" > "Define Credentials" >
"Topology Creation" > "Summary"

User interface elements are described below:
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Ul Element
(A-2) Description
Define New | Drill down to the property to be used to identify the CIT. Select the field next to
Cl the property name and enter a new value (or choose from existing values).
Properties . .
Note: If the selected CIT is abstract or federated, the properties are not
displayed.
Select CI Select the CIT for which you are defining a new Cl instance.

Type

Define Credentials

Enables you to define credentials for the new CI.

Important ¢ Any changes you make here to a protocol (updating, adding, or removing)
Information affect the protocol throughout DFM. Therefore, you must ensure that changes
you make (for example, to a password) are valid. If the change is not valid, the
Data Flow Probe will fail to connect at the next attempt.

¢ Any updates you make here can be viewed in the Data Flow Probe Setup
window. For details, see "Data Flow Probe Setup Window - Details Pane" on
page 40.

o This page is displayed if the adapter writer has defined that credentials are
needed to access the discovered component.

See Also For details on using the buttons and shortcut menus, see "Domains and Probes
Pane" on page 47.

For details on the protocols, see the HP Universal CMDB Discovery and
Integration Content Guide.

Wizard The Topology CI Creation wizard contains:

Ma
P "Topology Preview" > "Define Cl: <Cl name>" > "Define Credentials" >

"Topology Creation" > "Summary"

Topology Creation

Enables you to read through the topology details (the Cls and relationships that are to be created)
and make changes if required.

Important Review the topology. To make changes, click the Back button.
Information

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define Cl: <Cl name>" > "Define Credentials" >
"Topology Creation" > "Summary"
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Summary

Displays the result of the topology creation.

Important
Information

o If DFM displays a success message, click Finish.

Note: For Population integration points, if at least one query ends with a
warning and no errors are encountered, a Success with warnings message is
displayed.

¢ AClinthe topology you create may be ignored by the reconciliation process if
it matches an existing Cl. If the SOURCE CI in the topology is ignored, the
topology creation process fails. If another Cl is ignored (any other node in the
query), creation succeeds. This is because the SOURCE Cl is needed by the
query to create the Trigger Cl. If it is ignored, the trigger cannot be identified
and used for the integration. For details on the reconciliation process, see
"Reconciliation Services" on page 254.

o If DFM cannot create the topology, an error message is displayed. Click the
link to review the error details in the ui-server.log file, located in the following
folder: C:\hp\UCMDB\UCMDBServer\runtime\log\.

Then, click Back to fix the error and run the wizard again.

Wizard
Map

The Topology CI Creation wizard contains:

"Topology Preview" > "Define Cl: <Cl name>" > "Define Credentials" >
"Topology Creation" > "Summary"

Limitations

This section describes certain limitations on the Integration Studio functionality.

This section includes the following topics:

o "Limitations on Population Integrations" below

o "Limitations on Federation Integrations" on next page

o "Limitations on Data Push Integrations" on next page

Limitations on Population Integrations

1. When configuring a population job between two CMDBs, verify that the synchronized CITs are
the same in the two CMDBs.

2. When modifying a TQL query that is used in a population job, it is recommended to run a
differential synchronization before modifying the TQL and a full synchronization after modifying
the TQL. The differential synchronization removes any data that is no longer necessary as a
result of the updated query, and the full synchronization creates new baseline data on the
target system.

3. Afterajob runs successfully, its status remains Succeeded even after the job definition is
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changed (for example, selecting another TQL query or enabling deletion) and saved.

Limitations on Federation Integrations

1. When avirtual link exists between two data repositories, HP Universal CMDB supports
mapping in the following cases only:

= The UCMDB integration point lies at one end of the link and multiple data repositories lie at
the other end. The Cartesian product is calculated for A’s data repository (UCMDB) and B’s
data repositories (UCMDB, d2, d3).

¥ UCMDB
UCMDB ° UCMDB : UCMDE

~3 JCMDE,
g | UCMDB

= The same data repositories lie at both ends of the link. The link is an internal link of each
data repository and no mapping is required.

""" d1, d2, d3
d1. d2. d3 %
{a1.a2d |
e ______ .-

2. When changes are made in the Modeling Studio and these changes affect the results of a TQL
query, federated Cls in the view are not updated. This is because federated TQL queries are
calculated ad-hoc only and are not updated when a view is recalculated. To update the
federated Cls, select the view in the Cl Selector and click the Refresh Cls Tree button. (Note
that the recalculation may take a long time.) For details, see "Browse Views Mode" in the HP
Universal CMDB Modeling Guide.

©20
v

3. You cannot edit the values of attributes that are configured to be retrieved from both an external
data repository and UCMDB during federation.

Limitations on Data Push Integrations

1. After modifying a TQL query that is used in a data push job, it is recommended torun a
differential synchronization before modifying the TQL and a full synchronization after modifying
the TQL. The differential synchronization removes any data that is no longer necessary as a
result of the updated query, and the full synchronization creates new baseline data on the
target system.

2. The Universal CMDB cannot push static attributes.
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Integrating Multiple CMDBs Overview

Multiple CMDBs is a solution that allows setting up a multiple number of CMDBs for delegating the
workload and responsibility of the solution to the different CMDBs.

Note: Synchronization between multiple CMDBs of different versions can be performed only
between UCMDB versions 9.02 or later.

Configuration Management System (CMS)

The CMS is the central CMDB server and is the authority for configuration management in the
multiple CMDBs solution. It is responsible for integrating between the different CMDB server
instances and other services in the solution, as well as for generating global IDs. Most of the
integrations are defined in the CMS, and other CMDBs or services only access the CMS to access
the data from these CMDBs or services.

The CMS allows integration with other services using:
o Population
o Federation

e DataPush
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o Data Flow Management Web Service API

e Soap Web Service

Global ID

The global ID is a unique CI ID (generated by the CMS or another CMDB that has been designated
as a global ID generator for that Cl type), that identifies that Cl across the entire portfolio, making it
easier to work in multiple CMDB environments.

The class model contains the global_id_scope attribute, which is used to specify the scope to
which a particular Cl type belongs.

In the JMX console, you can specify the scopes for which global IDs will be generated. For details,
see "How to Configure Global ID Generation" on page 176.

Use Cases — Multiple CMDB Deployments:
Discovery-CMS Solution

The Discovery-CMS solution enables the division of the workload and Discovery capacity over
more than one CMDB.

e Discovery 1 CMDB

e Discovery 2CMDB

e The central CMDB acting as the CMS

Both Discovery CMDBs are responsible for running different discovery jobs in the domain, and
containing all the discovered topology. The CMS populates the node, interface, and IP from both
Discovery CMDBs, and federates the node resource Cls (CPU, file system, and printer) from
Discovery 1 CMDB. The CMS federates the node resource Cls (OS user, process, and printer)
from Discovery 2 CMDB. When a user runs a view that requests these resources on the CMS, they
are brought seamlessly using federation.

Multiple Deployments with Version 9.x/10.x CMDBs

This section includes:

o "Population from UCMDB 9.x/10.x (CMS Synchronization)" below
o "Query Support" on next page

e "Global ID Synchronization" on next page

« "Automatic Completion of Reconciliation Data" on page 174

Population from UCMDB 9.x/10.x (CMS Synchronization)

When you use the UCMDB 9.x or UCMDB 10.x adapter to create an integration point, you are able
to synchronize data between different CMDB instances using population. For details on population,
see "How to Work with Population Jobs" on page 133.

During population, global IDs are synchronized. For details, see "Global ID Synchronization" on
next page below.
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Query Support

Two types of queries are supported for population jobs:

o Live queries—all non-federated TQL queries, when they are used for population with the UCMDB
9.x/10.x adapter.

Live queries require less bandwidth, and cause less load on the source system. There may be a
short delay from the time the change is made until the live query mechanism or the population
job receives the change (this may take up to several minutes).

Subgraphs and compound relationships are supported in queries. When using compound
relationships, you must select Show full path between source and target Cls in the
Compound Relationship properties of the query.

o Federated queries—queries that contain at least one federated node or attribute.
When the UCMDB 9.x/10.x adapter is used, federated queries may also be used for population.

Federated queries are calculated each time the integration is performed; the entire result set is
retrieved and filtered by the Probe.

The deletion of Cls is not supported. The aging mechanism must be used, since no information
about the deletion of Cls or links is populated. For details, see "Cl Lifecycle and the Aging
Mechanism" in the HP Universal CMDB Administration Guide.

You can create TQL queries for integration. For details, see "Topology Query Language" in the
HP Universal CMDB Modeling Guide.

Global ID Synchronization
The following examples describe two types of synchronization that can be performed:
e Two-way ID synchronization

Synchronization of data occurs in both directions between two UCMDB instances.

The CMS uses the population flow to retrieve data from UCMDB-B, which may be any UCMDB.
UCMDB-B uses the population flow to populate data from the CMS.

Because synchronization is performed in two directions, global IDs are also updated on
UCMDB-B.
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Data Flo
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e Pushback of IDs

The CMS uses the population flow to retrieve data from UCMDB-B. Cls are reconciled with the
data inthe CMS.

The global-ID in the CMS for each Cl received is pushed back to UCMDB-B.
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The default state of this option is disabled.

For details about enabling the pushback of IDs, see "How to Set Up Integrations Between

Multiple CMDBs " on page 177.

Automatic Completion of Reconciliation Data

The UCMDB 9.x/10.x adapter automatically retrieves data needed for the reconciliation process of
the Cls brought by the population flow. The actual data retrieved is determined by the reconciliation

rule defined for the CITs of the TQL query.

For example, if your population TQL query includes a node but does not have any layout selected,

the actual data that enters the CMDB is:
o Nodes, with layout

= name

= bios_uuid

= serial_number

= additional data, according to the defined reconciliation rule

o |P Addresses, with layout
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= name
= routing_domain

o Interfaces, with layout
= mac_address

= interface_name

Note:

= The automatic completion feature may actually synchronize many more Cls or links than
you intend.

= The automatic completion feature always retrieves the Global ID.

= By default, if data required for the reconciliation of a particular Cl cannot be retrieved (for
example, if the data is missing in the source), that Cl is ignored without causing the entire
job to fail. You can change this behavior in the CmdbAdapter configuration. For details, see
"Adapter Configuration Tab" on page 96.

Federation in Version 9.x/10.x CMDBs

Federation allows the CMDB to retrieve data in real time (on-the-fly) from any remote data
repository, and combine it with CMDB's internal data to show a complete picture of the
configuration it manages, including multiple sources. For more information about federation, see
"How to Work with Federated Data" on page 133.

Using the UCMDB 9.x/10.x adapter to federate data from different CMDBs, enables the federation
of any CIT in the model. This means that only a small portion of data from the remote CMDBs can
be populated, and the rest of the data is federated on demand. This ability enables the delegation of
the information to multiple CMDBs, with the CMS always showing the most updated data available
and at the same time not overloading its capacity.

A CMS populates the Node, Interface, and IP from a Discovery CMDB (a CMDB whose role is to
run Discovery), and defines the CPU, File System, OS, User, Printer, and Process Cls as
federated from the same source. When a user runs a TQL query or view that has any federated
CITs, these specific Cls are brought in real time from the Discovery CMDB. They are therefore as
updated as the Discovery CMDB and do not depend on the population schedule to receive updated
information. In addition, these Cls only reside on the Discovery CMDB, and do not burden the
capacity of the CMS.

The CMDB 9.x/10.x adapter supports the delegation of the federation capabilities, providing the
ability to set up a single point for data retrieval (usually the CMS). Any CMDB or service that uses
the CMDB's ability to delegate federation uses the CMDB as a virtual black box, and is unaware of
whether data comes directly from the CMS or from an external integration.

Note: When you set up a federation flow, be careful not to cause an endless loop. For
example, do not set up CMDB-X to federate data from CMDB-Y, and at the same time CMDB-
Y to federate data from CMDB-X.
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How to Perform Initial Synchronization

This procedure performs a full synchronization of Cls and relations between CMDBs, while
retaining the original CMDB IDs. Cls are replicated from the external CMS to the UCMDB. The
procedure is generally intended to be performed only once, on a new system.

1. Launch a Web browser that connects to the CMS, and enter the following address:
http://[<CMS server>:8080/jmx-console.

2. Click UCMDB:service=Multiple CMDB Instances Services to open the JMX MBEAN View
page.

3. Click the fetchAllDataFromAnotherCMDB method.

4. Enter values as required for the following fields:
Note: You must enter information in fields that do not have default values.

= CustomerID

= Remote user name

= Remote password

= Remote host name

= Remote port 8080

= Remote Customer name (default value is Default Client)

= Maximum chunk size

» Cl type to sync (default value is managed_object, causing all Cl types to be synchronized)

= Relation type to sync (the default value is managed_relationship, causing all relation
types to be synchronized)

5. Click Invoke.

How to Configure Global ID Generation
1. Launch the Web browser and enter the following address:
http://<CMS server>:8080/jmx-console.

2. Click UCMDB:service=Multiple CMDB Instances Services to open the JMX MBEAN View
page.

3. Click one of the following methods and enter values as required:

= setAsGloballdGenerator - specifies that the CMDB will act as the global ID generator for
all locally existing scopes.

= setAsGloballdGeneratorForScopes - specifies the scopes for which global IDs will be
generated.
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4.

= setAsNonGloballdGenerator - stops the CMDB from acting as the global ID generator for
all scopes.

Click Invoke.

Note: If you want to check which scopes are currently set, use the
getGloballdGeneratorScopes method.

How to Use SSL with the UCMDB 9.x/10.x Adapter

If the remote UCMDB server uses a certificate signed by a known certificate authority, selecting
the HTTPS (SSL) value in the Protocol field is sufficient.

If not, add the remote UCMDB server certificate to the local UCMDB JVM Trusted Stores as
follows:

1.

6.
7.

Export the remote UCMDB self-signed certificate by executing the following command (on the
remote server machine):

c:\hp\UCMDB\UCMDBServer\bin\jre\bin\keytool.exe -exportcert -
keystore c:\hp\UCMDB\UCMDBServer\confl\security\server.keystore -
alias hpcert -storepass hppass -file remoteServer.cert

Copy the certificate to UCMDB at C:\hp\UCMDB\UCMDBServer\bin\jre\bin and to the Data
Flow Probe at C:\hp\UCMDB\DataFlowProbe\bin\jre\bin.

Locate the JRE security folder, by default located
inC:\hp\UCMDB\UCMDBServer\bin\jre\lib\security\ and also at
C:\hp\UCMDB\DataFlowProbe\bin\jre\lib\security\.

Back up the cacerts file by copying it to another folder.

Open a command line window and execute the following commands on the local UCMDB and
Data Flow Probe (to import the previously created or copied certificate):

cd C:\hp\UCMDB\<UCMDBServer/DataFlowProbe>\bin\jre\bin
keytool.exe -import -storepass changeit -keystore
c:\hp\UCMDB\<UCMDBServer/DataFlowProbe>\bin\jre\lib\security\
cacerts -trustcacerts -file

C:\hp\UCMDB
\<UCMDBServer/DataFlowProbe>\bin\jre\bin\remoteServer.cert

At the command line prompt "Trust this certificate?", enter 'yes'.

Restart the UCMDB service and the Data Flow Probe service.

How to Set Up Integrations Between Multiple
CMDBs

The following steps describe how to create integration points and jobs to integrate between multiple
CMDBs
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1.

"Define an integration point" below
"Define a population job" on next page

"Run the population job " on page 180

Define an integration point

"Select Cl types and attributes to be federated" on page 180

a. Navigate to Data Flow Management > Integration Studio.

b. Click the New Integration Point |_| button to open the New Integration Point Dialog

Box. For details, see "New Integration Point/Edit Integration Point Dialog Box" on page

159.

Enter the following information:

Recommended

Name (A-Z) Value Description

Adapter UCMDB 9.x or | The adapter that is used to integrate between multiple
UCMDB 10.x CMDBs.

Additional <user defined> | Additional probes over which to run a federation-type

Probe Name

integration. Click [....] to select the additional probes.
When the integration runs, if additional Data Flow
Probes are defined, the server uses the most
available Probe.

Credentials

Remote
UCMDB

If you must create a new credential protocol, use the
Generic Protocol as a basis. For details, see HP
Universal CMDB Discovery and Integration Content
Guide.

Customer
Name

<user defined>

The name of the remote UCMDB from which you
want to retrieve data.

Default
Owner Name

<user defined>

The name of the owner tenant that should be assigned
to the federated or populated Cls and relationships.

Note:

o This field is displayed when creating a federation or
population type integration point in a multi-tenancy
environment only.

o If no owner tenant is specified, or if the data source
is not a multi-tenancy environment, the system
owner tenant is assigned by default.

Hostname/IP

<user defined>

The name or IP address of the remote CMDB
machine.
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Recommended
Name (A-Z) Value Description
Integration <user defined> | Free text that describes the integration point.
Description
Integration <user defined> | The name you give to the integration point.
Name
Is selected Select this check box to create an active integration
Integration point.
Activated
Port 8080 The port listened to by the HP UCMDB API.
Probe Name | <userdefined> | The name of the probe on which the population jobs
are run. If this field is left empty, UCMDB uses
IP ranges to attempt to select the correct Probe.
Protocol HTTP Selects the protocol to be used for connecting to the
remote CMDB. Valid values are:
o HTTP
o HTTPS (SSL)
Push Back <user defined> | Specifies whether to push back the global IDs after
Ids Cls are populated into UCMDB.
State <user defined> | The state with which you want to connect when
integrating with multi-state CMDBs.
o Actual
o Authorized
o Leave this field empty for a single-state UCMDB
(default).
Web <user defined> | The root context value of the remote CMDB. If no root
application context is defined on the remote CMDB, leave this
Root field empty.
Context

c. Click Save ||

d. Click Test Connection to ensure that the integration point has been successfully created,
and then click OK.

2. Define a population job

An out-of-the-box integration point already contains population jobs. This step is relevant only
when creating additional population jobs.
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Select the Population tab to define a population job that uses the integration point you defined
above. For details, see "New Integration Job/Edit Integration Job Dialog Box" on page 156.
Note:

= When integrating between multiple CMDBs, population queries must be set up for the
source CMDB.

= Select the Allow Delete check box if you want your population job to allow deletion of
Cls and links from the source CMDB.

= By default, infrastructure Cls and containment relationships are deleted. All other Cls
and relationships are retained.

3. Run the population job

Click the Run Changes Sync > button to make sure that the integration has been
successfully configured.

4. Select Cl types and attributes to be federated
a. Navigate to Data Flow Management > Integration Studio.
b. Click the Federation tab.
c. Select the Cl types you want to federate from the source CMDB.

If desired, you can select only attributes to be federated. For details, see "Federation Tab"
on page 146.

d. Click Save Integration J.

Multiple CMDB Integration Troubleshooting and
Limitations

Troubleshooting

When performing troubleshooting, be sure to check both CMDB server and Probe logs.

o CMDB serverlogs

fcmdb.log

fcmdb.adapters.log

error.log

= cmdb.reonciliation.log (for population jobs)
o Probelogs

= wrapperProbeGw.log

= fcmdb.log
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= fcmdb.adapters.log

= probe-infra.log

Following are some problems that you may encounter and their solutions.

Problem. TQL query not active/persistent error message.

The Query settings have been changed manually.

Solution. Run full population to reactivate/persist the query.

Problem. The number of Cls that is populated is much larger than the requested amount.

Solution. Since the automatic completion feature for reconciliation is turned on by default, it
may populate the CMDB with additional Cls or links, in order to contain sufficient information to
insert the Cls into the CMDB.

Problem. Changes are not populated immediately after a job is run.

Changes may take a few minutes to be detected by the live mechanism.

Solution. Wait a few minutes for changes to be populated by your next population job.
Problem. Cls are not populated into the CMDB.

Changes may take a few minutes to be detected by the live mechanism.

Solution. Wait a few minutes for changes to be populated by your next population job.
Check the CMDB reconciliation logs for more information.

Problem. Deletions are not populated.

Solution:

= Make sure that you have selected the Allow Delete check box in the population job
properties.

= Check the query you are running. Deletes are not supported on federated queries, and the
aging mechanism must be used.

Problem. Queries that contain compound relationships fail.

Solution. Select Show full path between source and target Cls in the query's Compound
Relationship properties.

Problem. Authentication fails.

Solution. Since the UCMDB 9.x /10.x adapter uses the UCMDB API for connection, set up an
integration user to ensure that you provide proper credentials. For details, see Create an
Integration User in the HP Universal CMDB Developer Reference Guide.

Problem. TQL query not active/persistent error message.
The Query settings have been changed manually.
Solution. Run full population to reactivate/persist the query.

Problem. The number of Cls that is populated is much larger than the requested amount.
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Solution. Since the automatic completion feature for reconciliation is turned on by default, it
may populate the CMDB with additional Cls or links, in order to contain sufficient information to
insert the Cls into the CMDB.

o Problem. Changes are not populated immediately after a job is run.
Changes may take a few minutes to be detected by the live mechanism.
Solution. Wait a few minutes for changes to be populated by your next population job.
e Problem. Cls are not populated into the CMDB.
Changes may take a few minutes to be detected by the live mechanism.
Solution. Wait a few minutes for changes to be populated by your next population job.
Check the CMDB reconciliation logs for more information.
o Problem. Deletions are not populated.
Solution:

= Make sure that you have selected the Allow Delete check box in the population job
properties.

= Check the query you are running. Deletes are not supported on federated queries, and the
aging mechanism must be used.

o Problem. Queries that contain compound relationships fail.

Solution. Select Show full path between source and target Cls in the query's Compound
Relationship properties.

o Problem. Authentication fails.

Solution. Since the UCMDB 9.x /10.x adapter uses the UCMDB API for connection, set up an
integration user to ensure that you provide proper credentials. For details, see Create an
Integration User in the HP Universal CMDB Developer Reference Guide.

Limitations

o Ifthe TQL query for a population job (defined on the source) includes Cl types or links that do not
exist on the target, or links that are not valid, those types or links are ignored in the target data
repository.

o Since the UCMDB 9.x/10.x adapter works with the "changes" population engine, if a population
flow retrieves federated data, no removals are made in the CMDB, since the federation brings
only added or updated data.
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Universal Discovery Overview

Universal Discovery enables you to activate discovery of components that make up your system.
You can discover Zones in your environment by running discovery activities is those Zones.
Alternatively, you can set up and run individual discovery jobs on any Node in your environment:

Zone-Based Discovery
Zone-based discovery enables you to:
« Limit the scope of a discovery activity to a sub-set (zone) of the entire network

« Run multiple instances of the same discovery activity on different zones in the network
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« Configure each discovery activity instance with different settings (parameters, scheduling)
o Diagnose discovery problems (using the Discovery Troubleshooter)
Definitions

« Management Zone. A Management Zone is a region in the network defined by a collection of IP
ranges. A region of an organization’s infrastructure should be defined as a Management-Zone
when you want to discover all the managed objects of the region using the same scheduling
policy and parameters.

« Discovery Activity. You configure a Discovery activities to perform discovery inside a specific
Management Zone. The activities discover infrastructure (IPs, nodes), basic software (shallow
running software including application servers, databases, and web servers), deep database
configuration, and inventory ( for example, CPUs, installed software, logical volumes), among
other information. A Discovery activity includes:

= Discovery parameters that are specific to the type of the Discovery activity
= A scheduling policy

For more information on Discovery activities and instructions on how to activate them, see the
HP Universal CMDB Discovery and Integration Content Guide.

Example: How to Define Management Zones

Organization-X has two data-centers: DC-A and DC-B. Each data center is owned/managed by a
different administration group: Admin-Group-A and Admin-Group-B. Each administration group
would like to run its own “instance” of a Discovery activity within its data center. On DC-A, you
want to discover all machines operating on Windows once every week using the same discovery
parameters. Therefore, DC-A should be defined as a Management Zone. On DC-B, you want to
discover all the J2EE servers once every day using the same discovery parameters. DC-B should
also be defined as a Management Zone.

For details on the Zone-Based Discovery tab, see "Zone-Based Discovery Tab" on page 246.

For details on creating a Management Zone, see "New/Edit Management Zone Dialog Box" on page
236.

For details on the Discovery Troubleshooter, see "Discovery Troubleshooter" on page 187.

Discovery Modules/Jobs-Based Discovery

Enables you to customize discovery by making changes to an out-of-the-box discovery job or
building your own discovery jobs.

For details, see "Module/Job-Based Discovery Workflow" on page 190.

For details about the jobs and how they are organized in modules, see the HP Universal CMDB
Discovery and Integration Content Guide.

Agent-Based vs Agentless Discovery

Agent-Based Discovery

To collect inventory information, you can deploy Universal Discovery agents on client or server
machines. The UD agent provides a secured communication channel between the Data Flow Probe
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and the Nodes being discovered. After setting up the secure communication channel, Universal
Discovery deploys and activates scanners onto the Nodes being discovered. The Scanners scan
the Nodes for inventory information and store the scanned results in scan files which are
downloaded to the Data Flow Probe through the secured communication channel established with
the UD agent.

When the UD agent is installed, collection of software utilization information is enabled. The

UD Agent also enables you to benefit from the Call Home feature. Call Home is useful in the case
where a Node was unavailable for scanning for a long period. It enables the UD agent to notify the
Data Flow Probe that the Node is currently available for scanning.

Agentless Discovery

Although agentless discovery does not require the installation of dedicated agents on the servers
that are to be discovered, it does depend on native OS or standard agents that are already installed
such as SNMP, WMI, TELNET, SSH, NETBIOS, and others. Other discovery capabilities are
based on application-specific protocols such as SQL, JMX, SAP, Siebel, and so on. For details on
supported protocols, see the HP Universal CMDB Discovery and Integration Content Guide.

Inventory Discovery

Universal Discovery determines which devices are in your network and gathers basic information
about each of them. This process allows you to get a good overview of the number and types of
devices in your network, as well as a basic set of attributes for each. It also serves as the
foundation for the other modules of discovery.

Discovery can be based on Management Zones. Universal Discovery can use a variety of methods
to discover devices, and provides out-of-the-box discovery activity wizards that allow you to
choose the appropriate settings for your different Management Zones. For example, UNIX servers
in the Data Center may have different requirements for discovery than laptops in the Finance group.

After discovering a device, Universal Discovery runs a Scanner on the device to gather detailed
hardware, configuration and software license information. This process is referred to as Inventory
Discovery and makes it possible to drive standardization and compliance initiatives, manage risk,
implement chargeback policies, and so on.

The Scanners can be launched automatically according to a configurable schedule, allowing
complete control over network bandwidth usage and any impact on the end-user.

To automatically manage the Scanners, the Universal Discovery (UD) Agent needs to be in place.
This is a small component deployed on the discovered device that enables secure communication
with the Data Flow Probe. The UD Agent can be automatically deployed to Windows machines in
your network, and must be manually deployed to UNIX machines. Once this is done, Universal
Discovery can automatically upgrade the Scanners and agents when necessary.

Universal Discovery includes Agents and Scanners for most common desktop and server operating
systems.

The Scanner can also be installed manually. This is known as agentless inventory discovery.

Universal Discovery can also gather information about what software is used on the machines on
your network. This is referred to as Software Utilization and the information collected is necessary
to optimize software license cost, for example by eliminating unused or under-utilized software
installations.
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For details on setting up the Inventory discovery and other activities, see the HP Universal CMDB
Discovery and Integration Content Guide.

Just-In-Time Discovery

Universal Discovery integrates with RUM to provide real time, passive discovery and monitoring of
topology changes in a given environment. This is known as the Just-In-Time (JIT) discovery
mechanism.

One or more RUM Engines can be configured to interact with Universal Discovery's Data Flow
Probes. The RUM Engine gathers information from RUM Probes in its network, and passes
relevant information on to the Data Flow Probes. From the Universal Discovery perspective, the
RUM Engines behave as passive discovery probes, where the Data Flow Probes are the active
probes.

The passive probes also send notifications about discovered information to the Data Flow Probes.
Notifications can include, for example, changes in environment topology, such as an unseen IP
address, or software that is not running. You configure these notifications in Universal Discovery.
Based on these notifications, the Data Flow Probes report, add, or remove relevant Cls to or from
the UCMDB Server, or designate them as candidates for deletion.

For details about setting up the passive discovery probes and running JIT Discovery, see "How to
Configure Just-In-Time Discovery" on page 193.

Discovery Troubleshooter

It is possible that after running discovery, you will not find a particular Cl in the discovery results.
There are various types of errors that can occur that would cause this to happen. The Discovery
Troubleshooter allows you to search for the missing Cl, and even if you are unable to locate the
missing Cl, the Discovery Troubleshooter also detects and lists errors that occurred during the
discovery process. By attempting to solve these errors, this can lead you to the missing CI.

Currently the Discovery Troubleshooter allows you to locate missing Running Software Cls. When
invoking the Discovery Troubleshooter, you are requested to enter the IP of the target host you are
looking for and choose a detection method before searching for the missing running software CI. If
the Discovery Troubleshooter does not initially succeed in connecting to the target host, it allows
you to rerun discovery with a different detection method. If the Discovery Troubleshooter does
succeed in connecting to the target host, it lists all the running software currently connected to the
detected Node ClI. If the Cl you are looking for is not in the list, the Discovery Troubleshooter lets
you update available application signatures, which may provide a more extensive list of all running
software connected to the detected Node Cl and enable you to find the missing ClI.

Note: The Discovery Troubleshooter can be run on a Management Zone only after the
Infrastructure and Basic Software Configuration discovery activities have been run on that
Management Zone.

See also: "Discovery Troubleshooter Wizard" on page 229
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Viewing Permissions While Running Jobs

During a job run, you often need to know which credentials are being used to connect to a
component in the system. You also often need to know the effect of a run on network performance,
for example, whether the job should be run at night instead of during the day. View Permissions
enables you to view the objects and parameters of a job's Jython script commands, as can be seen
in the following image:

Permission Operation Usage Description Objects and Parameters
shellprotocol exec Basic login uname
ver
shellprotocol BXEC CPU Info AL I=attr | grep "proc”

ALK priconf | grep "proc”

FreeB5D: dmesg | grep "cpul|Multiprocessor"

FreeBSD: dmesg | grep -4 1 "CPL"

FreeB5D: sysctl hw.model hw.ncpu hw.clockrate

HPL: model

Linux: cat fprocicpuinto

SunQ S jusrishinipsrinfo v

SuniOS: priconf

Windows: reg query HKEY_LOCAL_MACHINE\HARDWARE\DESCRIP...

Note: The information you define here is not dynamic, that is, if an adapter is changed, the
information in this dialog box is not updated.

For details, see "Discovery Permissions Window" on page 226.

Example of Using the Discovery Permissions Window:

You are running the Host Connection by Shell job to discover a host running on a UNIX
system. An error message in the Discovery Status pane shows that DFM could not access a
host through SSH because permission was denied. You display the Discovery Permissions
window and see that the command to access the host requires a user with a certain level of
permissions. You check the SSH Protocol window and discover that the user defined there
does not have that level of permissions.

To resolve the problem, change the user in the SSH protocol or update the permissions for the
existing user in the external system.

Managing Problems With Error Reporting

During discovery, many errors may be uncovered, for example, connection failures, hardware
problems, exceptions, time-outs, and so on. You can drill down from the Trigger Cl that caused the
problem to view the error message itself.

DFM differentiates between errors that can be ignored (for example, an unreachable host) and
errors that must be dealt with (for example, credential problems or missing configuration or DLL
files). Moreover, DFM reports errors once, even if the same error occurs on successive runs, and
reports an error even if it occurs once only.

For details on severity levels, see "Error Severity Levels" in the HP Universal CMDB Developer
Reference Guide.
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Error Table in Database

All DFM errors are saved to the discovery_problems table in the Probe Manager database
schema. (The error information is saved to the database—and is not handled in the Probe's
memory—to guarantee delivery to the server.) The Probe holds the latest list of problems for each
Trigger Cl. After each run, the Probe checks for changes and reports them in the Discovery Status
pane. For details, see "Discovery Module/Jobs - Details Tab" on page 214.

Permissions Document

You can view a list of DFM jobs together with the protocols and permissions needed to access the
job components. For example, you can view information about what is needed to execute a basic

login when running the Host Resources by Shell job.

To view the list, access this file: http://[<UCMDB Server>:8080/ucmdb-

ui/docs/permissions.jsp.

The list is organized by module and consists of the following information:

e Module
e JOb

e Protocol

o Operation, usage description, objects and parameters

Example of Permissions Document Contents

Database - Oracle. The module name.

Oracle RAC Topology by Shell. The job name.

Discovers Oracle RAC Topology by Shell. The job description. This section is omitted if

no description is defined in the application.

Protocol: Shell. The protocol name: SQL, Shell, WMI, SNMP, and so on. For a full list of
supported protocols, see the HP Universal CMDB Discovery and Integration Content Guide.

Operation Usage Description

Objects and Parameters

file read Parsing of listener and tnsnames
configuration files

cat SORACLE_
HOME\network\listener.ora

cat SORACLE_
HOME\network\admin\
tnsnames.ora

Zone-Based Discovery Workflow

This workflow describes how to run discovery over a Management Zone.

This workflow includes the following steps:
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o "Prerequisites" below

o "Create a Management Zone" below

o "Set up and run Discovery activities" below

¢ "Runthe Discovery Troubleshooter - Optional" below

1. Prerequisites
Verify that the Data Flow Probe is installed.

2. Create a Management Zone
a. InData Flow Management, go to Discovery Control Panel > Zone-Based Discovery
tab, and click the New|:| button .
b. Inthe New Management Zone dialog box that opens:
o Entera name for the Management Zone. This field is mandatory.

o Select a method for defining IP ranges for the Management Zone. You can use full Data
Flow Probe ranges or define partial IP ranges for the Management Zone. By default,
Use full probe ranges is selected. For more information on the differences between
these two options and on the user interface, see "New/Edit Management Zone Dialog
Box" on page 236.

3. Set up and run Discovery activities

a. Inthe list of Management Zones in the Zone-Based Discovery tab, select the zone in
which you want to create and run the discovery activity.

b. Right-click the zone and select New Discovery Activity.
c. Select the type of discovery activity that you want to set up and run.

d. Continue with the wizard for setting up and running the discovery activity. For more
information about setting up and running discovery activities, see HP Universal CMDB
Discovery and Integration Content Guide.

4. Run the Discovery Troubleshooter - Optional

If you do not find a particular Cl in the discovery results, run the Discovery Troubleshooter to
search for the missing Cl. For more information about running the Discovery Troubleshooter,
see "Discovery Troubleshooter Wizard" on page 229

Note: The Discovery Troubleshooter can be run in a Management Zone only after the
Infrastructure and Basic Software Configuration Discovery Activities have run in that
zone.

Module/Job-Based Discovery Workflow

This task describes how to begin mapping your system and its components. You would use this
workflow to customize the components of a module.

Note: For details about running Zone-based discovery, see "Zone-Based Discovery Workflow"
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on previous page.

This task includes the following steps:

o "Prerequisites" below

o "Determine the network range" below

¢ "Set the relevant credentials" below

o "Activate the relevant jobs" below

« "Make changes to relevant adapters" on next page
o "Monitor the discovery process" on next page

o "View Result Statistics" on page 193

o "Troubleshoot the Results" on page 193

1. Prerequisites

a. Verify that the Data Flow Probe is installed on a Windows machine.

Note: The Data Flow Probe installed on a Linux platform is intended only for
integrations, and not for discovery

b. Verify that the relevant packages are deployed.

If you need to deploy discovery packages, see Deploy a Package in the HP Universal
CMDB Administration Guide.

2. Determine the network range

Define the range of the network to be discovered. For details, see "New/Edit IP Range Dialog
Box" on page 35.

Note: Adapters try to connect to every IP address in a range. Therefore, if a range is wide,
network performance may be affected.

3. Setthe relevant credentials

To enable the Data Flow Probes to connect to servers or applications using specific protocols,
you must set the relevant credentials (for example, UD, NTCMD, SNMP, TTY, or WMI). For
details on protocol parameters, see the HP Universal CMDB Discovery and Integration
Content Guide.

Note: The Data Flow Probe tries to connect to a node by using each credential in turn.
Universal Discovery then saves the successful credential. The next time the Data Flow
Probe connects to this node, it first tries to connect using the successful credential.

4. Activate the relevant jobs
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Once you have defined the network range and set credentials, you can run discovery on
specific jobs. For details on running specific jobs, see HP Universal CMDB Discovery and
Integration Content Guide.

Tip:

= You can view a full description of a selected job in the Properties tab > Description
pane.

= You can search for all jobs that discover a particular connection type.
For example, to search for all jobs that discover SNMP connections:
In the Discovery Control Panel > Discovery Modules/Jobs tab, click the Search

for Discovery Job Q button. In the Find Jobs dialog box, enter SNMP in the Name
box and click Find All. For details, see "Find Jobs Dialog Box" on page 235.

5. Make changes to relevant adapters

You can customize adapters to discover infrequent system components. For details on adapter
writing, see Adapter Development and Writing in the HP Universal CMDB Developer
Reference Guide.

Caution: Do not make changes to default adapters without consulting HP Software
Support.

6. Monitor the discovery process

For details on monitoring the Cls that are discovered by the run, see "Statistics Results Pane"
on page 220.

a. Define aquery

You create a query that retrieves information about Cls and CITs from the CMDB. For
details, see Define a TQL Query in the HP Universal CMDB Modeling Guide.

If necessary you can trigger queries to manually discover objects. For details, see "Trigger
Queries Pane" on page 240.

b. Build a view for each query

A view enables you to build a subset of the overall IT universe model, containing only those
Cls inthe CMDB that relate to a specific discovery. For details, see Pattern View Editorin
the HP Universal CMDB Modeling Guide.

Example — Creating a View to Display Discovered Cl Instances:
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To view the number of instances found by during discovery, select Modeling >
IT Universe Manager, and display the view you created, as seen in the following

illustration:

CI Selector [Browse Views || search cis
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7. View Result Statistics

You can display overall statistics for a job or you can filter the results by time range or by Data
Flow Probe. Each time you log in to UCMDB and access the Discovery Control Panel, the
statistical data is updated so that the data displayed is the latest for the selected module or job.

For details on working with the statistical data, see "Statistics Results Pane" on page 220.

You can also view discovered Cls from the Data Flow Probe Status Window. For details, see
"Data Flow Probe Status Window" on page 72.

8. Troubleshoot the Results

You can check discovery results to see which errors are being reported. For details, see the
"Discovery Status Pane" on page 216.

How to Configure Just-In-Time Discovery

This task describes how to set up Just-in-Time discovery to provide passive, real-time discovery
and monitoring of traffic in a given environment.

To learn more about Just-In-Time discovery, see "Just-In-Time Discovery" on page 187.

1. Prerequisites

HP Real User Monitor (HP RUM) version 9.20 or later must be installed on a separate server,
and must be running and configured to integrate with a Data Flow Probe.

Note: The HP RUM Installation can be downloaded from the HP Software Support Online
Portal (http://support.openview.hp.com/selfsolve/patches). Search for Application
Performance Management (BAC) > BAC Real User Monitor

To configure HP RUM to integrate with a Data Flow Probe:
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a.

C.
d.

e.

Universal Dy  Probe Management

InHP RUM, select Configuration > UD Probe Connection Settings.

[l Business Service Management - Real Us

Health - Tools = Help -
- |

BZM Connection Settings

Connectipf]  Transaction Management Configuration
T Connection Settings

WD Probe Advanced Settings
Port UD probe Connection Settings
Protocol System Info

Enter the host name of the Data Flow Probe to which the RUM Engine is to report, and port
through which it is to send data to the Data Flow Probe.

Select a connection protocol.
Leave Authentication, Proxy, and SSL settings empty.

Save your configuration.

2. Configure passive discovery probe notifications and removal
verification policy

a.

In Data Flow Management > Data Flow Probe Setup >, select the domain where the
passive discovery probe (RUM Engine) resides.

In the Domain and Probes pane, click Passive Discovery Probes.

In the Passive Discovery Probes Pane configure the passive probe notification options
and removal verification policy. For details see "Passive Discovery Probes Pane" on page
52.

Inthe Domains and Probes pane select the passive discovery probe that you want to
configure

Inthe Passive Discovery Probe details > Passive Discovery Integrated Ranges pane,
configure the IP ranges over which the passive discovery probe should perform discovery,
and the ports it should monitor. For details, see "Passive Discovery Probe Details Pane"
on page 49.

Ensure that the passive probe status is Connected, If it is suspended, click the Resume

Probe |E| button in the Domains and Probes pane toolbar.

3. Activate passive Just-in-Time discovery

a.

b.

Go to the Discovery Control Panel > Discovery Modules/Jobs tab.

Under Network Infrastructure > JIT Discovery select JIT Passive Discovery.

Click the Activate Selected Discovery Jobs |§| button. When the passive probes are
activated, they download configuration (ranges and notifications) and start to report
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notifications to the Data Flow Probe.

How to Manually Activate Modules/Jobs/Cls

You can manually activate modules/jobs/Cls in the Discovery Modules/Jobs tab.

To manually activate a module/job:

¢ Inthe Discovery Modules pane, select the module/job, and click Activate |Q|

To manually activate a Cl :

o Select the job with the Cl you want to activate manually.

o Disable the Data Flow Probes for the job: In the job's Properties tab >Trigger Queries pane,

select the query, and in the Probe Limit column, click the [L===] button and ensure that no Probes
are selected.

¢ Manually activate Cls: In the Details tab, in the Discovery Status pane, click the Add CI |i|
button and manually add Cls.

The job runs using only the redispatched Cls. For details, see "Discovery Modules Pane" on
page 222.

How to View Job Information on the Data Flow
Probe

This task describes how to invoke job information (for example, job threads and Trigger Cls) saved
to the Data Flow Probe's MySql database. You work with the JMX console.

This task includes the following steps:

1. Access the MBean operations

Use the following procedure to access the JMX console on the Data Flow Probe and to invoke
the JMX operations.

a. Launch the Web browser and enter the following address:
http://<machine name or IP address>.<domain_name>:1977/

where <machine name or IP address> is the machine on which the Data Flow Probe is
installed. You may have to log in with the user name and password.

b. Click the Local_<machine name or IP address> > type=Jobsinformation link.

2. Locate the operation to invoke

Inthe MBean View page, locate the operation. For details, see "Discovery Job Operation
Commands" on page 197 and "Job Operation Parameters" on page 203.

3. Run the operation

Click the button to run the operation. A message is displayed with the results of the operation
run.
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Reload The number of seconds between automatic reloads of the JMX interface.
0: The interface is never reloaded.

Click the Reload button to manually reload the current page (if more operations
have been added or removed).

Unregister | Do not touch (the view becomes inaccessible to the application that is running).

How to Manage Discovery Errors

This task describes how to investigate problems that arise during a discovery run.

Note: For details about severity levels and so on, see "Managing Problems With Error
Reporting" on page 188.

This task includes the following steps:

4.

"Prerequisites" below

"Run the discovery job" below

"Locate the problem CI" below

"Troubleshoot the problem" below
Prerequisites
Set up DFM. For details, see "Data Flow Management Setup" on page 22
Run the discovery job

You can view error messages for one job, one module, or all modules. For details on running a
job, see "Module/Job-Based Discovery Workflow" on page 190.

Locate the problem CI
Use the Discovery Status pane to drill down to the error messages. For details, see "Discovery
Status Pane" on page 216.

Example:

DFM displays the error message:

<= Progress message, Severity: Fatal==

Probe DefaultProbe is missing at least one of the discovery pattern's required protoceols for jolb:
DB2 Connection by SGL

Troubleshoot the problem

= For Fatal errors, you should contact HP Software Support.
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» Forothererrors, check the Cls. For example, a Trigger Cl that does not fall within the
Probe's range may show an error.

= For details on setting communication logs, see "Execution Options Pane" on page 96.
= For details on managing problems, see "Managing Problems With Error Reporting" on page
188.

How to Find Discovery Errors

This task describes how to investigate problems that arise during discovery.

Note: For details about severity levels and so on, see "Managing Problems With Error
Reporting" on page 188.
This task includes the following steps:
o "Prerequisites" below
o "Select the Module/Job" below
¢ "Locate the Problem CI" below
1. Prerequisites
Set up DFM. For details, see "Data Flow Management Setup" on page 22.
2. Select the Module/Job

You can view error messages for one job, one module, or all modules. For details on running a
job, see "Module/Job-Based Discovery Workflow" on page 190.

3. Locate the Problem CI

Use the Discovery Status pane to drill down to the error messages. For details, see "Discovery
Status Pane" on page 216.

Example of an error message:

<< Progress message, Severity: Fatal==

Probe DefaultProbe is missing at least one of the discovery pattern's reguired protocols for jok:
DE2 Connection by SGL

Discovery Job Operation Commands

For details on viewing job information, see "How to View Job Information on the Data Flow Probe"
on page 195.

activateJob

Enter the name of a job and click the button to activate the job immediately. This operation returns a
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message, for example, <job name> was triggered.

Note: The following message is displayed if the job has not been activated and there is no
information about the job in the Probe's database:

Job '<job name>' does not exist in the Jobs Execution table (job was not activated!).

activateJobOnDestination

Enter the name of a job and a Trigger Cl and click the button to activate the job immediately on a
specific Trigger Cl. This operation returns a message, for example, The operation returned with
the value: Job <job name> was triggered on destination <Cl name>.

Note: Both the JobID and triggerCl fields are mandatory.

start/stop

These operations start and stop the JobsInformation service. Do not use these operations;
instead, restart the Probe itself.

viewJobErrorsSummary

Enter the name of a job to return a list of error messages reported on this job, together with the error
severity, the last time that the error was reported, and the number of Trigger Cls that have the error.

For details on the job operation parameters, see "Job Operation Parameters" on page 203.

Click the entry in the Number of Trigger Cls column to view a list of one job's Trigger Cls with
errors in the viewJobTriggeredCIsWithErrorld page (see below).

viewJobExecHistory

Enter the name of a job to retrieve a history of job invocations. A message is displayed showing the
jobinvocations (the last invocation is shown first).

For details on the job operation parameters, see "Job Operation Parameters" on page 203.

For each invocation the number of Triggered Cls and the total running time is shown. The Execution
Details column shows at which times the job was executed. If the Probe shut down in the middle of
a job execution and then resumed running or if there were blackout periods during the job execution,
several time ranges are shown.

viewJobProblems

Enter the name of a job or the name of a Trigger CI to retrieve a list of Trigger Cls that have
problems.

Note: You must fill in at least one of the fields.

For details on the job operation parameters, see "Job Operation Parameters" on page 203.
viewJobResultCilnstances
Fill in one or more of the parameters to return a list of Cls that have been discovered by a job.

For details on the job operation parameters, see "Job Operation Parameters" on page 203.
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The Object State Holder column displays the code for the Cl or relationship defined in the CMDB.
For details on creating object state holders for common CITs, see modeling.py in "Jython Libraries
and Utilities" in the HP Universal CMDB Developer Reference Guide. For details on the
appilog.common.system.typesClass ObjectStateHolder method, see the ObjectStateHolder
method in the online API documentation.

viewJobResults

Fill in one or more of the parameters to return a list of Cls that have been discovered by a job.
For details on the job operation parameters, see "Job Operation Parameters" on page 203.

When Hide Touched Cls Info is set to True, the results page displays the following information:

Column Description

Job Name Displayed if the jobID field is left empty.
The job name as it appears in Data Flow Management.
Click ajob to go toits viewJobStatus page, to view its status and scheduling
information.

Cl Type Click tofilter the list to show results for one CIT only.

Total Cls Click to go to the viewJobResultCilnstances page, to view a list of all Cls that
have been discovered by a job.

Triggered Click to go to the viewJobTriggeredCls page, to view a list of all Trigger Cls that

Cls have been discovered by a job.

Last The date and time that the job was invoked.

Discover

Time

When Hide Touched Cls Info is set to False, the results page displays the following information:

Column Description

Job Name Displayed if the jobID field is left empty.
The job name as it appears in Data Flow Management.
Click ajob to go to its viewJobStatus page, to view its status and scheduling
information.

Cl Type Click tofilter the list to show results for one CIT only.

Touched ClIs | Click to go to the viewJobResultCilnstances page, to view a list of those Cls

discovered by the job that are Touched Cls. For details, see "Job Operation
Parameters" on page 203.

Non Touched
Cls

Click to go to the viewJobResultCilnstances page, to view a list of those Cls
discovered by the job that are not Touched Cls.
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Column Description

Triggered Cls | Click to go to the viewJobTriggeredCls page, to view a list of those Trigger Cls

for Touched included in a job that are Touched Cls.

Cls

Triggered Cls | Click to go to the viewJobTriggeredCls page, to view a list of those Trigger Cls
for Non included in the job that are not Touched Cls.

Touched Cls

Last Discover | The date and time that the job was invoked.
Time

You can further filter results in the results page by entering text filters in one of the fields, and
clicking the Search button.

viewJobsStatuses

Click the viewJobsStatuses button to return status and scheduling information for all jobs. You can
choose to filter the results. For details, see "Job Operation Parameters" on page 203.

Note: This page is saved under \DataFlowProbe\runtime\jobsStatuses once a day.

The results page displays the following information:

Column Description

No. The number of the job in the list.

Job Name | Thejob name as it appears in Data Flow Management.

Click ajob to go toits viewJobStatus page, to view its status and scheduling
information.

Status The severity of the job's status, as calculated by the Probe.
o Blocked. Not inuse.

¢ Removed. The job is no longer active.

¢ Running. The jobis currently running.

¢ Scheduled. The job is scheduled to run. For details on scheduling jobs, see
"Discovery Scheduler Dialog Box" on page 227.

A red background signifies that a thread has run longer than expected and may be
stuck. A green background signifies that the job is running as expected.

Errors The number of errors for a specific job. Click to go to the viewJobErrorsSummary
page, to view a list of error messages reported on this job.

Triggered The Trigger Cls that have been run by the job. Click to go to the
Cls viewJobTriggeredCls page.

Last The date and time that the job was last run.
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Column Description

Invocation

Next The date and time that the job is next scheduled to run.

Invocation

Last Total | The total time that it took for the job to run in the last invocation. Compare this

run result with the average time taken for a job to run. The discrepancy is probably due

duration to periods of time when a job waits for another job to finish.

(seconds)

Avg run The average time that the job ran, calculated from all previous invocations.

duration

(seconds)

Recurrence | The number of times that the job was invoked. Click to go to the
viewJobExecHistory page, to retrieve a history of job invocations.

Results The number of CITs that have been discovered by the job. Click to go to the
viewJobResults page to view the CITs.

viewJobStatus

Enter the name of a job to return its status and scheduling information.

For details on the job operation parameters, see "Job Operation Parameters" on page 203.

The results page displays the following information:

Column Description

Threading | The total number of worker threads created by the invocation, the free worker

info threads, and the stuck worker threads.

Total work | The time that the Probe took to run this job.

time

Tasks A list of jobs together with the number of Trigger Cls that are awaiting activation.

waiting for

execution

Max. The number of threads that are serving this job.

Threads

Progress A summary of the current run, that is, since the specific run was activated.
Forexample, Progress: 2017 / 6851 destinations (29%) means that
out of 6851 Cls, 2017 Cls have already run.

Working e Thread Name. The thread that is now running this job. Click to go to the

Threads viewJobThreadDump page. You use this page when a thread is running for a

information long time, and you must verify that this is because the thread is working hard,
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Column Description

and not because there is a problem.

e Curr Dest. ID. The name of the node on which the job is running.
e Curr Dest. IP. The IP for which the job is discovering information.
e Work Time (Sec). The length of time that this thread is running.

e Communication Log. Click to go to the viewCommunicationLog page, to
view an XML file that logs the connection between the Probe and a remote
machine. For details, see the Create communication logs field in the
"Execution Options Pane" on page 96.

Discovery o Status. The severity of the job's status, as calculated by the Probe. For
Jobs details, see "Status" on page 200.
Information

table o Errors. Click to go to viewJobErrorsSummary page, to view a list of error

messages reported on this job.

o Triggered Cls. Click to go to viewJobTriggeredCls page, to view a list of
Trigger Cls that are part of a job.

o Last invocation. The date and time that the job was last run.
¢ Next invocation. The date and time that the job is next scheduled to run.

¢ Last Total run duration (seconds). For details, see "Last Total run duration
(seconds)" on previous page.

e Avg run duration (seconds). For details, see "Avg run duration (seconds)" on
previous page.

¢ Recurrence. The number of times that the job was invoked. Click to go to
viewJobExecHistory page, to view a history of job invocations.

Results The number of CITs that have been discovered by the job. Click to go to the
viewJobResults page to view the CITs.

viewJobTriggeredCls

Fill in one or more of the parameters to return a list of Trigger Cls that are part of a job.
For details on the job operation parameters, see "Job Operation Parameters" on next page.

The results page displays the following information:

Column Description

No. The number of the job in the list.

Triggered | The Cl instances that have been discovered by the job. Click to go to the
ClID viewJobTriggeredCls page to view information about their CITs.

Page 202 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 8: Universal Discovery

Column Description

Last The date and time that the job was last run.
Execution

Service The maximum time that it took for a job to run in the last invocation, not including

Exec. periods when the job did not run. Compare this result with the total execution
Duration | duration.
(ms)

For example, when several jobs run simultaneously, but there is only one CPU, a
job might have to wait for another job to finish. The service duration does not include
this waiting time, whereas the total duration does.

Total The time that it took for a job to run in the last invocation, including the periods when
Exec. the job did not run.

Duration

(ms)

Last Run | The status of the last run, that is, whether the run succeeded or failed. In case of
Status failure, click to go to the viewJobProblems page, to view a list of Trigger Cls with
problems.

Priority The priority of the job.

Note: The lower the value, the higher the priority.

viewdJobTriggeredCisWithErrorid

Note: This operation is part of the inner interface and serves as a helper function. Do not use
this page to view Trigger Cls information; instead, use the viewJobTriggeredCls page.

Job Operation Parameters

The following list includes job operation parameters.
o ciType. The name of the Cl type (for example, ip, host).

o data. A textual field in the DiscoveryResults table that contains information about the
discovered object. For example:

<object class="ip">

<attribute name="ip probename" type="String">EBRUTERO2</attribute>
<attribute name="ip address" type="String">16.59.58.200</attribute>
<attribute name="ip domain" type="String">DefaultDomain</attribute>
</object>

o Error Id. The error message hash string (error hash ID) that is displayed in the Jobs_Problems
table.

o HideRemovedJobs.True: do not display jobs that have run previously and are not relevant to
the current run.

o Hide Touched Cls Info. Touched Cls are Cls which were discovered in previous invocations.
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DFM already has information about these Cls, so there is no need for the Probe to send the
information to the server again. The server identifies that these Cls are relevant and that there is
no need to enforce the aging mechanism on them. For details on aging, see "The Aging
Mechanism Overview" in the HP Universal CMDB Administration Guide.

True: the table displays the total number of Cls and the total number of Trigger Cls for each CIT.
False: The table displays the total number of Cls and Trigger Cls divided between touched Cls
and non-touched Cls.

includeNonTouched. Enables filtering the table to view non-touched Cls. Choose between
viewing non-touched Cls only, all Cls (touched and non-touched), or none:

Non-touched All CIs No ClIs
Cls
(boolean)inchide TouchedCis " True ¥ False | @ True © False " True ¥ False
(boolean)inclhideNonT ouchedCis & True " False | @ True © False " True ¥ False

includeNonTouchedCls. See includeNonTouched.

includeTouched. Enables filtering the table to view touched Cls. Choose between viewing
touched Cls only, all Cls (touched and non-touched), or none.

includeTouchedCls. See includeTouched.
jobID. The name of the job, for example, Host Applications by PowerShell:

(W] Basic Applicstions
' Host Applications by PawerShell |
A Host Applications by Shel
A Host Applications by ShMP
A Host Applications by Wb

maxRows. The maximum number of rows that should be displayed in the results table. The
default is 100 or 1000.

maxTriggeredCls. See maxRows.
objectlD. The CMDB object ID.

showRemovedJobs. Shows information about jobs that are not currently scheduled to run, but
that have run previously. These jobs take the state of REMOVED.

showResults. Indicates whether to display the Show Results column. If the Show Results
column is present, you can navigate from viewJobsStatuses to viewJobResults.

triggerCIl. The CMDB object ID of the trigger for a job.
triggeredCilD. See triggerCl.

Discovery Control Panel User Interface

This section describes:

Choose Cls to Add Dialog BOX. . . - .. oo oo 205
Choose Discovery Query Dialog BoX. . . . ... oL 207
Choose Probe Dialog BOX. . . . . ..o 207
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Configuration Item Properties Dialog BOX. .. ... ... 207
Create New Discovery Job Dialog Box. ... ... ... 207
Created by WindoW. . . .. L 211
Dependency Map Tab. . ... oo L 211
Discovered CIs WINAOW. . . ... ... 212
Discovery Control Panel. . ... .. o 213
Discovery Modules/Jobs Tab. .. .. ... 214
Discovery Module/Jobs -Details Tab.. ... .o . 214
Discovery Modules Pane. . .. ... 222
Discovery Permissions Window. .. ... ... il 226
Discovery Scheduler Dialog BOX. . . . ... L 227
Discovery Troubleshooter Wizard. .. ... . L 229
Edit Probe Limitation for Query Output Dialog Box.......... ... ... ... 234
Edit Time Template Dialog BOX. . . ... 235
Find Jobs Dialog BoX. . . ... L 235
New/Edit Management Zone Dialog BOX. . .. ... .. oo . 236
Properties Tab. . ... 238
Related Cls WiNdOW. . . ... ... 242
Show Results for Triggered Cl Dialog BOX. . . . ... 242
Time Templates Dialog BoOX. . ... o 243
Trigger Query Editor Window. . ... ...l 243
Zone-Based Discovery Tab. ... ... 246

Choose Cls to Add Dialog Box

Enables you to choose Cls to run with selected jobs.

To » Data Flow Management > Discovery Control Panel. In the Details tab, locate
access the Discovery Status pane. Click the Add CI |E| button.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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ul
Element
(A-2) Description
<right- | Choose from the following options:
click a . . e
. ¢ Hide Column. Select to hide a specific column.
title>

¢ Show All Columns. Displayed when a column is hidden.

o Select Columns. Select to display or hide columns and to change the order of the
columns in the table. Opens the Select Columns dialog box.

o Auto-resize Column. Select to change a column width to fit the contents.

For details, see "Select Columns Dialog Box" (on page 1) in the HP Universal CMDB

Modeling Guide.

Add Note: If you choose Cls with an error status to add to the trigger list, a message is
button | displayed when you click the Add button.

Search | Contains filters with which you can limit the number of Cls that appear in the Search
Cls Results pane.

o By Discovery Query. Select a Discovery query to search for those Cls that
match the query.

e Show only Cls containing. To search for Cls that include a certain text, enter the
text here.

o Exact match. Select to search for Cls with the exact match of the text label. (By
default, you search by entering part of a text. For example, searching for 10 within
the IP Cls finds all the IPs that contain 10 in their address. Entering 10 then
selecting Exact match finds no results.)

e Search. Click to display the search results.

Search | Displays alist of triggered Cls answering to the criteria set in the filter. To add the Cls
Results | tothe list in the triggered Cls pane, select the Cls. You can make multiple selections.

o CIT. The Cl type of the selected triggered CI.

e CI. The label of the triggered CI.

o Related Host. The label for the node related to the triggered CI.

o Related IPs. The IPs of the related node.

o Reported. The time that the Cl is added to the Discovery Status table.

Page. Thelist of Cls is divided into pages. The number in the Page box indicates

which page is currently displayed. To view other pages, use the up and down arrows,

or type the page number, and press Enter.

To determine the number of Cls that appear on a page, right-click the up or down

button and choose the required number. The default is 25.
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Choose Discovery Query Dialog Box

Enables you to add a Trigger query to a job.

To access Click the Add Query button in the Trigger Queries pane.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2Z) Description

<Discovery query name> The query that queries the CMDB for the selected CIT.

Query Preview Hold the cursor over an element to view details.

Choose Probe Dialog Box

Enables you to filter the Probe list.

To Click a Filter button in the Discovery Control Panel > Details tab:

access

o Triggered Cls pane Filter button. For details on the menu options, see "Discovery
Status Pane" on page 216.

o Statistics pane Filter button. For details on the menu options, see "Statistics
Results Pane" on page 220.

Configuration Item Properties Dialog Box

Enables you to view CI properties.

To access In the Discovered Cls dialog box, right-click a Cl and choose Properties.
Important For details, see "Configuration Item Properties Dialog Box" in the HP
Information Universal CMDB Modeling Guide.

Create New Discovery Job Dialog Box

Enables you to create a job.

To Navigate to Data Flow Management > Discovery Control Panel > Discovery
access | Modules/Jobs, right-click a module in the Discovery Modules pane, and select New >
Job.

Discovery Job Details Pane

User interface elements are described below:
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Ul Element (A-2) Description

—?mu- Opens the Help document related to the selected job's adapter.
To update or modify this document, see "Adapter Definition Tab"
on page 89.

| # Edit Adapter Click to go to the adapter in the Resources pane.

You can choose to view a map of the Cls and links that are
discovered by the adapter, instead of a list. Click the button to open
the Discovered CITs Map window. The selected adapter is shown
together with its Cls and relationships. Hold the cursor over a CIT
to read a description in a tooltip.

Click to view permissions that are defined for specific adapters.
For details, see "Discovery Permissions Window" on page 226.

For details on editing these permissions, see "Permission Editor
Dialog Box" on page 114.

Adapter

The adapter needed by the job to discover the Cls.

Discovered Cls

The Cls that are discovered by this job.

Input ClI Type

The CIT that triggers the Cls for this job.

Job Name

The name and description of the job and the package in which it is
located.

Note:
e Job names cannot start with a numeric value.

o Job names must be limited to a length of 50 characters.

Required Protocols

The protocols needed by the activated job to access the system
components.

Parameters Pane

Enables you to override adapter behavior.

To view a description, hold the pointer over the parameter.

To access Select a job in the Discovery Modules pane in the Discovery Control
Panel window.

Important You can override a default adapter parameter for a specific job, without
Information affecting the default value.

User interface elements are described below:
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ul

Element

(A-2) Description

Name The name given to the adapter.

Override | Select to override the parameter value in the adapter.
When this check box is selected, you can override the default value. For example, to
change the protocolType parameter, select the Override check box and change
MicrosoftSQLServer to the new value. Click OK in the Properties tab to save the
change:

Farameters
Override Hame | Value
protocolType MicrosoftSGLServer

For details on editing parameters in the Adapter Parameters pane, see "Adapter
Definition Tab" on page 89.

Value The value defined in the adapter.

Trigger Queries Pane

Enables you to define one or more queries to be used as triggers to activate the selected job.

User interface elements are described below:

Ul
Element

Description

Add Query. You can add one or more non-default TQL queries to be used as triggers
to activate the selected job. Click to open the Choose Discovery Query dialog box.

Remove Query. Select the query and click the button.
(No message is displayed. To restore the query, click the Cancel button.)

Note: If a query is removed for an active job, Discovery no longer receives new Cls
coming from that query. Existing Trigger Cls that originally came from the query are
not removed.

Click to add or remove Probes for a specific query. For details, see "Edit Probe
Limitation for Query Output Dialog Box" on page 234.

Click to open the Trigger Query Editor. For details, see "Trigger Query Editor
Window" on page 243.

Available: In the job's Properties tab only.
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Ul
Element

(A-2) Description

|ﬁ| Click to open the Modeling Studio.

Available: In the job's Properties tab only.

Probe The Probes being used for the discovery process. To add or remove Probes, click the
Limit button.

Query The name of the Trigger query that activates the job.

Global Configuration Files Pane

User interface elements are described below:

Ul Element (A-2) Description

|§| Edit. Opens the selected configuration file in an appropriate editor.

For example, the file msServerTypes.xml opens the Script Editor.

Discovery Scheduler Pane

Enables you to set up a schedule for this job.

User interface elements are described below:

Ul Element

(A-2) Description

(& Click to add times to the Allow Discovery to run at list. The Time Templates
dialog box opens. To add a time template to the list, in the Time Templates
dialog box, click the Add button to open the Edit Time Template dialog box. For
details, see "Edit Time Template Dialog Box" on page 235.

Allow Choose a template that includes the days and times when the job should run.

Discovery

to run at

Edit Click to open the Discovery Scheduler. For details, see "Discovery Scheduler

scheduler Dialog Box" on page 227.

Invoke on Enables the job to run as soon as the Trigger Cl reaches the Probe.

new

triggered When this option is not selected, the job runs according to the schedule defined in
Cls the Schedule Manager.

immediately

Note: If this option is not selected and a job is running, new triggered Cls are
not run by the job.
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Ul Element
(A-2Z)

Description

Although new triggered Cls are not run, they are counted into the status bar.

This means the status bar does not reach 100% completed, even though the
job successfully completed, and the user has to wait until the next run of the
job for the status bar to reach 100% completed.

Created by Window

Enables you to view Cl instances of a CIT discovered by a job.

To access In the Statistics Results pane, select a CIT, and click the View instances
button.
In the Dependency Map tab, select Show Discovered Cls or Show all
instances.

Important The Discovered by <job name> window includes the same information as the

Information Element Instances window. For details, see "Element Instances Dialog Box"

in the HP Universal CMDB Modeling Guide.

Depending on whether you select Show discovered Cls or Show all
instances in the Dependency Map, you can view all Cls discovered by a
selected job or all Cls of a selected type.

The Cl instances displayed are retrieved from the server upon opening this
window. The number of Cls may differ from the number of Cls displayed in the
Statistics Results pane because some created Cls may have been merged or
deleted since they were created by the job.

Dependency Map Tab

Displays a visual representation of the real-time progress of the discovery process. The map

displays:

o Cls that were triggered by a job

o Cls that were discovered as a result of the activated job.

To access | Click the Dependency Map tab in the Discovery Control Panel window.
Important Depending which level you select in the Discovery Modules pane, different
Information | information is displayed in the Dependency Map tab.

If you select:

= The Discovery Modules root, and select the Show only active Discovery
jobs check box, the Dependency Map displays only active jobs and their
interdependencies.
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= The Discovery Modules root, and clear the Show only active Discovery
jobs check box, the Dependency Map displays all DFM jobs and their
interdependencies.

= A module, atopology map is displayed showing the module's active and
inactive jobs.

= A job, the topology map highlights the job in the module's map.

See also

"Created by Window" on previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description
<right-click | Use the right-click menu to view details for a job, Cl, or link, for example, the
menu> number of Cl instances (of a specific type) in the CMDB or the number of CI
instances created by a specific job.
Depending on which object is selected, the following menu options are
displayed:
e Whenajobis selected:
Show discovered Cls. Click to view the Cls discovered by the job. To filter
the query, select a CIT from the menu.
Show trigger Cls. Click to view the Cls that triggered the job.
e When aCl is selected:
Show all CIT instances. Click to view all Cls of this Cl type.
e Whenalink froma Cl toajob is selected:
Show trigger Cls for job. Click to view Cls (of the selected type) that
triggered the job.
e Whenalink from ajobtoa Cl is selected:
Show discovered instances. Click to view Cls (of the selected type) that
were discovered by the job.
<Toolbar> For a description of the icons, see "Toolbar Options" in the HP Universal CMDB
Modeling Guide.
<Tooltip> Hold the pointer over a Cl or job to display a description.
Show only When the Discovery Modules root is selected in the Discovery Modules pane,
active this check box is displayed.
Discovery . Lo
jobs Select to display all active jobs (from any module).

Discovered Cls Window

Enables you to view all Cl instances found for a selected TQL node.
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To access o Data Flow Management > Discovery Control Panel > Dependency Map
tab. Right-click a CIT and select Show Triggered Cls

¢ Inthe Discovery Status pane, click the Show additional data button

Important | The Triggered Cls window includes the same information as the Element
Information | Instances window. For details, see "Element Instances Dialog Box" in the HP
Universal CMDB Modeling Guide.

Discovery Control Panel

You activate jobs that discover the components of your system from the Discovery Control Panel.

To access Data Flow Management > Discovery Control Panel.

Relevant tasks e "Zone-Based Discovery Workflow" on page 189

e "Module/Job-Based Discovery Workflow" on page 190

See also e "Universal Discovery Overview" on page 184

User interface elements are described below:

Ul Element
(A-2Z) Description
Discovery Enables you to activate discovery by setting up and run individual discovery

Modules/Jobs | jobs. For details, see "Discovery Modules/Jobs Tab" on next page

tab
Note: This tab is suitable for when you want to run discovery on a particular

node rather than within a Management Zone.

Zone-Based Enables you to activate discovery in a user-friendly way by setting up
Discovery tab | Management Zones with various discovery activities. For details, see "Zone-
Based Discovery Tab" on page 246.

Note: This tab is displayed by default when accessing the Discovery Control
Panel.
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Discovery Modules/Jobs Tab

Enables you to view and manage modules and jobs, to activate jobs, and to follow job progress.

To access | Data Flow Management > Discovery Control Panel
Important o This tabis suitable for advanced users of Universal Discovery only.
Information I . . .
e Each change you make in Discovery Control Panel is delivered to and stored in
the CMDB. From there, the changes are sent to the Probe. You can verify that
changes have been sent to the Probe by opening the wrapperProbe.log file
located in C:\hp\UCMDB\DataFlowProbe\runtime\logs\ and searching for
the following lines:
processing document domainScopeDocument.bin
Processing document domainScopeDocument.bin is done.
Relevant "Module/Job-Based Discovery Workflow" on page 190
tasks

User interface elements are described below:

Ul Element

(A-2) Description

Dependency | Displays a visual representation of the real-time progress of the process. For

Map tab details, see "Dependency Map Tab" on page 211.

Details tab Enables you to manage a module's Cls and view Cl statistics. For details, see
"Discovery Module/Jobs - Details Tab" below.

Discovery Each module includes jobs. You activate a module or job to discover a specific

Modules group of Cls. For details, see "Discovery Modules Pane" on page 222.

pane

Properties Enables you to view and administer the properties of modules and jobs. For

tab details, see "Properties Tab" on page 238.

Discovery Module/Jobs - Details Tab

Enables you to view and administer modules and jobs, to follow the progress of the DFM process,
and to manage errors during discovery.

To access Discovery Control Panel > Discovery Modules/Jobs tab > Details tab.
Important Depending which level you select in the Discovery Modules pane on the left,
Information | different information is displayed in the Details tab.
If you select:
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e The Discovery Modules root or a Discovery module, the following is
displayed:

= "Discovery Status Pane"
= "Statistics Results Pane"

These panes display information and statistics about all active jobs and
errors discovered during a run.

e A job, the following is displayed:
= "Discovery Job Details Pane"
= "Discovery Status Pane"
» "Statistics Results Pane"
o Several jobs or modules, the following is displayed:

= "Selected Items Pane"

tasks Guide

Relevant "Error Messages Overview" in the HP Universal CMDB Developer Reference

Discovery Job Details Pane

User interface elements are described below:

Ul Element (A-2) Description

M Opens the Help document related to the selected job's adapter.
To update or modify this document, see "Adapter Definition Tab"
on page 89.

| # Edit Adapter Click to go to the adapter in the Resources pane.

You can choose to view a map of the Cls and links that are
discovered by the adapter, instead of a list. Click the button to open
the Discovered CITs Map window. The selected adapter is shown
together with its Cls and relationships. Hold the cursor over a CIT
to read a description in a tooltip.

Click to view permissions that are defined for specific adapters.
For details, see "Discovery Permissions Window" on page 226.

For details on editing these permissions, see "Permission Editor
Dialog Box" on page 114.

Adapter

The adapter needed by the job to discover the Cls.

Discovered Cls

The Cls that are discovered by this job.

Input CI Type

The CIT that triggers the Cls for this job.
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Ul Element (A-2) Description

Job Name

The name and description of the job and the package in which it is
located.

Note:
o Job names cannot start with a numeric value.

o Job names must be limited to a length of 50 characters.

Required Protocols The protocols needed by the activated job to access the system

components.

Discovery Status Pane

Enables you to view a run status and drill down to problematic Trigger Cls, to uncover specific
problems that DFM encountered during the run. For example: incorrect credentials. You can also
add newly discovered Cls to the Trigger Cl list.

To access Select a module or job, click the Details tab, and locate the Discovery Status
pane.
Important o This pane enables you to view the results of the previous run for a selected
Information module or job, or for all modules, depending which level you select
Note: Jobs that are running via the Scheduler do not automatically appear as
running in the Discovery Control Panel.
e Youcanuse the SHIFT and CTRL keys to select adjacent and non-adjacent
Clsinalist.
o The information in this pane is automatically refreshed every thirty seconds.
Relevant "Check Status of Application Discovery (Rediscover a View)" in the HP
tasks Universal CMDB Modeling Guide
See also "Error Messages Overview" in the HP Universal CMDB Developer Reference
Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2)

B

Description

Up one level. Click to return to the upper pane.

]

Show triggered Cls. Click to drill down to the Trigger Cl that includes the
problem.

Note: This icon is enabled only when you can drill down from error or warning
links.
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Ul Element
(A-Z)

il

Description

Refresh. Click to refresh the status view.

Add CI. Click to add a newly-discovered Cl to the Trigger Cl list. For details, see
"Choose Cls to Add Dialog Box" on page 205.

Remove CI. If the Cl is no longer of interest, click to remove a Cl from the list.
The Cl is deleted from the specific job.

Filter Cls. Click and choose an option from the menu:

o By Status. (This option is available only when the Total number of Cls is
displayed.) Displays a list of Trigger Cls:

= All. Displays all the Trigger Cls.

= Waiting for Probe. Displays the Trigger Cls that are ready to be
dispatched and are waiting for the Probe to retrieve them.

= In Progress. Displays the Trigger Cls that are active and are running on the
Probe.

= In progress (being removed). Displays the Trigger Cls that are being
removed from the Trigger Cls list.

= Success, Failed, Warning. Displays only those Cls that have the selected
status.

e By Probe. Displays only the Cls triggered by a selected Probe. Click to open
the Choose Probe dialog box.

o By Dispatch Type. Displays a list of Cls according to one of the following
options:

= All. Displays both Cls that are used to manually activate the job and
Discovery TQL queries that are used to automatically activate the job.

= Manually Added. Displays the Cls that are used to manually activate the
job.

= By Discovery Query. Displays the Cls that are used to automatically
activate the job.

¢ Reset. Click to remove any filters.

Handle errors. Opens a message box containing an explanation of the selected
failure. (You can also view messages by right-clicking the Cl and selecting Show
error details.)

Show additional data. Click to open the Triggered Cls dialog box with additional
information about the CI. For details, see "Discovered Cls Window" on page 212.

Show results for triggered Cl. DFM sends an ad-hoc request to the Probe and
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Ul Element
(A-Z)

Description

retrieves the latest results of the job (CIT name and number of discovered Cls)
that is running on a specific Trigger CI.

This ad-hoc request does not run the job, but brings the results of the previous job
run that are stored in the Probe's database. If the job has not yet run for this
Trigger Cl, a message is displayed. See "Show Results for Triggered Cl Dialog
Box" on page 242.

If no communication log exists in the Probe, a message is displayed. You can
choose that DFM always creates communication logs. For details, see "Adapter
Configuration Tab" on page 96.

Rerun Discovery. Enables you to rerun the discovery.job.

0w/ [

Pause / Resume. Enables you to pause an active job or resume a paused job.
Note:
e When you pause an active job:

» triggers that are currently running continue to run until they are finished

» all the execution information is retained, including errors

e Jobs are paused based on their defined job execution policies. For details, see
"Job Execution Policies" on page 23.

<right-click
menu>

In addition to some of the functionality described above, right-clicking a CI
enables you to do the following:

¢ Run from step. Enables you to manually run the job on the selected Cl from a
particular step in the job's workflow. This is useful if you do not want to rerun
the whole discovery job on the ClI, but only a part of it.

Note:

o The workflow steps are defined in the job’s adapter file. You can view or edit
the workflow in the Adapter Definition tab for the relevant adapter. For
details, see "Adapter Definition Tab" on page 89

o You cannot run the job from particular step if the status of the Cl is Waiting
for probe or In Progress.

Available: For Cls that trigger workflow-based jobs

Failed

Displays those Cls that returned a severity of type Error or Fatal.
Note:

e When you pause an active job:

Page 218 of 279

HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 8: Universal Discovery

Ul Element
(A-Z)

Description

» triggers that are currently running continue to run until they are finished
= all the execution information is retained, including errors

o Jobs are paused based on their defined job execution policies. For details, see
"Job Execution Policies" on page 23.

Double-click a job to display the error message.

Right-click an error to deactivate or rerun a job.

In progress

Displays the number of Trigger Cls that are running in the probe. Click to view the
jobs that are running.

Note: For consecutive runs of a job via the Scheduler, it does not appear as
In progress, but only the final status (Success or Failed) is updated.

Look for

To search for a specific Probe, related host, or related IP, enter part of its name in

the box and click the |i| button.

Progress

The indicator shows a summary of the current discovery run, that is, since the
specific run was activated.

Success

DFM displays the number of Cls that have been run successfully, that is, without
errors.

Click to view the jobs (and the number of Cls in each job) that completed
successfully.

Select a Cl and use the right-click menu to view information about the CI.
With warnings. Click to view a waming message for each job.

o Double-click a message to view the Cls that finished successfully with a
warning.

¢ Right-click a message to access information about the ClI.

Total

Displays the status of all of a job's Trigger Cls. Double click a Warning or Error
status to open the Message dialog box.

Waiting for
Probe

The Trigger Cls that are waiting for the Probe or are waiting to run.

Selected Items Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description
<right-click | Edit Scheduling. Click to open the Discovery Scheduler to define a schedule
menu> for a specific job. For details, see "Discovery Scheduler Pane" on page 241.
Invoke o A check mark signifies that the DFM job runs as soon as the triggered Cl
immediately reaches the Probe. In this case, the Invoke on new triggered Cls
immediately check box is selected in the Properties tab.
¢ If this column does not contain a check mark, the job runs according to the
schedule defined in the Schedule Manager.
Job name The name of the job.
Schedule The scheduling information of the job as defined in the Discovery Scheduler.
info
Trigger The name of the query that activated the job. For details, see "Trigger Queries
Queries Pane" on page 240.

Statistics Results Pane

Important
Information

UCMDB includes a purging mechanism for managing old discovery result
statistics. This mechanism enables faster display of discovery result statuses.
That is, the old statistics records are merged and therefore they are still available
for the user. This feature is controlled by two system parameters:

o appilog.collectors.ResetDiscoveryStatisticsintervalHours.name=Reset
Discovery Statistics Interval by Hours. This property defines the interval of
merging discovery statistics (the interval for running the purging mechanism).

o appilog.collectors.DiscoveryStatisticsArchiveDays.name=Discovery
results statistics archive period. This property defines the number of days
after which results statistics are being archived (the number of days after
which the statistics are considered old).

See also

e "Data Push Tab" on page 145
e "Population Tab" on page 162

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

|E| Click toretrieve the latest data from the server (job results are not automatically
updated in the Statistics pane).

|{}31 ,.| Select a CIT and click the View Instances button to view created or updated CI
instances and their attributes.
A message is displayed when:
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Ul Element
(A-2) Description
o All the Cls that were discovered by this job were already discovered by another
job.
o Allthe Cls that this job discovered have been deleted.
e The Cl instances were discovered in a previous version.
Note:
e Youcanalso view Cl instances by double-clicking a row.
e Only instances created by the job are shown. If there are no such instances,
this button is not available.
e CITs with noinstantiated instances are displayed.
|f| Select the time range or Probe for which to display statistics about the CITs.
o By Time Range:
= All Displays statistics for all job runs.
= From Now/Last Minute/Last Hour/Last Day/Last Week. Choose a period
of time for which to display statistics about the CITs.
= Custom Range. Click to open the Change Timeframe dialog box: Enter
the date or click the arrow to choose a date and time from the calendar, for
the From and To dates (or click Now to enter the current date and time).
Click Last Day to enter the current date and time in the To box and
yesterday's date and time in the From box. Click OK to save the changes.
o By Probe: To view statistics for a specific Probe, select to open the Choose
Probe dialog box.
|%| Show all declared CI Types. By default, only discovered CITs are listed in the
— table; the Discovered Cls column includes CITs if the number of Cls found is
greater than zero. Click the button to display every Cl that can be discovered by
the job, even if the Discovered Cls value is zero:
Statistics Results
Yo
Fitter: Tirme Ranga[Al)
Last Updated: 09/21/2008 02:54:23
CIT Dizcovered Clz
Database 0
<Column Click a column title to change the order of the CITs from ascending to descending
title> order, or the other way round.
<right-click | Choose from the following options:
a title>
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Ul Element
(A-2) Description
¢ Hide Column. Select to hide a specific column.
e Show All Columns. Displayed when a column is hidden.
o Select Columns. Select to display or hide columns and to change the order of
the columns in the table. Opens the Select Columns dialog box.
e Auto-resize Column. Select to change a column width to fit the contents.
For details, see "Select Columns Dialog Box" in the HP Universal CMDB
Modeling Guide.
CIT The name of the discovered CIT.
You can configure discovery so that any object reported by the job and whose CIT
is not defined in the adapter's discovered CITs list is marked in red. Objects
include those added by the Probe result mechanism.
To set this parameter:
1. Select Administration > Infrastructure Settings Manager.
2. Select the General Settings category.
3. Locate the Enable statistics results validation according to adapter
parameter.
4. Change the value to True.
Created The number of CIT instances created in the period selected or for the selected
Probe.
Deleted The number of CIT instances deleted in the period selected or for the selected
Probe.
Discovered | The number of Cls that were discovered for each Cl type.
Cls
Filter The time range set with the Set Time Range button.
Last The date and time that the statistics table was last updated for a particular job.
updated
Total The total number of Cls in each column.
Updated The number of CIT instances that were updated in the period selected.

Discovery Modules Pane

Enables you to view and manually manage modules and jobs. Each module includes the jobs
necessary to discover specific Cls.

To Data Flow Management > Discovery Control Panel > Discovery
access Modules/Jobs tab.
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User interface elements are described below:

ul
Element
Description
|§| Refresh All. Updates the modules.
|E| Search for Discovery Job. Click to open the Find Jobs dialog box. For example, to

search for all jobs that discover SNMP connections, in the Find Jobs dialog box,
enter SNMP in the Name box and click Find All. For details, see "Find Jobs Dialog
Box" on page 235.

Activate Selected Discovery Jobs. You can run one job or several jobs in a module,
and one or several modules.

Select the jobs or modules and click Activate.

1-:;;, Deactivate Selected Discovery Jobs. Select the jobs or modules to be stopped and
d click Deactivate.

= Represents the module root.
To create a module, right-click to enter the name of the module you are creating.

Note: A name is case sensitive. Names beginning with an upper case letter appear in
the Discovery Modules list before names beginning with a lower case letter.

] Represents a module.

o l TLTL. Indicates that some of a module's jobs are activated.
R Mairframe by EView Sgert

A CICE by Eview

A DE2 hy Eview

é%‘.] EWieww Connection

A IMS by Eview

é?'} LPAR Resources by EView

e MO by Eview

o l |I"'ILZ‘I:-. Indicates that all of a module's jobs are activated.

e Mainframe by Eview Sgent

dts CICS by Eview

dt» DE2 by Eview

5?3 Eiew Connection

dts IMS by Eview

5?3 LPAR. Fesources by EVisw
4a MG by Eview

F Represents a job.
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Ul

Element
(A-2) Description

o 4. Indicates that the job is active.
e 4m. Indicates that the job is paused.
To view an adapter description, hold the pointer over the icon.

Jobs contain configuration information derived from adapters and other resources and
are the entities controlled by users, for example, when activating or deactivating a
module.

For details on the right-click menu, see "Right-Click Menu" on next page.

An exclamation mark signifies that one or more of the jobs is experiencing a problem
that could affect the discovery process, for example, a protocol connection failure.

To view the reason for the problem, click the (show errors) link in the Discovery
Status pane. For details, see "Failed" on page 218.

Note: If a problem is resolved by clicking the Refresh All button, the Problem
Indicator disappears.
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Right-Click Menu

Ul Element (A-Z) Description

|§| Activate Module: Runs the jobs in the selected module.

Job: Runs the selected jobs

The Discovery Module discovers CITs and relationships of the types that
are described in each job, and places them in the CMDB. For example, the
Class C IPs by ICMP job discovers the Dependency, IpAddress, and
Membership CITs and relationships.

Clear Probe Clears the job's results cache on the probes

Results Cache Note: If a job's results cache is cleared, all discovery results are sent
again the next time the job runs

i?i Content Help Opens the Help document related to the selected job's adapter.

To update or modify this document, see "Adapter Definition Tab" on page
89.

To see the full HP Universal CMDB Discovery and Integration Content
Guide, select Help > Discovery and Integrations Content Help.

|_| Create New > Opens the Create New Discovery Job dialog box, enabling you to create a
Job job. For details, see "Create New Discovery Job Dialog Box" on page 207.

|_| Create New > Enables you to define a new name for the module root.

Module Note: Module names must be limited to a length of 50 characters.

1«:3, . Module: Stops the running jobs in the selected module.
“»  Deactivate

Job: Stops the selected running jobs.

Note: To stop all the running jobs simultaneously, right-click the
Discovery Modules root folder and click Deactivate all jobs.

ﬁ Enables you to delete the selected module.
| Delete

Caution: Only administrators with an expert knowledge of the Universal
Discovery process should delete modules.

E . Enables you to delete the selected job.

| Delete job

& Edit Opens the Discovery Scheduler to define a schedule for the selected job.

Scheduling

Edit Script Enables you to select and edit one of the selected job's scripts.
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Ul Element (A-Z) Description

G d Opens the details of the selected adapter in the Adapter Management
© to adapter module, enabling you to view and edit its definition.

Move to Enables you to move the selected module folder or job to a different folder.

|M| Pause Click to pause an active job.

To pause all active jobs simultaneously, right-click the Discovery
Modules root folder and click Pause jobs.

Note:
o When you pause an active job:

= triggers that are currently running continue to run until they are
finished

= all the execution information is retained, including errors

o Jobs are paused based on their defined job execution policies. For
details, see "Job Execution Policies" on page 23.

Rename Enables you to enter a new display name for the selected module.

Available: When you right click a module

Rename Job Opens the Rename Job dialog box, enabling you to enter a new display
name for the job.

Note: You cannot rename active jobs.

Available: When you right click a job

Rerun Discovery | Reruns the selected job using the selected Trigger Cls.

|E| Resume Enables you to resume a paused job.
To resume all paused jobs simultaneously, right-click the Discovery
Modules root folder and click Resume jobs.

|| Save as... Enables you to clone the selected job.

Discovery Permissions Window

Enables you to view permissions data for jobs.

To Data Flow Management > Discovery Control Panel > Discovery Module/Jobs
access | tab. Select a job. Locate the Discovery Job Details pane in the Details tab. Click the
View Permissions button.

See ¢ "Viewing Permissions While Running Jobs" on page 188

|
also o "Adapter Definition Tab" on page 89

o "Permission Editor Dialog Box" on page 114
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User interface elements are described below:

Ul Element

(A-Z) Description

|=:§_‘-| ,| Export a permission object in Excel, PDF, RTF, CSV, or XML format. For details,
see "Browse Views Mode" in the HP Universal CMDB Modeling Guide.

Objects and | The commands that appear in the relevant Jython scripts.
Parameters

Operation The action that is being run.

Permission | The name of the protocol as defined for the job.

Usage A description of how the protocol is used.
Description

Discovery Scheduler Dialog Box

Enables you to define a schedule for a specific job, for example, every day Data Flow Management
starts running an IP ping sweep on class C networks at 6:00 AM.

To access ¢ Right-click a job and choose Edit scheduling.

¢ Click the Edit Scheduler button in the Discovery Scheduler pane of the
Properties tab in the Discovery Control Panel window.

Important o The Discovery Scheduler defines the frequency of the discovery (daily,
Information monthly) whereas the time template defines when the job should run (during
the day, at night, at weekends only). You can run the same schedule with
different time templates. For example, you can define a schedule that runs
every day and you can define a time template that runs at night from 01:00 AM
to 05:00 AM. A job defined in this way runs every day from 01:00 AM to 05:00
AM. You can define a second time template to run at a different time, and you
also can use this time template with the same schedule.

o If you change a schedule for a job, DFM next runs the job according to the
following calculation: The current date and time plus the selected interval. For
example, if you choose Once, the Invocation Time is in one hour.

For details on creating a time template, see "Edit Time Template Dialog Box" on
page 235.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description

btz se sy | Click to validate the Cron expression you entered.

<Days of (Displayed when you select Monthly.) Click the button to choose the days of
month>
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Ul Element
(A-Z)

Description

the month on which the action must run. The Select Days dialog box opens.
Choose the required days by selecting the check boxes. You can select multiple
days.

o Select all. Select all the days.

o Unselect all. Clear all the selected days.

<Days of the
week>

(Displayed when you select Weekly.) Select the day or days on which the action
should run.

<Frequency>

e Once. Define the task to run only once. (

o Interval. Defines the interval between successive runs.
o Daily. Run atask on a daily basis.

o Weekly. Run atask on a weekly basis.

¢ Monthly. Run a task on a monthly basis.

e Cron. Enter a Cron expression in the correct format.

<Months of
the year>

(Displayed when you select Monthly.) Select the month or months in which the
action must run.

End by

Select the date and time when the action should stop running by selecting the
End by check box, opening the calendar, selecting the date and time, and
clicking OK.

Note: This step is optional. If you do not need to specify an ending date, leave
the End by check box cleared.

Invocation
hour

(Displayed when you select Daily, Weekly, or Monthly.) Select the time to
activate the action. Click the button to open the Select Hours dialog box.
Choose the required time by selecting the check boxes. You can select multiple
times.

o Select all. Select all the times.
¢ Unselect all. Clear all the selected times.

Note: You can also enter the time manually in the Invocation hour box.
Separate times by a comma and enter AM or PM after the hour. The manually
entered action times are not restricted to the hour and half hour only: you can
assign any hour and minute combination. Use the following format: HH : MM
AM, forexample, 8: 15 AM, 11:59 PM.

Invocation
Time

(Displayed when you select Once.) Choose the date and time the action should
begin running by opening the calendar and choosing a date and time, or accept
the default.

Repeat every

(Displayed when you select Interval.) Type a value for the interval between
successive runs and choose the required unit of time (minutes, hours, or days).
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Ul Element

(A-2) Description
Note: After each change, the next time that the job runs is the current time plus
the interval, that is, the job does not start immediately.

Start at Choose the date and time when the action must begin running by selecting the
Start at check box, opening the calendar, selecting the date and time, and
clicking OK.

Time zone Select the time zone according to which the Probe must schedule jobs.

The default is <<Data Flow Probe Time Zone>>: the Probe uses its own
system-defined time zone. This enables scheduling to take place at different
times in different geographical locations.

For all Probes to start working at the same time, select a specific time zone.
(This assumes that the Probes' system date/time and time zone are correctly
configured.)

Discovery Troubleshooter Wizard

The Discovery Troubleshooter allows you to troubleshoot for running software Cls that do not show
up when you run an activity on the Management Zone. This is useful for customers who are running
activities for discovering running software, and they see that the running software is not found.

This wizard page allows you to initiate the Discovery Troubleshooter.

To access

Select a Management Zone in the Management Zones tree structure on the left

)

el

and click the Troubleshooting button

Important
information

o The Discovery Troubleshooter wizard can be activated only within the context
of a Management Zone.

o The Discovery Troubleshooter wizard can be run on a Management Zone only
after the Infrastructure and Basic Software Configuration Discovery activities
have been run on that Management Zone.

o If any discovery activities are still running when you start this wizard, the Wait
for Jobs screen appears after clicking Next in the first screen of this wizard. If
the Wait for Jobs screen appears, wait until the activities finish and then
continue with the wizard.

Relevant
tasks

"Zone-Based Discovery Workflow" on page 189

Wizard
map

The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" above > "Activity Instances Mapping Page"
on next page > "Target Host Page" on next page > "Additional Information Is
Required Page" on page 231 > "Investigate Missing Node C| Page" on page 232 >
"Retrieve Running Software Cls Page" on page 233
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See also o "Discovery Troubleshooter" on page 187
e "Universal Discovery Overview" on page 184

e "Zone-Based Discovery Tab" on page 246

Activity Instances Mapping Page

This wizard page allows you to select a Discovery Activity Instance associated with the
Management Zone on which you are running the Troubleshooter.

Important This wizard page only appears if you have more than one Infrastructure or Basic
information | Software Configuration Discovery activity associated with the Management
Zone.

Wizard The Discovery Troubleshooter Wizard contains:

ma
P "Discovery Troubleshooter Wizard" on previous page > "Activity Instances

Mapping Page" above > "Target Host Page" below > "Additional Information Is
Required Page" on next page > "Investigate Missing Node Cl Page" on page 232
> "Retrieve Running Software Cls Page" on page 233

User interface elements are described below:

Ul Element (A-Z) Description

Activity Type Lists the types of Discovery Activities that are prerequisites
for running the Troubleshooter. Currently, only Infrastructure
and Basic Software Configuration Discovery activity types
are listed here.

Activity Instance Lists the instances of the Activity Type. If there is more than
one instance, they are listed in a drop-down menu.

Troubleshooter Log This log lists all actions performed by the Troubleshooter that
occur in the background and do not appear in the user
interface.

Target Host Page

This wizard page allows you to enter the name or IP address of the host that you want to discover.

Important information e The name or IP address that you enter in this
page should be within the range of at least one
of the probes in the Management Zone. Ifitis
not, an error message appears.

o After clicking Next on this page, the Validate
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Target Host IP Address page appears. Wait
briefly while the Discovery Troubleshooter
validates the target host IP address. If the
target host you entered is not within the range
of the Management Zone, the Validate Target
Host IP Address page offers you an option to
choose a different target host, or close the
wizard. If you choose a different target host,
the Target Host page appears again.

e Once an IP address is defined, the Discovery
Troubleshooter checks if a Cl exists for that IP.
If no Cl exists, the Discovery Troubleshooter
automatically creates a Cl for that IP address.

Wizard map The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" on page 229 >
"Activity Instances Mapping Page" on previous
page > "Target Host Page" on previous page >
"Additional Information Is Required Page" below >
"Investigate Missing Node C| Page" on next page
> "Retrieve Running Software Cls Page" on page
233

User interface elements are described below:

Ul Element (A-Z) Description

Target host: Enter here the name or IP address of the host that you want
to discover.

Troubleshooter Log This log lists all actions performed by the Troubleshooter that
occur in the background and do not appear in the user
interface.

Additional Information Is Required Page

This wizard page allows you to select a method for detecting the target host.
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Important information

o Afterclicking Next in this page, the Discovery
Troubleshooter attempts to activate a specific
job. If this job is not active, a message appears
stating that the job is about to be activated and
that if you activate it, this may invoke the job on
all potential trigger Cls that are relevant to this
job.

After clicking Next in this page, the Discovery
Progress screen appears and informs you that
Discovery is currently running.

Wizard map

The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" on page 229 >
"Activity Instances Mapping Page" on page 230 >
"Target Host Page" on page 230 > "Additional
Information Is Required Page" on previous page >
"Investigate Missing Node C| Page" below >
"Retrieve Running Software Cls Page" on next

page

User interface elements are described below:

Ul Element (A-Z) Description

Select detection method for
the requested host:

Discovery uses detection methods to communicate with the
remote machine. Choose from one of the following detection
methods: WMI, Shell, Power Shell, SNMP.

Troubleshooter Log

interface.

This log lists all actions performed by the Troubleshooter that
occur in the background and do not appear in the user

Investigate Missing Node Cl Page

This wizard page lists errors found if the Troubleshooter does not succeed in connecting to the host,
and offers options for trying to resolve those errors.

Important information

This page only appears if the Troubleshooter does
not succeed in connecting to the host.

Wizard map

The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" on page 229 >
"Activity Instances Mapping Page" on page 230 >
"Target Host Page" on page 230 > "Additional
Information Is Required Page" on previous page >
Investigate Missing Node Cl Page > "Retrieve
Running Software Cls Page" on next page

User interface elements are described below:
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Ul Element (A-Z) Description

<error messages>

Various error messages can occur when running the
Troubleshooter.

One of the more common types of error messages is
Permission Denied. This error occurs if there is a problem
with the user credentials. You can attempt to fix this error by
clicking Fix by the error message. If you do this, the Update
Credentials dialog box appears, and you can update the
user credentials as explained in "Data Flow Probe Setup
Window - Details Pane" on page 40, "[Protocol] Pane" on
page 44. After updating user credentials, you should choose
Rerun relevant discovery job to find missing Cl in this
wizard page and continue with the wizard.

Rerun relevant discovery job
to find missing ClI

Choose this option if you see an error in the list for which
rerunning a job might help (for example, a timeout error). If
you choose this option, the Discovery Progress screen
appears.

Choose a different detection
method to find missing CI

If you choose this option, the wizard retumns to the
"Additional Information Is Required Page" on page 231

Close the Troubleshooter and
save support log

Choosing this option exits the wizard and saves the log file to
a location on the server machine (the exact location is
indicated on the page that follows).

Troubleshooter Log

This log lists all actions performed by the Troubleshooter that
occur in the background and do not appear in the user
interface.

Retrieve Running Software Cls Page

This wizard page lists all running software that is currently listed as connected to the detected Node

Cl.

Wizard map The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" on page 229 > "Activity Instances
Mapping Page" on page 230 > "Target Host Page" on page 230 >
"Additional Information Is Required Page" on page 231 > "Investigate
Missing Node Cl Page" on previous page > "Retrieve Running Software
Cls Page" above

User interface elements are described below:
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Ul Element (A-Z) Description

Yes, the Cl was discovered

Check this option if the running software Cl that you are
looking for is in the list, or just close the Troubleshooter since
you have successfully completed troubleshooting.

No, the Cl is still missing

Check this option if the running software Cl that you are
looking for is not in the list. If you choose this option, the
Software Identification Rules Management screen
appears, and you can continue the search for the missing Cl
as followings:

¢ Inthe Software Identification Rules Management
screen, update the available application signatures as
explained in "Software Identification Rule Editor Dialog
Box" on page 121.

o The Troubleshooter then attempts again to find the
missing Cl (by re-running its corresponding job) and this
wizard page appears with a potentially more extensive list
of all running software that is connected to the detected
Node Cl.

o If the running software CI that you are looking for is still
not in the list, select again No, the Cl is still missing
,and the Additional Information Is Required page
appears (see below).

Additional Information Is
Required page

If after updating the available application signatures the
Troubleshooter still does not find the missing Cl, this page
appears. You can choose either Update software
identification rules and rerun discovery or Close the
Troubleshooter and save support log.

If you choose Update software identification rules and
rerun discovery, the Software Identification Rules
Management screen appears again and you can continue to
update the software identification rules.

Troubleshooter Log

This log lists all actions performed by the Troubleshooter that
occur in the background and do not appear in the user
interface.

Edit Probe Limitation for Query Output Dialog Box

Enables you to change the Probes on which a Trigger query is running. For details on selecting the
Probes, see "Selecting Probes" on page 54.

To Data Flow Management > Discovery Control Panel > <selected job> > Properties
access | tab > Trigger Queries pane > Probe Limit column > fieeed .
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Edit Time Template Dialog Box

Enables you to define a time template to use when scheduling jobs.

To access

Use one of the following:
o Click the Add button in the Time Templates dialog box.

« Inthe Time Templates dialog box, select a time template and click

2.

Important Information | The name of the time template must be unique.

See also

"Discovery Scheduler Dialog Box" on page 227

User interface elements are described below:

ul

Element

(A-2) Description

Every Define a daily schedule when a job must run. You can also type in times. You can

day assign any hour and minute combination.

between

Time Enter a unique name.

Template

name

Week Define a weekly schedule when a job must run. Select this option to select atime in

Time the Time Definition grid. To select adjacent cells in the grid, click and drag the pointer
over the grid. To clear a time, click a cell in the grid a second time.

Find Jobs Dialog Box

Enables you to search for jobs answering to specific criteria. The results of the search are displayed
in the Selected Items pane in the Details tab.

To access

Click the Search for Discovery Jobs|i| button in the Discovery Modules pane.
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User interface elements are described below:

Ul Element
(A-2) Description
Direction Searches forwards or backwards through the modules.
Find All All jobs meeting the search criteria are highlighted.
Find Choose between:
Discovery Name. Enter th f the job or part of it
job by ¢ Name. Enter the name of the job or part of it.
o Input type. Cls that triggered the job. Click the =22l button to open the CI
type list. Locate the Cl type that you are searching for.
o Output type. Cls that are discovered as a result of the activated job.
Find Next The next job meeting the search criteria is highlighted.

New/Edit Management Zone Dialog Box

This dialog box enables you to create or edit a Management Zone.

To access Data Flow Management > Discovery Control Panel > Zone-Based
Discovery tab > Click New buttonl__

Important You must have at least one Data Flow Probe set up to create a Management

information Zone.

Relevant tasks | "Zone-Based Discovery Workflow" on page 189

See also

¢ "Universal Discovery Overview" on page 184
e "Zone-Based Discovery Tab" on page 246
e "Zone-Based Discovery Workflow" on page 189

o "Discovery Troubleshooter" on page 187

User interface elements are described below:

Ul Element Description

> Add Probe. Click this button to add a probe to the Management Zone (you must
first select the probe in the Non-selected Probes column).

& Remove Probe. Click this button to remove a probe from the Management
Zone (you must first select the probe in the Selected Probes column).

= Add All. Click this button to add all the probes listed in the Non-selected

= Probes column to the Management Zone.

= Remove All. Click this button to remove all the probes listed in the Selected

= Probes column from the Management Zone.
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Ul Element Description

Open Data Flow Probe Setup. Click this button to change the IP range of a
probe (you must first select the probe from the Domains and Probes tree
structure on the left). This button appears only if you select Define partial IP
ranges on probes.

Clicking this button opens the Edit Probe Configuration dialog box. For
instructions on how to edit probe configuration, see "Data Flow Probe Setup
Window - Details Pane" on page 40"Details Pane (Probe)" on page 42 and
"Ranges Pane" on page 46.

Select IP Range. Click this button to select the sub-ranges you want to include
or exclude from the full probe range (you must first select the probe from the
Domains and Probes tree structure on the left). This button appears only if you
select Define partial IP ranges on probes.

Clicking this button opens the Select IP Range window. In the Select IP Range
window, you can select multiple sub-ranges by pressing the Ctrl key and
clicking on sub-ranges with the mouse. If a sub-range has more than one
excluded section, you cannot choose to exclude only one section. If you choose
to exclude only one section, all sections will be excluded.

Delete IP Range. Click this button to delete a sub-range from the Management
Zone. This button appears only if you select Define partial IP ranges on
probes, and is active only if you have previously added at least one sub-range
of the probe to the Management Zone.

Clicking this button deletes the sub-range from the Management Zone, but not
from the probe.

Name

The name of the Management Zone. This field is mandatory. You can enter
only alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), underscores (_ )and
spaces.

Description

The description of the Management Zone. This field is optional. This description
appears in the Details table in the right pane after creating the Management
Zone.

IP Ranges

o Select Use full probe ranges if you want to perform Discovery using the
ranges that have already been defined for the probe(s).

o Select Define partial IP ranges on probes if you want to select a sub-
range(s) from the ranges defined for the probe(s).

By default, Use full probe ranges is selected.

Note: If you bind a probe to the Management Zone with Use full probe ranges,
any future changes to the probe range will be applied to the Management Zone.

All Data
Flow
Probes

Check this option to bind the entire list of available probes (all probes of all
domains defined in the system) to the Management Zone. If you check this
option, any additions or deletions to the available probes in the future will be
applied to the Management Zone. The difference between this option and
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Ul Element Description

clicking the Add All button (described below) is that if you click the Add All
button, this will not apply to the Management Zone any changes made in the
future to the available probes in the system.

Non- This column lists the available probes in the system that you have not selected

selected for your Management Zone.

Probes

column

Selected This column lists the available probes in the system that you have selected for

Probes your Management Zone.

column

Properties Tab

Enables you to view and administer the properties of modules and jobs.

To access | Discovery Control Panel > Discovery Modules/Jobs tab > Properties tab
Important Depending which level you select in the Discovery Modules pane, different
Information | information is displayed in the Properties tab.

If you select:

o The Discovery Modules root, all active jobs are displayed with scheduling
information. Click any of the columns to sort the list by that column. Right-click
ajob to edit its scheduling. For details, see "Discovery Scheduler Dialog Box"
on page 227.

o A Discovery module, the Description and Module Jobs panes are
displayed.

To edit a description, make changes in the Description pane and click OK.
See also "Module Jobs Pane" below.

¢ A job, the Parameters, Trigger Queries, Global Configuration Files, and
Discovery Scheduler panes are displayed. For details, see below.

Module Jobs Pane

Enables you to view the active jobs for the selected module.

User interface elements are described below:

Ul Element

(A-Z)

Description

Add Discovery Job to Module. Opens the Choose Discovery Jobs dialog
box where you can select jobs from more than one zip file. (Use the SHIFT or
CTRL key to select several jobs.)
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Ul Element
(A-2) Description
E Remove Selected Discovery Job from Module. Select the job and click the
button. (No message is displayed. To restore the job, click the Cancel button.)
|@| Show results as a map. You can choose to view a map of the Cls and links that
T are discovered by the adapter, instead of a list. Click the button to open the
Discovered CITs Map window. The selected adapter is shown together with its
Cls and relationships. Hold the cursor over a CIT to read a description in a tooltip.
<Column o Click a column title to change the order of the CITs from ascending to
title> descending order, or vice versa.
o Drag acolumn head to a different location in the table columns.
« Right-click a column title to customize the table. Choose from the following
options:
= Hide Column. Select to hide a specific column.
= Show All Columns. Displayed when a column is hidden.
= Select Columns. Select to display or hide columns and to change the
order of the columns in the table. Opens the Columns dialog box.
= Auto-resize Column. Select to change a column width to fit the contents.
For details, see "Select Columns Dialog Box" in the HP Universal CMDB
Modeling Guide.
<List of All jobs included in the module. (Displayed when a specific module is selected in
jobs> the Discovery Modules pane.)
Right-click a row to open the Discovery Scheduler for the selected job. For
details, see "Discovery Scheduler Dialog Box" on page 227.
Invoke o A check mark signifies that the Discovery job runs as soon as the triggered Cl
Immediately reaches the Probe. In this case, the Invoke on new triggered Cls
immediately check box is selected in the Properties tab.
¢ If this column does not contain a check mark, the job runs according to the
schedule defined in the Schedule Manager.
Job Name The name of the job and the package in which the job is included.
(Displayed when a job is selected in the Discovery Modules pane.)
Schedule The scheduling information of the job as defined in the Discovery Scheduler.
Information
Trigger The name of the query that activated the job.
Queries

Parameters Pane

Enables you to override adapter behavior.
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To view a description, hold the pointer over the parameter.

To access Select ajob in the Discovery Modules pane in the Discovery Control

Panel window.

Important
Information affecting the default value.

You can override a default adapter parameter for a specific job, without

User interface elements are described below:

ul

Element

(A-2Z) Description

Name The name given to the adapter.

Override | Select to override the parameter value in the adapter.
When this check box is selected, you can override the default value. For example, to
change the protocolType parameter, select the Override check box and change
MicrosoftSQLServer to the new value. Click OK in the Properties tab to save the
change:

Parameters
Override Hame | Value
protocolType MicrosoftSQLServer

For details on editing parameters in the Adapter Parameters pane, see "Adapter
Definition Tab" on page 89.

Value The value defined in the adapter.

Trigger Queries Pane

Enables you to define one or more queries to be used as triggers to activate the selected job.

User interface elements are described below:

Ul
Element
(A-2Z)

Description

Add Query. You can add one or more non-default TQL queries to be used as triggers
to activate the selected job. Click to open the Choose Discovery Query dialog box.

Remove Query. Select the query and click the button.
(No message is displayed. To restore the query, click the Cancel button.)

Note: If a query is removed for an active job, Discovery no longer receives new Cls
coming from that query. Existing Trigger Cls that originally came from the query are
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Ul

Element
(A-2) Description

not removed.

= Click to add or remove Probes for a specific query. For details, see "Edit Probe
Limitation for Query Output Dialog Box" on page 234.

|§| Click to open the Trigger Query Editor. For details, see "Trigger Query Editor
Window" on page 243.

Available: In the job's Properties tab only.

|ﬁ| Click to open the Modeling Studio.

Available: In the job's Properties tab only.

Probe The Probes being used for the discovery process. To add or remove Probes, click the
Limit button.

Query The name of the Trigger query that activates the job.

Global Configuration Files Pane
Lists the global configuration files defined for the adapter used by the selected job.

User interface elements are described below:

Ul Element (A-2) Description

|5| Edit. Opens the selected configuration file in an appropriate editor.

For example, the file msServerTypes.xml opens the Script Editor.

Discovery Scheduler Pane

Enables you to view information about the schedule set up for the selected job.

User interface elements are described below:

Ul Element

(A-2) Description

& Click to add times to the Allow Discovery to run at list. The Time Templates
dialog box opens. To add a time template to the list, in the Time Templates
dialog box, click the Add button to open the Edit Time Template dialog box. For
details, see "Edit Time Template Dialog Box" on page 235.

Allow Choose a template that includes the days and times when the job should run.

Discovery

to run at

Edit Click to open the Discovery Scheduler. For details, see "Discovery Scheduler
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Ul Element
(A-2) Description

scheduler Dialog Box" on page 227.

Invoke on Enables the job to run as soon as the Trigger Cl reaches the Probe.

new

triggered When this option is not selected, the job runs according to the schedule defined in
Cls the Schedule Manager.

immediately

Note: If this option is not selected and a job is running, new triggered Cls are
not run by the job.

Although new triggered Cls are not run, they are counted into the status bar.

This means the status bar does not reach 100% completed, even though the
job successfully completed, and the user has to wait until the next run of the
job for the status bar to reach 100% completed.

Related Cls Window

Enables you to view, in map format, the Cls that are related to a selected Cl.

To access In the Discovered Cls dialog box, right-click a CIT and select Get
Related Cls.

Important Related Cls are Cls that are the parent, child, or sibling of an existing Cl.

Information

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<right-click For details, see "Shortcut Menu" in the HP Universal CMDB Modeling

menu> Guide.

<menu> For details, see "Toolbar Options" in the HP Universal CMDB Modeling
Guide.

<Topology For details, see "Topology Map Overview" in the HP Universal CMDB

Map> Modeling Guide.

Show Results for Triggered Cl Dialog Box

Enables you to view the results of running an ad-hoc request to the Probe. Discovery acquires the
results by running the job on a selected Trigger CI. In the case of an error, a message is displayed.

To Discovery Control Panel, select a module or job, select the Details tab. In the
access | Discovery Status pane, drill down to a Cl, right-click it, and choose Show Results for
Triggered CI.
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User interface elements are described below:

Ul Element

(A-Z) Description

|@ Select a CIT and click to display additional information in the Show Results for

T Triggered CI dialog box.

[} Click to open a topology map showing a result map for the Triggered CI. Right-
click a CIT to view its properties.

Time Templates Dialog Box

Enables you to define a daily or weekly schedule to run selected jobs.

To Data Flow Management > Discovery Control Panel > Properties tab >
access | piscovery Scheduler pane > Edit > Time Template & button

User interface elements are described below:

Ul Element (A—

Z) Description

|¥| Click to add a time template. Opens the Edit Time Template dialog box.
E Select a time template and click to delete.

|§| Select a time template and click to edit it. Opens the Edit Time Template
o dialog box.

Trigger Query Editor Window

Enables you to edit a TQL query that has been defined to trigger jobs.

To access | Data Flow Management > Discovery Control Panel > Properties tab >
Trigger Queries pane > select a TQL query and click the Open the Query
Editor button

Important | A Trigger query associated with a job is a subset of the Input query, and defines

Information | which specific Cls should be the Trigger Cls for a job. That is, if an Input query
queries for IPs running SNMP, a Trigger query queries for IPs running SNMP in
the range 195.0.0.0-195.0.0.10.

See also o "Trigger Cls and Trigger Queries" on page 20
¢ "Input Query Editor Window" on page 110
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<Panes> e "Cl Type Selector Pane" below
o "Editing Pane" below

¢ "Information Pane" below

Query Name The name of the Trigger query that activates the job.

Cl Type Selector Pane

Displays a hierarchical tree structure of the Cl Types found in the CMDB. For more details, see "Cl
Type Manager User Interface" in the HP Universal CMDB Modeling Guide.

Note: The number of instances of each CIT in the CMDB is displayed to the right of each CIT.

Important | To create or modify a TQL query, click and drag nodes to the Editing pane and
Information | define the relationship between them. Your changes are saved to the CMDB. For
details, see "Add Query Nodes and Relationships to a TQL Query" in the HP
Universal CMDB Modeling Guide.

Relevant o "Define a TQL Query" in the HP Universal CMDB Modeling Guide
tasks

o "Create a Pattern View" in the HP Universal CMDB Modeling Guide

Editing Pane

Enables you to edit the node selected in the Trigger Queries pane.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A—

Z) Description

<node> Click to display information about the node in the information pane.

<right-click Toview allist of icons, see "Shortcut Menu Options" in the HP Universal

menu> CMDB Modeling Guide.

<Toolbar> To view alist of icons, see "Toolbar Options" in the HP Universal CMDB
Modeling Guide.

Information Pane

Displays the properties, conditions, and cardinality for the selected node and relationship.

Important Hold the pointer over a node to view information:
Information
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User interface elements are described below:

Ul Element

(A-Z)

Attributes

Description

Displays the attribute conditions defined for the node or the relationship. For
details, see "Attribute Tab" in the HP Universal CMDB Modeling Guide.

Cardinality

Cardinality defines how many nodes you expect to have at the other end of a
relationship. For example, in a relationship between host and IP, if the cardinality is
1:3, the query retrieves only those hosts that are connected to between one and
three IPs. For details, see "Cardinality Tab" in the HP Universal CMDB Modeling
Guide.

Details

e CI Type. The CIT of the selected node/relationship.

o Visible. A tick signifies that the selected node or relationship is visible in the
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Ul Element
(A-Z) Description
topology map. When the node/relationship is not visible, abox & is displayed to
the right of the selected node/relationship in the Editing pane:
IpAddres
ontainment
'ﬁ' mMembership @
D)
Windows m
[atamet
¢ Include subtypes. Display both the selected Cl and its descendants in the
topology map.
Edit To view information, select a node or relationship in the Editing pane, select the
button tab in the Information pane, and click the Edit button. For details on the Node
Condition dialog box, see "Query Node/Relationship Properties Dialog Box" in
the HP Universal CMDB Modeling Guide.
Qualifiers | Displays the qualifier conditions defined for the node or the relationship. For
details, see "Qualifier Tab" in the HP Universal CMDB Modeling Guide.
Selected Displays the element instances that are used to define what should be included in
Identities the query results. For details, see "ldentity Tab" in the HP Universal CMDB
Modeling Guide.

Zone-Based Discovery Tab

This tab enables you to:

Create or edit a Management Zone

Create and run a Discovery Activity on a Management Zone

Reload Data

¢ Runthe Discovery Troubleshooter on a Management Zone

To access Data Flow Management > Discovery Control Panel > Zone-Based
Discovery tab

Important ¢ You must have at least one Data Flow Probe set up to create a Management
information Zone.

o This page includes a tree structure displaying all Management Zones and
Discovery Activities that have been run on them.
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Note:This tab is displayed by default when accessing the Discovery Control
Panel.

Relevant "Zone-Based Discovery Workflow" on page 189
tasks
See also ¢ "Universal Discovery Overview" on page 184

« "New/Edit Management Zone Dialog Box" on page 236
o "Discovery Troubleshooter" on page 187

¢ "Discovery Troubleshooter Wizard" on page 229

Ul Element

(A-2)

Description

New. Click this button to create a Management Zone or create and run a
Discovery Activity on a Management Zone. For more information on creating a
Management Zone see "New/Edit Management Zone Dialog Box" on page 236,
for more information on creating and running a Discovery Activity see HP
Universal CMDB Discovery and Integration Content Guide.

Edit. After you have created a Management Zone or Discovery Activity, click this
button to make changes toit.

Delete. Click this button to delete a Management Zone from the list of
Management Zones that you created, or to delete a Discovery Activity from a
Management Zone. If you delete a Management Zone, all activities associated
with it are also deleted.

Reload Data. Click this button to refresh the list of Management Zones and
Discovery Activities.

Expand All. Click this button to expand the Management Zone tree structure so
that all Discovery Activities that have been run on Management Zones are listed.

Collapse All. Click this button collapse the Management Zone tree structure so
that only Management Zones (and no Discovery Activities) are displayed.

Troubleshoot Missing Cls. If a Cl is missing from the results of a Data Flow
Probe and you expected to see it, click this button to run the Discovery
Troubleshooter wizard and try to find the missing Cl. This button is only active if a
Management Zone is selected in the tree structure. The Troubleshooter can only
be run on a Management Zone on which the Infrastructure and Basic Software
Configuration Discovery activities have been run. For more information on
Discovery Troubleshooter, see "Discovery Troubleshooter" on page 187.

Clear
Probe
Results

Cache

Clears the activity's results cache on the probes.

Note: If an activity's results cache is cleared, all Discovery results are sent again
the next time the activity runs.
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Ul Element
(A-Z)

Description

Available: When right-clicking on a Discovery Activity.

Management
Zones pane

Displays the defined Management Zones and their activities.

. & Represents the Management Zone root directory.

o ¥ Represents a Management Zone
= =, Indicates that the activities in the Management Zone are activated.
.

1. Indicates that the activities in the Management Zone are paused.

= i, Indicates that some of the activities in the Management Zone are
activated and some are paused.

o F%/F%‘u. Represents an activated/paused activity in a Management Zone.

Right Pane:
Details table

Appears at the top of the right pane.

o If a Management Zone is selected: The table shows the Zone description,
ranges method (either full or partial), and information on Probes in the Zone.

o If a Discovery Activity is selected: The table shows the activity type, status
(either Activated or Paused), and summary information on the activity. There
are also buttons to pause and resume the activity.

Right Pane:
Discovery
Overview

Appears at the bottom of the right pane.

o If a Management Zone is selected: This pane shows a Progress tab and a
Statistics tab. In the Progress tab you can view the progress of all activities
defined for the Management Zone. In the Statistics tab, you can view
statistics of all activities defined for the Management Zone that are running or
have finished running.

o If a Discovery Activity is selected: This pane shows a Progress tab and a
Statistics tab. In the Progress tab you can view the progress of the selected
activity. In the Statistics tab, you can view statistics on the activity that is
running or has finished running.
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Entity Reconciliation

This chapter includes:

Reconciliation Overview. ..l 250
Stable D L 251
Identification Configuration .. ... . .. 251
Reconciliation Services. .. ... 254
How to Add an Identification Rule toan Existing CIT. ... ... ... . ... ... 259
How to Create an Identification Rule Document....... ... . ... ... 259
Identification Rule Schema. .. ... .. .. il 261

Reconciliation Overview

Reconciliation is the process of identifying and matching entities from different data repositories (for
example, UCMDB Discovery, DDMI, ticketing, or BSM). This process is designed to avoid
duplicate Cls in UCMDB.

Many different data collectors can send Cls to UCMDB. In actuality, each different source might be
providing information about the same CI. The reconciliation engine is responsible for identifying and
matching entities from different data collectors and storing them, without duplicating Cls, in
UCMDB.

Three main services provide support for the reconciliation engine:

« Data Identification. Responsible for comparing input Cls, according to reconciliation rules. For
details, see "Identification Service" on page 255.

o Data In. Responsible for inserting data into UCMDB. This service decides:
= whether to merge data into existing Cls in UCMDB
= whether to ignore input Cls in the case of multiple matches
For details, see "Data In Service" on page 256.

o Merge. Responsible for merging Cls (used in Federation and Data In flows). Merging is done
according to the reconciliation priority definitions. For details, see "Merge Service" on page 259.

These services operate during reconciliation for inserting data from different sources into UCMDB,
and during federation for connecting or merging information from different data repositories during
TQL query calculations.

The reconciliation engine contains out-of-the-box identification and match criteria rules for most
usable and problematic CITs, such as node, running software, and so on.
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Stable ID

UCMDB now generates stable IDs during Cl creation. This means that the ID of the Cl is no longer
calculated from the Cl's properties. This stable ID therefore remains the same when the name,
attribute name, or property values (during normalization) change.

Identification Configuration

The reconciliation engine uses XML configuration files that contain identification and match criteria
to determine how Cls are identified during federation or data insertion. Configuration files for out-of-
the-box ClI types are provided when packages are deployed, but you can modify the provided files
or create additional files. For details, see "How to Create an Identification Rule Document" on page
259.

The following rules are used during reconciliation:

1. ldentification criteria — a set of criteria that defines all possible conditions to find all candidate
Cls for matching to a newly introduced CI.

2. Match criteria — There are two types of match criteria:

= Match verification criteria — a set of criteria that are applied to all candidates left over after
performing identification (in the previous step). Match verification ends successfully only
when all applied verification criteria are true or NA (missing data).

= Match validation criteria — an ordered set of criteria that are applied to all candidates left over
after performing match verification. For each criterion, the following results are possible:

o atrue result implies a match
o afalse result implies no match

o NA (missing data) causes reconciliation to proceed to the next criterion. If all validation
criterion are NA, then the all candidates left after match verification will be implied as
matched.

See also:
o "ldentification and Match Criteria Configuration " below

o "Examples of Identification Configuration" on page 253

Identification and Match Criteria Configuration

Due to the discovery method (local or remote), the available credentials (for example, remote
access to SNMP or WMI), and specific system security settings (for example, the system
responds to a ping), an integration point may have access to only a limited set of attributes when
identifying a Cl. For example, IP range discovery detects two IP addresses (10.12.123.101 and
16.45.77.145), and creates two nodes. However, detailed system discovery may detect that those
two IP addresses are actually configured on two network interfaces in the same node.

This means that you cannot always rely on a single matching set of attributes for identification —
other possible attributes that can potentially help to identify the Cl should also be listed. In the
previous example, the node identification attributes can be the IP address and the network

Page 251 of 279 HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 9: Entity Reconciliation

interface. If you use the IP address to identify the Cl, you see that all three discovered nodes are
the same node.

However, suppose that detailed system discovery detects a node with IP address 10.12.123.101
and network interface MAC1. At some point, that node was shut down, and the same IP address
(10.12.123.101) was given to another node with network interface MAC2. These two nodes have
the same IP address; howevers; it is obviously not the same Cl. Performing match validation on the
network interface data helps us to realize that it is not the same node.

The identification criteria are used to select candidates, and the match criteria are used to approve
the identification result or dismiss it. For example, while handling input CI 2, we may get
identification candidates B and C, and the match criteria will dismiss B. In that case, we are left with
C, which means that 2 is identified as C.

Identification Criteria

Data that the reconciliation engine receives from different data sources may contain different
subsets of the attributes (topology) necessary for identifying a Cl. The identification criteria should
contain all potential attributes on which CI matching can be done.

Specifications

Each identification criterion defines a potential condition for CI matching. The criterion can be an
attribute such as node name, or topology such as IP address. A criterion may contain two or more
conditions, to create a more complex matching rule. It may also contain different condition
operators such as equals or contains, or it may contain some master value that defines a value in
the Cl that will always allow a match.

During the identification process, all identification criteria are running to find all candidate Cls for
matching.

Possible Node Identification Criteria

e HWID

« Network interface (containing a condition operator)
e Node name

o [P address (containing a condition operator)

Match Criteria

While identification criteria list all potential attributes for matching the data, match criteria contain
the attributes that are essential for matching Cls, if any exist. This means that if two Cls are
marked as candidates to be matched by the identification criteria, the match criteria will check if the
data exists in both Cls in order to match the condition.

Match criteria are also used during the Data In process in case of multiple matches, to make the
decision to merge Cls from the CMDB. The Cls are merged only if the match criteria are satisfied. If
one of the Cls does not satisfy the match criteria, the merge is not performed.

Specifications

A match criterion is satisfied if two candidate Cls have the same essential data (as defined in the
that criterion), the data matches the condition, or if at least one of the Cls has no essential data.

Match criteria can be divided into two categories:
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o Match verification criteria — if the verification criterion is not satisfied on two candidate Cls,
these Cls are not matched.

o Match validation criterion — if the criterion with higher priority is satisfied (without missing data)
on two candidate Cls, the validation criterion with lower priority is even not checked and the Cls
are marked as matched. Similarly, if the validation criterion with higher priority is refuted on two
candidate Cls, the criterion with lower priority is even not checked and the Cls are marked as
not matched.

Possible Node Match Criteria

o Match verification criteria uses the discovered OS data for verification. This means that if two
nodes have discovered OS data and this data does not match, these two nodes are not
matched.

« Match validation criteria (ordered from highest to lowest priority):
= Network interface with a contains operator
= Node name with an equals operator
= HW ID with an equals operator

This means that if two nodes with the same HW ID are discovered, they are marked as matched
even if they have different network interfaces or node names. On the other hand, if the
discovered HW IDs on the nodes are not the same, the nodes are not marked as matched even
if the network interfaces and node names are the same. The network interface rule is checked
only if one of the nodes has no discovered HW ID.

Examples of Identification Configuration
Sample "vlan" Cl Type Identification Configuration

<identification-config type="vlan">
<identification-criteria>
<identification-criterion>
<attribute-condition attributeName="vlan id"/>
<connected-ci-condition ciType="physical port"
linkType="membership">
<overlap-fixed-operator number-of-matches="1"/>
</connected-ci-condition>
</identification-criterion>
</identification-criteria>
</identification-config>

Sample "Installed Software" Cl Type Identification Configuration

<identification-config type="installed software" xmlns:xsi=
"http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation=
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"C:\StarTeam\UCMDB\mam\ws\assets\dc\backend\reconciliation\src\main\
resources\schema\reconciliation.xsd"
description="Installed Software is identified by a
combination of their
container Node and either its Name or DML Product Name.
Two similarly identified installed software will be considered
different
entities in case of mismatch of either File System Path, DML
Product Name or
its Name.">
<identification-criteria>
<identification-criterion>
<attribute-condition attributeName="dml product name"/>
<attribute-condition attributeName="root container"/>
</identification-criterion>
<identification-criterion>
<attribute-condition attributeName="name"/>
<attribute-condition attributeName="root container"/>
</identification-criterion>
</identification-criteria>
<match>
<verification-criteria>
<verification-criterion>
<attribute-condition attributeName="file system
path"/>
</verification-criterion>
</verification-criteria>
<validation-criteria>
<validation-criterion priority="1">
<attribute-condition attributeName="dml product
name" />
</validation-criterion>
<validation-criterion priority="2">
<attribute-condition attributeName="name"/>
</validation-criterion>
</validation-criteria>
</match>
</identification-config>

Reconciliation Services

This section includes:
« "ldentification Service" on next page
o "Dataln Service" on page 256

« "Merge Service" on page 259
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Identification Service
The ldentification service uses identification rules to identify Cls. An identification rule is composed
of three criterion sets:
o ldentification criteria —for two Cls to be the same, one of these criteria must be satisfied.

o Match verification criteria — for two Cls to be the same, all the criteria must be satisfied, or there
is not enough information to evaluate all of the criteria.

o Match validation criteria — for two Cls to be the same, one validation criterion must be satisfied,
or there is not enough information to evaluate all of the criteria.

When trying to determine whether or not two Cls are the same (according to the identification rule),
each criterion is evaluated. Each criterion, in one of above sections, contains one or more
conditions. There are two types of conditions:

o Attribute conditions — tests whether or not two Cls have the same value (or same value while
ignoring case) of the given attribute define for the condition.

« Connected CI conditions — tests whether or not the two Cls share the given amount of
connected Cls defined for the condition.

For a criterion to evaluate to a t rue value, all of the conditions must evaluate to true. If one
condition evaluates to false, the entire criterion evaluates to false. If one condition cannot be
evaluated (its required data is missing in one of the two Cls being identified), the condition returns
unknown, and therefore the entire criterion that contains it, returns as unknown.

The identification process is as follows:

1. Must have at least one identification criteria that returns true. If there is at least one
identification criterion that retums t rue, we continue to the next step. Otherwise the two Cls
are not the same.

2. Are there contradictions between the Cls? If there is no verification criterion that returns
false, thatis, all of the verification data returns either t rue or unknown, continue to the next
step. Otherwise, there is a contradiction between the two Cls, and they are not the same.

3. Evaluate the validation criteria one by one and according to their priority:
a. When a validation criterion is satisfied, mark the two Cls as the same.

b. If none of the validation criteria are satisfied, and a validation criterion returns false, the
two Cls are unmatched.

c. If none of the validation criteria are satisfied or refuted, evaluate the criteria from the
next priority.

d. If there are no more criteria (the last priority was evaluated), then the two Cls are the same.

Identification Process Example

The following items are used in this example:
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Input node name = n1, ip_address = ip1, MAC address = m1, os_family = nt

UCMDB nodes | ¢« N1=name=n2
e N2=ip_address=ip1,ip2, MAC address=m1, os_family=nt

e N3 =name=n3, MAC address = m1, hw_id = id1, os_family =
unix)

1. Foreach UCMDB node, run the identification criteria:

= Node N1 does not match any identification criteria, so it will not be added to the
candidates list.

= Node N2 matches the IP identification criterion of the input node, so it will be added to
the candidates list.

= Node N3 does not match the input node by the IP identification criterion, but does
match by the MAC address identification criterion, so it will be added to the candidates
list.

Therefore, the candidates list is: N2 and N3.

2. Foreach node in the candidates list, run OS match verification criteria. Node N3 does not
satisfy this rule, since its OS is UNIX and the input node’s OS is NT. Therefore, N3 will be
removed from the candidates list.

The candidates list is: N2.

3. Run the match validation criteria one by one on node N2. Since node N2 has no data
conflicts, the match validation criteria are approved and N2 is marked as matched.

The result of the identification process is: N2 = ip_address=ip1,ip2, MAC address=m1,
os_family=nt.

Data In Service

After the Identification service runs, the identified data is merged and inserted into the UCMDB by
the Data In service.

One of the major problems that the Data In service solves is deciding what to do if the input ClI
matches multiple UCMDB Cls. You can:

« merge all matched Cls into one

o ignore the input CI

The Data In service uses match criteria to make the decision. The process is as follows:
1. Merge the input Cl with each matching UCMDB CI.

2. Foreach pair of Cls resulting from the step above, run match criteria (verification and validation
criteria).
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If at least one pair does not pass the match criteria check, the Cls are not merged. If all pairs
pass the match criteria check, the Cls are merged.

3. Ifthe Cls are not merged, the Data In service decides to ignore the input CI. This occurs when
the current match criterion causes a pair to fail the match criteria checking, and as a result the

service does not merge the Cls.

Multiple Matching Examples

Multiple matching by different identification criteria without conflicts

o Input bulk data

Matwork
Inlarface

IP Address = ip1 | | MAC Address = MACT |

o l|dentified datain the CMDB

Mode = i
M3 05 =nt

Matwork
Inbestace Inlerface

MAC Addrass = MACZ MAC Address = MACT

In this example, the input node matches four nodes in the CMDB having different identification
criteria, and there are no conflicts with any of the CMDB matched nodes. The process is as follows:

o Merge the input Cl with each matched CI in the CMDB.

Hode = n
HW D = hiwd
0E = nt

Hode =1
HW 1D = Frrad
CS=nl

Modz =1
HIW 10 = bt
5 = nl

Pode = it
W 10 = hiet
5 =

AT Ackdnats = WACT
IP Acdress = gt

IF Address = Ip1
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o Check for conflicts between the resulting merged Cls. In this example, there is no conflict
between the merged Cls. Nodes N2, N3, and N4 are the same ClI; therefore, it is obvious that
there is no conflict between them. The only difference between nodes N1 and N2 is the
additional MAC address in N1. Since the MAC address match validation criterion uses the
contains operator, there is no conflict between nodes N1 and N2 either.

The decision here is to merge all Cls into one.

Multiple matching by different identification criteria with conflicts

¢ Input bulk data

Mode = ni
05 =nt

Peartweork
Inlerface

MAC Address = MACT

o l|dentified data in the CMDB

HY 1D = hiw

Metwork
Intarface

MAC Address = MACH
MAC Address = MACI

Mesde = nZ

Metwsark
Interface

MAC Address = MACT
MAC Address = MACA

o Merge the input Cl with each matched CI in the CMDB.
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Node = n1
HYY 10 = hiw
Qs =nt ey

Mada = n2
Q5 =nt

Metaork
Intarface

MAC Addrass = MAC Addrass =
[MACT, MACI] [MACT, MACA]

In this example, the input node matches two nodes in the CMDB having different identification
criteria, and there are conflicts with the CMDB matched nodes.

e Merge the input CI with each matched CI in the CMDB.

o Check the conflicts between the resulting merged Cls. In this example, nodes N1 and N2 have
conflicting MAC address match criteria.

The decision is to not merge all Cls to one.

The decision of whether to ignore data or pass it on for manual reconciliation depends on the flag
setting for the MAC address match criterion.

Merge Service

The merge service is responsible for merging two or more Cls into one Cl. This service is used by
the Data In service and the Federation service.

How to Add an Identification Rule to an Existing
CIT

1. GotoModeling > Cl Type Manager > Details tab and select Advanced identification as
the identification method. For details, see "Details Page" in the HP Universal CMDB Modeling
Guide.

2. Click the Edit button to open the XML editor. Create the identification rule. For details, see
"How to Create an Identification Rule Document" below.

How to Create an Identification Rule Document

This task describes how to prepare the XML schema for an identification rule file. For details about
the schema elements and attributes, see "ldentification Rule Schema" on page 261.

The identification rule document is an XML file that describes the required reconciliation data for a
specific Cl type. This identification rule is applied to the Cl type and each of its descendants,
unless one of them has a identification rule of its own.

You can create an identification rule document from a blank document or use existing information
as abasis. To do this:
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1. Navigate to Modeling > Cl Type Manager.
2. Click the Details tab.

3. Select the information in the Identification field.

Example of the identification section

<identification-criteria> <identification-criterion> <connected-ci-condition
ciType="interface" link Type="composition"> <overlap-operator match-percent="66"/>
<attribute-condition attributeName="mac_address"/> </connected-ci-condition>
</identification-criterion> <identification-criterion> <attribute-condition
attributeName="name" operator="EquallgnoreCase"/> </identification-criterion>
<identification-criterion> <connected-ci-condition ciType="ip_address"

link Type="containment"> <overlap-operator match-percent="66"/> <attribute-
condition attributeName="name"/> <attribute-condition attributeName="routing_
domain"/> </connected-ci-condition> </identification-criterion> <identification-
criterion> <attribute-condition attributeName="bios_uuid"/> </identification-criterion>
</identification-criteria>

In this example:

o A 66% match of the mac_address attribute from the connected interfaces Cl types is
required.

e The name attribute is not case sensitive.
e The rule requires both the ip_address name and routing_domain to be the same.

o Only one of the identification criteria needs to be fulfilled for the reconciliation engine to find
a possible match.

Example of the match section

<match> <verification-criteria> <verification-criterion> <attribute-condition
attributeName="os_family"/> </verification-criterion>  </verification-criteria>
<validation-criteria> <validation-criterion priority="1"> <attribute-condition

attributeName="bios_uuid"/> </validation-criterion> <validation-criterion priority="2">
<connected-ci-condition ciType="interface" link Type="composition">

<overlap-operator match-percent="66"/> <attribute-condition attributeName="mac_
address"/> </connected-ci-condition> </validation-criterion> <validation-
criterion priority="3"> <attribute-condition attributeName="name"/> </validation-

criterion> </validation-criteria> </match>
In this example:

e The structure of the conditions is the same as those conditions in the Identification field.

o Only one priority criterion is given in this example, but there may be many criteria with the
same priority.
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Identification Rule Schema

Element

Name and Path

Description

Attributes

identification-config

The parent element for the
identification rule document.

Name. description

Description. A textual
description of the identification
rule.

Is required. Optional

Type. String

Name. type

Description. The Cl type to
which the identification rule will

apply.
Is required. Required

Type. String

identification-criteria

(Identification-config)

The parent element for all the
possible identification criteria for
the Cl type. For details, see
"ldentification Criteria" on page
252. The identification criteria
may contain many
identification-criterion
elements. Can appear at most
once.

match

(Identification-config)

The parent element for all the
possible match criteria for the ClI
type. For details, see "Match
Criteria" on page 252. Can
appear at most once.

multiple-match-resolving
(Identification-config)

When two or more Cls of the CI
type are identified to one
another, they may be of any
descendant Cl type as well.
This element states that one of
the descendant Cl types is
preferred over the others. Can
appear at most once.

Name. preferred-type

Description. Specifies the ClI
type of the Cl that will be
preferred when there are
multiple matches which cannot
be merged.

Is required. Optional

Type. String
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Element

Name and Path

Description

Attributes

preferred-property
(identification-config >

multiple-match-resolving)

This element specifies the
property value of the CI that will
be preferred when there are
multiple matches which cannot
be merged.

Name. name

Description. The name of the
property.

Is required. Required

Type. String

Name. value

Description. The value of the
property.

Is required. required

Type. String

Name. priority

Description. The priority of this
preferred property.

Is required. Optional

Type. Integer

identification-criterion
(Identification-config >
identification-criteria)

This element defines a single
identification criterion. The
criterion may contain many
conditions for identification, and
for the criterion to return True,
all of them must return True.

—_—,——————————————————————|

Name. targetType

Description. Indicates for
which Cl type this criterion is
valid. If this attribute is omitted,
then the criterion is applied to
any derived type.

Is required. Optional

Type. String

Name. isTargetTypeDerived

Description. Specifies
whether the target type is a
derived type of the current ClI

type.

Is required. Optional

Type. String

key-attributes-condition
(identification-config >
identification-criteria >
identification-criterion)

This special condition states
that the Cl type is identified by
its key properties and Cl type
name, and not by any

Page 262 of 279

HP Universal CMDB (10.00)



Data Flow Management Guide
Chapter 9: Entity Reconciliation

Element

Name and Path Description Attributes

identification criteria. If this
condition exists, it should be the
only one in the criterion, as well
the only criterion in the
identification section. Can
appear at most once.

attribute-condition Defines a condition based on an || Name. attributeName
(identification-config) attribute.

identification-criteria > Description. The name of the
identification-criterion -OR- attribute.

identification-config Is required. Required
identification-criteria >

identification-criterion > Type. String

connected-ci-condition -
OR- identification-config >
match > validation-criteria ) Descri ption_ For the purpose
of fulfilling the condition, the
value defined here is
considered equal to any other
value.

Name. masterValue

Is required. Optional

Type. String

Name. operator

Description. Specifies
whether the equality of attribute
values should be case
sensitive or not. The default is
case sensitive.

Is required. Optional

Type. One of the values:
Equals or EqualsignoreCase

Name. includeNullVValue

Description. Specifies
whether a Cl should still be
considered as a valid value if it
has a null (empty) value in the
attribute, and the condition will
process normally; oris the
condition ignored and the
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Element

Name and Path

Description

Attributes

reconciliation engine moves to
the next criterion. Default value
is False

Is required. Optional
Type. Boolean

reconciliation engine moves to
the next criterion. Default value
is False

reconciliation engine moves to
the next criterion. Default value
is False

Name. conditionType

Type. One of the following
values:
approveAndContradict
condition is used for both
approving and contradicting Cls
(default) or contradictOnly
condition is used to contradict

two Cls.
|=|

connected-ci-condition
(Identification-config
identification-criteria >
identification-criterion -OR-
identification-config >
match > verification-criteria
-OR- identification-config
> match)

Defines a condition based on
connected Cls. The connected
condition may contain attribute
conditions. If no attribute
conditions exist, the condition
matches the connected Cl type
using its own identification rule.

Name. ciType

Description. The type of ClI
that is assumed to be
connected to the Cl type to
which this rule belongs using
the link Type attribute.

Is required. Required

Type. String

Name. linkType

Description. The type of link
that the ciType attribute uses to
connect to the Cl type to which
this rule belongs

Is required. Required

Type. String

Name. isDirectionForward
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Element

Name and Path

Description

Attributes

Description. The direction of
the link. Default value is True
(from the rule’s Cl type to
ciType).

Is required. Optional

Type. Boolean

overlap-fixed-operator
(Identification-config >
identification-criteria >
identification-criterion >
connected-ci-condition)

Defines the fixed number of
matches to connected Cls that
are needed to fulfill the condition
for the connected-ci-condition
element to return True. Either
this or overlap-operator must
exist.

Name. number-of-matches

Description. The number of
matches.

Is required. Required

Type. Integer

overlap-operator
(Identification-config >
identification-criteria >
identification-criterion >
connected-ci-condition)

Defines the percent of
connected Cls (from the total
input number of connected Cls)
that are needed to fulfill the
condition for the connected-ci-
condition element to return True.
Either this or overlap-fixed-
operator must exist.

Name. match-percent

Description. The percent of
matches.

Is required. Required

Type. Integer between 1 and
100

verification-criteria
(Identification-config >
match)

The parent element for all the
possible verification criteria for
the Cl type. For details, see
"Match Criteria" on page 417.
The verification criteria must
contain at least one verification-
criterion element. Can appear at
most once.

verification-criterion
(Identification-config >
match > verification-
criteria)

This element defines a single
verification criterion. The
criterion may contain many
conditions for verification.

Name. targetType

Description. The derived ClI
type for which this criterion is
valid. If this attribute is omitted,
then the criterion is applied to
any derived type.

Is required. Optional

Type. String

Name. isTargetTypeDerived
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Element

Name and Path

Description

Attributes

Description. Specifies
whether the target type is a
derived type of the current ClI

type.
Is required. Optional

Type. Boolean

Name.
numberOfConflicts ToFail
Identification

Description. The number of
conflicting conditions that will
cause the current criterion to
fail.

Default Value: 1.

Is required. Optional

Type. Integer

validation-criteria
(Identification-config >
match)

The parent element for all
possible validation criteria for
the Cl type. For details, see
"Match Criteria" on page 417.
The validation criteria must
contain at least one validation-
criterion element. Can appear at
most once.

validation-criterion
(Identification-config >
match > validation-criteria)

This element defines a single
validation criterion. The criterion
may contain many conditions for
validation.

Name. priority

Description. The criterion’s
priority.

Is required. Required

Type. Integer

Name. targetType

Description. The derived CI
type for which this criterion is
valid. If this attribute is omitted,
then the criterion is applied to
any derived type.

Is required. Optional

Type. String
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Name and Path

Element

Description

Attributes

Name. isTargetTypeDerived

Description. Specifies
whether the target type is a
derived type of the current ClI

type.
Is required. Optional

Type. Boolean

Name.
numberOfConflicts ToFail
Identification

Description. The number of
conflicting conditions that will
cause the current criterion to
fail. Default Value: 1.

Is required. Optional

Type. Integer
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Reconciliation Priority

This chapter includes:

Reconciliation Priority Overview. ... . 268
How to Add Reconciliation Priorities toan Existing CIT. ... ... ... 268
How to Create a Reconciliation Priority Document. .. ... ... ... ... 269
Reconciliation Priority Schema, . . ... L 270
Reconciliation Priority Manager User Interface. .. ... .. . 271

Reconciliation Priority Overview

Reconciliation Priority (conflict resolution) specifies how matched Cls are merged. You set these
priorities in the Reconciliation Priority Manager. For details, see "Reconciliation Priority Window"
on page 274.

For details about the reconciliation process and its rules, see "Entity Reconciliation" on page 250.

Reconciliation Priority Configuration
When a Cl is matched with another Cl, they should be merged. This behavior becomes relevant in
the following situations:
¢ During Data In service —to insert an already existing Cl into the CMDB.
o During Federation — when multiple data repositories supply the same CI with different values.
To solve this problem, you can define priorities for each data repository to each CIT and attribute.

For details, see "Reconciliation Priority Window" on page 274.

How to Add Reconciliation Priorities to an Existing
CIT

1. Create an XML reconciliation file that contains reconciliation priorities. For details, see "How to
Create a Reconciliation Priority Document " on next page.

2. Create a package that contains the XML priorities file. The XML file should be located in a
folder called reconciliationPriority at the root level in the package. For details, see "Create a
Custom Package" in the HP Universal CMDB Administration Guide.

3. Deploy the package. For details, see "Deploy a Package" in the HP Universal CMDB
Administration Guide.
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How to Create a Reconciliation Priority Document

This task describes how to prepare the XML file according to the reconciliation priority schema. For
details about the schema elements and attributes, see "Reconciliation Priority Schema " on next
page.

The reconciliation priorities document is an XML file that describes the priorities of integration points
in the Data In flow for a specific Cl type. The priority is applied to the Cl type and each of its
descendants, unless one of them has a priority of its own for a given integration point.

You can create a reconciliation priority document from a blank XML document.

Example

<reconciliation-priority-config type="node">
<reconciliation-priority dataStoreName="CMS Sync"
priority="80"/>
<reconciliation-priority dataStoreName="DDMI DS"
priority="70"/>
<attributes-reconciliation-priorities>
<attribute-reconciliation-priorities attribute-name="name">
<reconciliation-priority dataStoreName="DDMI DS"
priority="100"/>
</attribute-reconciliation-priorities>
<attribute-reconciliation-priorities attribute-name="snmp
Sys name'">
<reconciliation-priority dataStoreName="CMS Sync"
priority="50"/>
</attribute-reconciliation-priorities>
</attributes-reconciliation-priorities>
</reconciliation-priority-config>

In this example:

1. We first define a priority value for all attributes of node. This is optional. If omitted, the
default value is 100.

2. For specific attributes we changed one of the data repositories. The other has the same
value as the one defined at the top of the document.
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Reconciliation Priority Schema

Name and Path

Element

Description

Attributes

reconciliation-priority-
config

The parent element of a
reconciliation priority section for
a specific Cl type.

Name. type

Description. The CI
type to which the
reconciliation
priorities will apply

Is required.

Required

Type. String
reconciliation-priority When this appears under the Name.
(reconciliation-priority- reconciliation-priority-config dataStoreName

config -OR- reconciliation-
priority-config > attributes-
reconciliation-priorities)

element, it defines priorities for
all attributes in an integration
point. When it appears under the
attribute-reconciliation-priorities
element, it defines a priority for a
specific attribute. Must appear
at least once when it is the child
of the attributes-reconciliation-
priorities element.

Description. The
name of the
integration point.

Is required.
Required

Type. String

Name. priority

Description. The
priority of the
dataStoreName
attribute.

Is required.
Required

Type. String

Value: -1,000,000
to 1,000,000

Default: 100

attributes-reconciliation-
priorities (reconciliation-
priority-config)

The parent element for the
section of the document that
defines priorities for specific
attributes. Can appear at most
once.

attribute-reconciliation-
priorities (reconciliation-
priority-config > attributes-

Defines the priorities of
integration points for specific
attributes of the current Cl type.

Name. attribute-
name
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Element
Name and Path Description Attributes
reconciliation-priorities) Description. The
name of the attribute
for which to define
priorities.

Is required.
Required

Type. String

Reconciliation Priority Manager User Interface

This section includes:

Add Attribute Dialog BoX. . . ... .. L 271
ClTypes Pane. il 272
<CI Type> - Reconciliation Priority Overrides Pane. . ... ... ... .. 273
Reconciliation Priority Window. . ... L 274

Add Attribute Dialog Box

The Add Attribute dialog box enables you to select specific attributes and specify a priority override
value for each.

To access Select a Cl type in the Cl Types tree and click % in the Attribute

Overrides area.
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User interface elements are described below:

Ul Element

(A-2)

Attributes

Description

Enables you to specify an attribute for which you want to specify a priority override.

Select the <Show hidden attributes> check box to include hidden attributes in
the displayed list. Hidden attributes are not marked as Visible in the Attributes
pane of the Cl Type Manager. For details, see "Attributes Page" in the HP
Universal CMDB Modeling Guide.

To change the priority of an attribute, do the following:
o Click in the Priority field and enter a new value.
This value can range from -1,000,000 to 1,000,000.

e Press Enter.

e Click |@| in the Cl Types pane.

Integration
Point

Displays a list of all defined integration points.

Select the integration point for which you want to change an attribute's priority. If
an integration point is selected, only attributes for this integration point can be
added to the list.

Cl Types Pane

The Cl Types pane displays the list of Cl types and attributes that are supported by the selected
integration point.

When you select a node in the Cl Types tree, all integration points that support the selected item
are displayed in the Cl Type Overrides area.

If there is a manual override on an item in the tree, that item and all its parent items will be displayed
with an asterisk next to the Cl type.

User interface elements are described below:

Ul Element

(A-Z) Description

|§| Click to expand the entire hierarchical tree structure.
|§| Click to collapse the hierarchical tree structure.
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Ul Element
(A-Z) Description
Tree View Click Tree View to select the display format of the Cl types tree. The following
& options are available:
o Display label

o Class name

e Legacy class name

|E| Toggles the display of the legend at the bottom of the Cl Types pane.

Saves the changes to the priority override settings.

(| Filters the tree to display only those CI types that have reconciliation priority
o overrides, and their parents.

<Cl Type> - Reconciliation Priority Overrides Pane

When you select a Cl type in the Reconciliation Priority Manager, the Reconciliation Priority
Overrides pane lists all integration points that contain the selected item and the priority overrides for
those Cl types, if any.

Attribute Overrides Area

User interface elements are described below:

Ul Element

(A-Z) Description

& Opens the Add Attribute dialog box, which enables you to specify attributes for
which you want to set overrides. For details, see "Add Attribute Dialog Box " on
page 271.

|ﬁ| Resets the value of the selected attribute to its default value.

If you reset the priority for an attribute, and this priority is not overridden in any
parent of this CIT, the attribute override row is removed from the list, and the value
is restored to 100. If a parent of this CIT does have an attribute override for this
attribute, the value is set to the parent's value.

Attribute The name of the attribute for which you are specifying a priority override.

Inherited The name of the Cl type from which the priority level is inherited.
From

Integration | The name of the integration point for which the override is defined.
Name

Priority Displays the priority that is assigned to a particular attribute. This value can range
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Ul Element
(A-Z) Description

from -1,000,000 to 1,000,000. The default priority level for all items is 100. If you

change the priority of an entry, the new value propagates downwards to all
descendants of that particular Cl type.

To change the priority of an item, do the following:

o Click in the Priority field and enter a new value.

e Press Enter.

¢ Click |@]| in the Cl Types pane.

Cl Type Overrides Area

User interface elements are described below:

Ul Element
(A-Z) Description

Inherited The name of the Cl type from which the priority level is inherited.
From

Integration | The name of the integration point for which the override is defined.
Name

Priority Displays the priority that is assigned to a particular Cl Type. This value can range
from -1,000,000 to 1,000,000. The default priority level for all items is 100. If you

change the priority of an entry, the new value propagates downwards to all
descendants of that particular Cl type.

To change the priority of a Cl type, do the following:

¢ Click in the Priority field and enter a new value.

e Press Enter.

e Click |@| in the Cl Types pane.

Reconciliation Priority Window

This window enables you to specify the reconciliation priority for a particular integration point, CIT,
or attribute.

The Reconciliation Priority Manager provides a centralized location where you can view and change
the reconciliation priority for all integration points.

Note: In the Integration Point Pane, you can modify the reconciliation priority for the selected
integration point only. For details, see "Integration Point Pane" on page 153.

For details about the reconciliation engine, see "Entity Reconciliation" on page 250.
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To access

Do one of the following:

Select Data Flow Management > Reconciliation Priority.

Select Data Flow Management > Integration Studio and click G

Relevant tasks .

"How to Work with Federated Data" on page 133
"How to Work with Population Jobs" on page 133

"How to Work with Data Push Jobs" on page 134

User interface elements are described below:

Ul Element

(A-2)

Integration

Description

Enables you to select a specific integration point for which to specify the
reconciliation priority, or to set priorities for all integration points.

If you have selected a specific integration point, its name is highlighted in the right
pane. You can then change the reconciliation priority for that integration point only.
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Troubleshooting and Limitations

This section describes general troubleshooting and limitations related to working with Universal
Discovery.

o "Troubleshooting" below

o "Limitations" on next page

Note:
o For details on using the log files to perform basic troubleshooting, see:
s "Data Flow Probe Log Files" on page 67

= "Data Flow Management Log Files" on page 1 in the HP Universal CMDB Administration
Guide

Troubleshooting

e "Troubleshooting" above

o "Discovery Results Do Not Appear in the Topology Map" below
¢ "Networks and IPs" below

e "TCP Ports" on next page

o "Discover Resources on a Windows XP Machine" on next page

o "Troubleshooting" above

Discovery Results Do Not Appear in the Topology Map

Problem. Data that should have been discovered during the Discovery process does not appear in
the topology map.

Verification. The CMDB cannot retrieve the data or build the query results. Check the Statistics
Results pane. If the Cls were not created, the problem is occurring during the Discovery process.

Solution. Check the error messages in the probeMgr-services.log file located in
C:\hp\UCMDB\DataFlowProbe\runtime\logs.

Networks and IPs

Problem. Not all networks or IPs have been discovered.

Indication. Not all the networks or IPs appear in the topology map results.
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Verification. The IP address range in the Data Flow Probe Setup window does not encompass the
scope of the networks or IPs that should have been discovered.

Solution. Change the scope of the Discovery range:
1. Select Data Flow Management > Data Flow Probe Setup.
2. Select the Probe and the range.

3. Change the IP address range in the Ranges box as required.

TCP Ports

Problem. Not all TCP ports have been discovered.
Indication. Not all TCP ports appear in the topology map results.

Verification. Open the portNumberToPortName.xml file (Data Flow Management > Adapter
Management > DDM Infra > Configuration Files > portNumberToPortName.xml), and search
for the missing TCP ports.

Solution. Add the port numbers that should be discovered to the portNumberToPortName.xml
file.

Discover Resources on a Windows XP Machine

Problem. Failure to discover resources on a machine running on the Windows platform.

« Solution 1. Start > Settings > Control Panel > System. In the Remote tab, verify that the
following check box is selected: Allow users to connect remotely to this computer.

¢ Solution 2. In Windows Explorer, select Tools > Folder Options. In the View tab, clear the
Use simple file sharing (Recommended) check box.

Limitations

 When Discovery is installed on a non-English operating system, job and module names are still
limited to English characters.

« Naming Conventions: When naming entities in Data Flow Management, you can use the
following characters: a-z, -7, 0-9. When entering IP addresses, use only digits and asterisks
(*)-

o Each Content Pack installation overrides all out-of-the-box resources with the contents of that
Content Pack. This means that any changes you made to these resources are lost. This applies
to the following resources: Queries, Views, Enrichments, Reports, Discovery Jython scripts,
Discovery adapters, Discovery jobs, Discovery resources, Discovery configuration files,

Discovery modules, Cl Types, and Relationships. (Attributes added to Cl Types and
Relationships are not overridden).
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In general, you should refrain from making changes to out-of-the-box resources. If you must do
s0, be sure to track your changes so that they can be re-applied after you install a Content Pack.
Important general fixes (not specific to your environment) should be sent to CSO so that they
can be analyzed and included as part of one of the next Content Packs.
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